To order replacement toner cartridges or supplies from Dell:

1. Double-click the **Dell 2335dn MFP Toner Reorder** icon on your desktop.

OR

2. Visit Dell's website, or order Dell printer supplies by phone.

   [http://www.dell.com/supplies](http://www.dell.com/supplies)

---

**Contacting Dell**

*NOTE: If you do not have an active Internet connection, you can find contact information on your purchase invoice, packing slip, bill, or Dell product catalog.*

Dell provides several online and telephone-based support and service options. Availability varies by country and product, and some services may not be available in your area. To contact Dell for sales, technical support, or customer service issues:


2. Verify your country or region in the **Choose A Country/Region** drop-down menu at the bottom of the page.

3. Click **Contact Us** on the left side of the page.

4. Select the appropriate service or support link based on your need.

5. Choose the method of contacting Dell that is convenient for you.
Notes, Notices, and Cautions

NOTE: A NOTE indicates important information that helps you make better use of your printer.

NOTICE: A NOTICE indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

CAUTION: A CAUTION indicates a potential for property damage, personal injury, or death.

Information in this document is subject to change without notice.
© 2008-2010 Dell Inc. All rights reserved.

Reproduction of these materials in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell and DELL logo are trademarks of Dell Inc.; Microsoft and Windows are registered trademarks of Microsoft Corporation.

PaperPort is a registered trademark of ScanSoft, Inc.

Adobe® and PhotoShop® are registered trademarks of Adobe Systems Incorporated.

Other trademarks and trade names may be used in this document to refer to the entities claiming the marks and names of their products. Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.
# Finding Information

<table>
<thead>
<tr>
<th>What Are You Looking For?</th>
<th>Find It Here</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drivers for my printer</td>
<td>DRIVERS AND UTILITIES CD</td>
</tr>
<tr>
<td>My User's Guide</td>
<td></td>
</tr>
</tbody>
</table>

You can use the **DRIVERS AND UTILITIES CD** to install, uninstall, reinstall drivers and utilities or access your *User's Guide*. For details, see "Software Overview".

Readme files may be included on your **DRIVERS AND UTILITIES CD** to provide last-minute updates about technical changes to your printer or advanced technical reference material for experienced users or technicians.

<table>
<thead>
<tr>
<th>How to use my printer</th>
<th>Owner's manual</th>
</tr>
</thead>
</table>

⚠️ **CAUTION:** Read and follow all safety instructions in your Product Information Guide prior to setting up and operating your printer.

⚠️ **NOTE:** Owner's Manual may not be provided with your product depending on your country.

<table>
<thead>
<tr>
<th>How to set up my printer</th>
<th>Setup diagram</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Safety information</th>
<th>Warranty information</th>
<th>Regulatory Notice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Information Guide</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Express Service | Express Service Code |
Identify your printer when you use support.dell.com or contact technical support. Enter the Express Service Code to direct your call when contacting technical support. Th Service Code is not available in all countries.

- Latest drivers for my printer
- Answers to technical service and support questions
- Documentation for my printer

Dell Support Website: support.dell.com

The Dell Support Website provides several online tools, including:

- Solutions- Troubleshooting hints and tips, articles from technicians, and online course
- Upgrades- Upgrade information for components, such as memory
- Customer Care- Contact information, order status, warranty, and repair information
- Downloads- Drivers
- Reference- Printer documentation and product specifications

You can access Dell Support at support.dell.com. Select your region on the WELCOME SUPPORT page, and fill in the requested details to access help tools and information.
Unpacking Your Printer

1. Select a location for your printer.

⚠️ **CAUTION:** The printer requires at least two people to lift it safely.

- Leave enough room to open the printer tray, covers, doors, and options. It is also important to allow enough space around the printer for proper ventilation.
- Provide the proper environment:
  - A firm, level surface
  - Away from the direct airflow of air conditioners, heaters, or ventilators
  - Away from sunlight, extreme humidity, or high fluctuations in temperature
  - A clean, dry, and dust free location
  - Select a level, stable place with adequate space for air circulation. See "Setting up the hardware".
  - Do not set the machine close to the edge of your desk or table.

⚠️ **NOTE:** Leave the printer in the box until you are ready to install it.

2. In addition to the **Dell 2335dn MFP**, ensure that you have the following items in the box. *If there is a missing item, contact Dell:*

<table>
<thead>
<tr>
<th>toner cartridge</th>
<th>power cord⁷</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DRIVERS AND UTILITIES CD</strong> ⁶</td>
<td>owner's manual⁷</td>
</tr>
</tbody>
</table>
a. The appearance of the power cord and the telephone line cord may differ according to your country's specifications.
b. The *DRIVERS AND UTILITIES CD* contains Dell printer drivers, Scan drivers, Printer Settings Utility, Set IP, Macintosh driver, Linux driver, Dell Toner Management System, Dell ScanCenter, PaperPort® and an HTML User's Guide.
c. Owner's Manual may not be provided with your product depending on your country.
d. This item is only provided in some countries.

**NOTE:** Use the telephone line cord supplied with your printer. You can also use AWG#26 or lower gauge cord that is less than 250 cms in length.

**NOTE:** The power cord must be plugged into a grounded power socket.

3. Save the carton and packing material in case the printer needs to be repacked.
4. Remove the packing tape from the front, back and, sides of the printer.

5. Remove the label completely from the scanner module by gently pulling it. The scan unlock switch should move forward to the unlock position as the label is pulled out.
NOTE: To confirm the scanner is unlocked, open the scanner cover and ensure that the blue latch is in the unlocked ( unlocking) position. If the latch is not in the unlocked position, reach under the operator panel and pull it forward. If the scan switch is locked, you cannot copy or scan.

NOTE: When you are moving the printer or do not intend to use it for a long period of time, move the switch BACKWARD to the lock position, as shown. To scan or copy a document, the switch must be unlocked.

About Your Printer

These are the main components of your printer. The following illustrations show the standard Dell 2335dn...
**Front View**

**Rear View**
Operator Panel Button Functions

Common Keys
### Press:

<table>
<thead>
<tr>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; : Scroll through available options.</td>
</tr>
<tr>
<td>✓ : Confirm the selection on the display.</td>
</tr>
<tr>
<td>🔄 : Return to the upper menu.</td>
</tr>
<tr>
<td>❌ : Stop an operation at any time, or return to main menu.</td>
</tr>
<tr>
<td>🎤 : Start a job.</td>
</tr>
</tbody>
</table>

### Fax Keys

<table>
<thead>
<tr>
<th>Press:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>📧 :</td>
<td>Dial/Enter number or enter alphanumeric characters.</td>
</tr>
<tr>
<td>📗 :</td>
<td>Store frequently used fax numbers in memory or search for stored fax numbers or email addresses. It also allows you to print a Phonebook list.</td>
</tr>
<tr>
<td>🔄</td>
<td>Insert a pause into a fax number in edit mode.</td>
</tr>
</tbody>
</table>

### Understanding the Status LED

When the problem occurs, the Status LED indicates the machine's condition by the light color of it's action.
<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
</table>
| Off         | • The machine is off-line.  
              • The machine is in power save mode. When data is received, or any button is pressed, it switches to on-line automatically. |
| Green Blinking | The machine is warming up or ready to receive the data.                     |
| On          | The machine is on-line and can be used.                                     |
| Orange Blinking | • A minor error has occurred and the machine is waiting the error to be cleared. Check the display message. When the problem is cleared, the machine resumes.  
              • The toner cartridge is low. Order a new toner cartridge. You can temporarily improve print quality by redistributing the toner.  
              • The toner cartridge is totally empty. Remove the old toner cartridge and install a new one.  
              • A paper jam has occurred.  
              • There is no paper in the tray. Load paper in the tray.  
              • The machine has stopped due to a major error. Check the display message. |

---

**Internal Fonts**

The **Dell 2335dn MFP** Laser printer supports the PCL and PS fonts.

If you want to see the PCL and PS font list, follow these steps:

**Printing the PCL Font list**

1. Press **Scroll** ( 或 ) to highlight **Setup** and then press **Select** ( ).
2. Press **Scroll** ( 或 ) to highlight **Reports** and then press **Select** ( ).
3. Press **Scroll** ( 或 ) to highlight **PCL Font List** and then press **Select** ( ).
4. PCL Font list pages print out.

**Printing the PS3 Font list**

1. Press **Scroll** ( 或 ) to highlight **Setup** and then press **Select** ( ).
2. Press **Scroll** ( 或 ) to highlight **Reports** and then press **Select** ( ).
3. Press **Scroll** ( \( \downarrow \) or \( \uparrow \)) to highlight **PS Font List** and then press **Select** ( \( \checkmark \)).

4. PS Font list pages print out.

**NOTE:** You can add additional PCL fonts and PS fonts in Printer Settings Utility. See "Printer Settings Utility".

---

**Setting up the hardware**

This section shows the steps to set up the hardware which is explained in the Placemat. Make sure you read Placemat and complete following steps.

1. Select a stable location.

   Select a level, stable place with adequate space for air circulation. Allow extra space to open covers and trays.

   The area should be well-ventilated and away from direct sunlight or sources of heat, cold, and humidity. Do not set the machine close to the edge of your desk or table.

   ![Diagram of printer dimensions]

   Place the machine on a flat, stable surface so that there is no incline greater than 2 mm (0.08 inch). Otherwise, printing quality may be affected.
2. Unpack the machine and check all the enclosed items.
3. Remove the tape holding the machine tightly.
4. Install both the print cartridge.
5. Load paper. See "Loading Paper".
6. Make sure that all the cables are connected to the printer.
7. Turn the printer on.

**NOTE:** When you move the printer, do not tilt or turn it upside down. Otherwise, the inside of the printer may be contaminated by toner, which can cause damage to the printer or bad printing quality.

---

### Installing the Toner Cartridge

1. Open the front cover.

**CAUTION:** To prevent damage, do not expose the toner cartridge to light for more than a few minutes.

**CAUTION:** Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area.
2. Remove the toner cartridge from its bag and thoroughly shake the cartridge from side-to-side to distribute the toner evenly inside the cartridge.

![Shaking the Toner Cartridge](image)

**NOTE:** If toner comes into contact with your clothing, wipe the toner off with a dry cloth and wash your clothing in cold water. Hot water sets toner into fabric.

3. Holding the toner cartridge by the handle, slide it into the printer until it locks firmly into place.

![Inserting the Toner Cartridge](image)

4. Close the front cover.
Loading Paper

Load up to 250 sheets of plain paper (75 g/m², 20lb) in the paper tray.

⚠️ **NOTE:** Set the paper type and size after loading paper into the paper tray. See "Setting the Paper Type" and "Setting the Paper Size" for the paper used in copying and faxing, or "Paper Tab" for Computer printing.

Load the paper:

1. Pull the paper tray out of the printer.

2. If you load paper that is longer than a standard (Letter or A4) size, such as Legal paper, press and unlatch the guide lock, and then slide the paper length guide out completely to extend the paper tray to its full length.

3. Slide in the paper length guide until it rests against the end of the paper stack.
For paper smaller than Letter size, adjust the rear paper length guide so that it lightly touches the paper stack.

4. Pinch the paper width guide, and move it towards the stack of paper until it touches the side of the stack.

5. Flex the sheets back and forth to loosen them, and then fan them out. Do not fold or crease the print media. Align the edges on a level surface.

6. Insert the paper stack into the paper tray with the side to be printed on facing down.
7. Do not exceed the maximum stack height indicated by the paper limit marks on the both inside walls of the tray.

**NOTE:** Overloading the paper tray may cause paper jams.

**NOTE:** Improper adjustment of paper guides can result in paper jams.

8. Slide the paper tray back into the printer.
9. Set the paper type and size. For more information, see "Setting the Paper Type" and "Setting the Paper Size".

---

**Making Connections**

**Connecting the Telephone Line**

1. Plug one end of a telephone line cord into the RJ11 telephone line socket (FAX) and the other end into an active wall jack.

To connect a telephone and/or answering machine to your printer, remove the plug from the extension telephone socket (EXT) ( ) and plug the telephone or answering machine into the extension telephone socket (EXT).

2. Alternative setup of Fax connected to a wall socket and an external phone or Telephone answering device (TAD).
If connecting a FAX using an answering machine or telephone answering device (TAD).

**NOTE:** Set rings to answer to digit greater than the "Ring To Answer" setting for the telephone answering device (TAD).

If connecting a FAX using a computer modem.

**NOTE:** Set rings to answer to digit greater than the "Ring To Answer" setting for the telephone answering device (TAD).

**NOTE:** For additional information, see "Using an Answering machine" or "Using a Computer Modem".
NOTE: Phone adaptor not supplied with unit for UK setup, advice to buy from local market or check with telephone service provider. Terminator plug is provided along the unit.

*If the phone communication is serial in your country* (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, France, and Switzerland), remove the plug from the extension telephone socket (EXT) and insert the supplied terminator.

---

**Connecting the Printer Cable**

**Connecting the printer Locally**

Local printer refers to a printer connected to your computer using a USB cable. *If your printer is attached to a network instead of your computer*, skip this step and go on to "Connecting the printer to the Network".

**NOTE:** USB cables are sold separately. Contact Dell to purchase a USB cable.

**NOTE:** Connecting the printer to the USB port of the computer requires a certified USB cable. You will need to buy a USB 2.0 compliant cable that is about 3 m in length.

1. Ensure that the printer, computer, and any other attached devices are powered off and unplugged.

2. Connect a USB cable to the USB port on your printer.
3. Connect the other end of the cable to an available USB port on the computer, not the USB keyboard.

Connecting the printer to the Network

1. Ensure that the printer, computer, and any other attached devices are powered off and unplugged.

2. Connect one end of a standard category 5 Unshielded Twisted Pair (UTP) network cable to a LAN drop or hub, and the other end to the Ethernet network port on the back of the printer. The printer automatically adjusts for the network speed.

**NOTE:** After connecting the printer, you need to configure the network parameters on the operator panel. See "Printing a Network Configuration Page".

Powering On the Printer

**CAUTION:** The fusing area at the rear part of the inside of your printer becomes hot once the printer is powered on.

**CAUTION:** Be careful not to be burned when you access this area.
**CAUTION:** Do not disassemble the printer when it is powered on. *If you do*, it may give you an electric shock.

To power on the printer:

1. Plug one end of the power cord into the power receptacle at the back of the printer and the other end into a properly grounded outlet.

2. Press the power switch to turn on the printer. *Warming Up Please Wait* appears on the display indicating that the printer is now on.

**NOTE:** If you power on the printer for the first time, you have to set the language, date, time, country and fax setup sequence. These settings may be needed also after the firmware upgrade or after the printer reset.

### Setting fax setup sequence

1. Set the language. See "Changing the Display Language".

2. Select the country. See "Selecting Country".

3. Set the date and time. See "Setting the Time and Date".

4. When *Fax Setup* appears, press **Scroll** ( or ) to select *Yes* or *No*.
   
   *If you selected No*, your printer restores the fax settings as default.
   
   *If you selected Yes*:
   
   
   b. Enter machine ID. See "Setting the Printer ID".
   
   c. Select the receive mode and ring to answer. See "Setting up the Fax System".
   
   d. Test fax line. See "Testing Fax line connection".

5. Your printer returns to the Standby mode.
# Dell 2335dn MFP Menu Functions

<table>
<thead>
<tr>
<th>1. Scan</th>
<th>2. Copy</th>
<th>3. Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td># of copies</td>
<td>Enter Number:</td>
</tr>
<tr>
<td>USB Key</td>
<td>Zoom</td>
<td>Broadcast Fax</td>
</tr>
<tr>
<td>Fax Server</td>
<td>Contrast</td>
<td>Priority Fax</td>
</tr>
<tr>
<td>PC Application</td>
<td>Original Size</td>
<td>Phone Book</td>
</tr>
<tr>
<td>Scan Defaults</td>
<td>Original Type</td>
<td>Search</td>
</tr>
<tr>
<td></td>
<td>Select Tray</td>
<td>Delay Fax to:</td>
</tr>
<tr>
<td></td>
<td>Layout</td>
<td>Add Pages</td>
</tr>
<tr>
<td></td>
<td>Duplex</td>
<td>Cancel Job</td>
</tr>
<tr>
<td></td>
<td>Copy Defaults</td>
<td>On Hook Dial</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Setup</td>
<td>5. USB</td>
<td></td>
</tr>
<tr>
<td>Paper Setup</td>
<td>Email Setup</td>
<td>Scan Defaults</td>
</tr>
<tr>
<td>Tray Behaviour</td>
<td>Network Setup</td>
<td>Copy Defaults</td>
</tr>
<tr>
<td></td>
<td>Setup</td>
<td>Fax Defaults</td>
</tr>
<tr>
<td>Directory</td>
<td>Machine Setup</td>
<td>Job Management</td>
</tr>
<tr>
<td>Reports</td>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>Fax Setup</td>
<td>Restore Options</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Press **Scroll** (← or →) to highlight the desired menu function and then press **Select** ( ).

2. Press **Scroll** (△ or ▽) to highlight the desired menu function and then press **Select** ( ).

3. Repeat use of the (←), (→), (△), and (▽) to navigate to the desired setting, then press **Select** ( ) to select the displayed setting.

---

## Printing the Printer setting and Op-panel Menu setting
NOTE: This will be helpful for the users to maneuver through the op-panel setting and tree in changing the defaults.

**Printing the Printer setting**

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).

2. Press Scroll (▲ or ▼) to highlight Reports and then press Select (✓).

3. Press Scroll (▲ or ▼) to highlight Printer Settings and then press Select (✓).

4. The Printer Settings page prints out.

**Printing the Op-panel Menu setting**

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).

2. Press Scroll (▲ or ▼) to highlight Reports and then press Select (✓).

3. Press Scroll (▲ or ▼) to highlight Op-panel Menu Tree and then press Select (✓).

4. The Op-panel menu page prints out.

**Changing the Display Language**

To change the displayed language that the operator panel displays, follow these steps:

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).

2. Press Scroll (▲ or ▼) to highlight Machine Setup and then press Select (✓).

3. Press Scroll (▲ or ▼) to highlight Language and then press Select (✓).

4. Press Scroll (▲ or ▼) to display the language you want.

   The available languages are English, French, German, Italian, Spanish, and Dutch.

5. Press Select (✓) to save the selection.
6. Press **Cancel** (  ) to return to the Standby mode.

---

**Selecting Country**

To change the country that appears on the operator panel, follow these steps:

1. Press **Scroll** (  or  ) to highlight **Setup** and then press **Select** (  ).
2. Press **Scroll** (  or  ) to highlight **Machine Setup** and then press **Select** (  ).
3. Press **Scroll** (  or  ) to highlight **Select Country** and then press **Select** (  ).
4. Press **Scroll** (  or  ) to display the country you want and then press **Select** (  ).
5. Press **Cancel** (  ) to return to the Standby mode.

---

**Power Save Mode**

The Power Save mode enables your printer to reduce power consumption when it is not in actual use. You can enable this mode by selecting the duration for which the printer waits after a job is printed before it switches to a reduced power state.

1. Press **Scroll** (  or  ) to highlight **Setup** and then press **Select** (  ).
2. Press **Scroll** (  or  ) to highlight **Machine Setup** and then press **Select** (  ).
3. Press **Scroll** (  or  ) to highlight **Print Power Save** and press **Select** (  ).
4. Press **Scroll** (  or  ) to display the time settings you want.
   
   The available options are 5, 10, 15, 30, 60 and 120 (minutes).
   
   The factory default setting is 30 minutes.
5. Press **Select** (  ) to save the selection.
6. Press **Cancel** (  ) to return to the Standby mode.
Setting the Time and Date

The time and date are printed on all faxes.

**NOTE:** It may be necessary to reset the correct time and date if loss of power to the printer occurs.

To set the time and date:

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).
2. Press Scroll ( or ) to highlight Machine Setup and then press Select ( ).
3. Press Scroll ( or ) to highlight Date & Time and then press Select ( ).
4. Enter the correct time and date using the number keypad.

   - Month = 01 ~ 12
   - Day = 01 ~ 31
   - Year = 2000 ~ 2099
   - Hour = 01 ~ 12 (12-hour mode)
   - 00 ~ 23 (24-hour mode)
   - Minute = 00 ~ 59

   You can also use Scroll ( or ) to move the cursor under the digit you want to correct and enter a new number.

5. To select AM or PM for a 12-hour format, press the or the button.

   When the cursor is not under the AM or PM indicator, pressing the or the button immediately moves the cursor to the indicator.

   You can change the clock mode to a 24-hour format (e.g. 01:00 PM as 13:00). Press Scroll ( or ) to highlight AM or PM and then press Scroll ( or ).

6. Press Select ( ) when the time and date on the display is correct.

**NOTE:** The printer beeps and does not allow you to proceed to the next step if a wrong number is entered.

Setting Daylight Savings Time

If your country switches to Daylight Savings Time each year, use this procedure to automatically switch to
Daylight Savings Time and to Standard time.

1. Press Scroll (👈 or 👉) to highlight Setup and then press Select (✔).

2. Press Scroll (↖ or ↘) to highlight Machine Setup and then press Select (✔).

3. Press Scroll (↖ or ↘) to highlight Day Light Saving and then press Select (✔).

4. Press Scroll (↖ or ↘) to highlight Manual and then press Select (✔).

5. Enter Start Date and then press Select (✔).

6. Enter End Date and then press Select (✔).

7. Press Cancel (✘) to return to the Standby mode.

---

**Scanner Lamp Power Save Mode**

The scan lamp under the document glass automatically turns off when it is not in actual use after a preset period to reduce power consumption and extend the lamp life. The lamp automatically turns on and the warm-up cycle begins whenever any key is pressed or the DADF cover is opened or a document is detected in the DADF.

You can set the duration for which the scan lamp waits after a scan job is completed before it switches to the Power Save mode.

1. Press Scroll (👈 or 👉) to highlight Setup and then press Select (✔).

2. Press Scroll (↖ or ↘) to highlight Machine Setup and then press Select (✔).

3. Press Scroll (↖ or ↘) to highlight Scan Power Save and then press Select (✔).

4. Press Scroll (↖ or ↘) to display the time settings you want.

   The available time options are 30, 60, and 120 (minutes).

5. Press Select (✔) to save the selection.

6. Press Cancel (✘) to return to the Standby mode.
**Setting the Time Out Option**

You can set the time the printer waits before it restores the default copy or fax settings, if you do not start copying or faxing after changing the settings on the operator panel.

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Machine Setup and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Timeout and then press Select (✓).
4. Press Scroll (▲ or ▼) to display the timeout value you want.
   - The available time options are 15, 30, 60 and 180 (seconds).
   - You can select from 15, 30, 60 and 180 (seconds). Selecting Off means that the printer does not restore the default settings until you press Start (✓) to begin copying or faxing, or Cancel (✗) to cancel.
5. Press Select (✓) to save the selection.
6. Press Cancel (✗) to return to the Standby mode.

---

**Setting the Default Mode**

Your machine is preset to Fax mode. You can switch this default mode to Copy mode or Scan mode.

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Machine Setup and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Default Mode and then press Select (✓).
4. Press Scroll (▲ or ▼) to display the mode you want.
5. Press Select (✓) to save the selection.
6. Press Cancel (✗) to return to the Standby mode.

---

**Setting the Toner Save Mode**
Toner Save mode allows your machine to use less toner on each page. Activating this mode extends the life of the toner cartridge beyond what one would experience in the normal mode, but it reduces print quality.

1. Press Scroll (👈 or ➤ ) to highlight Setup and then press Select (✓).

2. Press Scroll (👈 or ➤ ) to highlight Machine Setup and then press Select (✓).

3. Press Scroll (👈 or ➤ ) to highlight Toner Save and then press Select (✓).

4. Press Scroll (👈 or ➤ ) to change the setting to On (enable) or Off (disable).

   Selecting On means that the printer uses less toner than normal printing.

5. Press Select (✓) to save the selection.

6. Press Cancel (❌) to return to the Standby mode.

---

**Setting the Levels of Toner Low Alert**

You can customize the level to alert toner low or toner empty. If the current toner amount drops below the setting level, the device will display a warning message on the operator panel.

1. Press Scroll (👈 or ➤ ) to highlight Setup and then press Select (✓).

2. Press Scroll (👈 or ➤ ) to highlight Machine Setup and then press Select (✓).

3. Press Scroll (👈 or ➤ ) to highlight Toner Status Alert and then press Select (✓).

4. Press Scroll (👈 or ➤ ) to highlight Toner Low and then press Select (✓).

5. Press Scroll (👈 or ➤ ) to display the Toner Low level you want.

   The available levels are 20, 30, 40, and 50 (%).

6. Press Scroll (👈 or ➤ ) to display the Alert on Panel and then press Select (✓).

7. Press Scroll (👈 or ➤ ) to change the setting to On (enable) or Off (disable).

   Selecting Off means that the printer does not display the Toner Low message.

8. Press Scroll (👈 or ➤ ) to display the Almost Empty level you want.

   The available levels are 5, 10, and 15 (%).

9. Press Scroll (👈 or ➤ ) to display the Alert on Panel and then press Select (✓).

10. Press Scroll (👈 or ➤ ) to change the setting to On (enable) or Off (disable).
Selecting **Off** means that the printer does not display the *Almost Empty* message.

11. Press **Cancel** (❌) to return to the Standby mode.

---

**Ignoring Blank Pages**

The printer detects the printing data from computer whether a page is empty or includes any data. To skip the blank pages at printing document, follow these steps:

1. Press **Scroll** (👈 or ➤) to highlight **Setup** and then press **Select** (✔️).
2. Press **Scroll** (👈 or ➤) to highlight **Machine Setup** and then press **Select** (✔️).
3. Press **Scroll** (👈 or ➤) to highlight **Print Blank Pages** and then press **Select** (✔️).
4. Press **Scroll** (👈 or ➤) to change the setting to **Do Not Print**.
5. Press **Select** (✔️) to save the selection.
6. Press **Cancel** (❌) to return to the Standby mode.

---

**Setting the Job Management**

1. Press **Scroll** (👈 or ➤) to highlight **Setup** and then press **Select** (✔️).
2. Press **Scroll** (👈 or ➤) to highlight **Job Management** and then press **Select** (✔️).
3. Press **Scroll** (👈 or ➤) to display the option and then press **Select** (✔️).
   - **Stored Jobs**: Print jobs currently stored in the hard disk. When a user sends a confidential job from PC to the device, it will hold the job until you release it with your password.
   - **Job Expiration**: Limits the amount of time a confidential job stays in the printer before it is deleted.
   - **Clear Stored Job**: You can delete jobs currently stored in the hard disk and RAM disk. If you select the **ALL**, all **Secure Jobs** and **Stored Prints** are deleted.
4. Set each option as you want and then press **Select** (✔️).
5. Press **Cancel** (❌) to return to the Standby mode.
Software Overview

After setting up your printer and connecting it should read as to your computer, you must install the drivers and utilities from the DRIVERS AND UTILITIES CD included with your printer. If you purchased a Dell™ computer and your printer at the same time, the drivers and utilities are automatically installed. You don’t need to install them. The DRIVERS AND UTILITIES CD contains the following:

- Dell Printer PCL driver- allows your computer to communicate with your printer. To use your printer as a printer in Windows, you must install the printer driver(s). For information about installing the printer drivers in Windows, see "Installing Software in Microsoft® Windows® Operating System".

- Dell Printer Configuration Web Tool- enables you to monitor the status of your network printer without leaving your desk.

- Printer Settings Utility- allows you to set up fax phonebook and the printer’s other options from your computer desktop.

- Dell Toner Management System - displays the status of the printer and the name of the job when you send a job to print. The Dell Toner Management System window also displays the level of toner remaining and allows you to order replacement toner cartridges.

- PaperPort - enables you to scan documents, create PDFs, and turn your scanned images into editable Microsoft Word, Excel, or text files. PaperPort provides improved scanning features and supports annotations on all image types. PaperPort's enhanced search feature enables you to find items by specific item properties.

- Dell ScanCenter - This is the application that enables you to quickly scan documents into a variety of applications, such as e-mail, photo editors, and text editors.

- Scan Driver- TWAIN or Windows Image Acquisition (WIA) drivers are available for scanning documents on your printer.

- User’s Guide - HTML documentation provides detailed information about using your printer.

- Set IP- Use this program to set your printer’s TCP/IP addresses.

- PS driver- PostScript Printer Description (PPD) file. You can use the PostScript driver to print documents.

- Dell Scan Manager- enables you to scan a document on your printer and save it to a network-connected computer.

- PC-Fax/Network-Fax- enables you to send a fax from your computer.

- Linux driver- enables you to print and scan in a Linux environment.

- Macintosh printer driver- enables you to use your printer with a Macintosh computer.

- Firmware Update Utility- use this program to update your machine's firmware. See "Firmware Update Utility".

- Status Monitor- This program allows you to monitor the printer’s status and alerts you when an error occurs during printing.

- LDAP- enables you to store e-mail addresses in the certain (LDAP) server. In the Embedded Web Service, you can set the LDAP server attributes.
Dell Printer Configuration Web Tool

The Dell Printer Configuration Web Tool, also known as the printer Embedded Web Service, lets you monitor the status of your network printer without leaving your desk. You can also view and/or change the printer configuration settings, monitor toner level, and order replacement toner cartridges, by clicking on the Dell supplies link right from your Web browser.

NOTE: The Dell Printer Configuration Web Tool is only available when the multi-function printer is connected to a (or the) network. See page "Using the Dell Toner Management System".

To launch the Dell Printer Configuration Web Tool, just type your network printer's IP address in your Web browser.

If you do not know what your printer's IP address is, print a network configuration page, which lists the IP address:

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).
2. Press Scroll ( or ) to highlight Reports and then press Select ( ).
3. Press Scroll ( or ) to highlight Network Settings and then press Select ( ) to print a network configuration page.

If an IP address has not been assigned, assign one for your printer. See "Configuring TCP/IP".

Printer Status

Get immediate feedback on printer supply status. When the toner is running low, click the toner supplies link on the first screen to order additional toner cartridges.
**Printer Settings**

Change the printer settings, view the printer settings status, and update the print server firmware.

*NOTE: Configuration Menu* blocks the user from altering the operator panel setting unless the correct password is entered.

**Available Options for Administrator**

Administrator can enable or disable services and I/O ports as the following items:

- COPY service
- FAX service
- SCAN service
- USB Port
- USB Host
- Ethernet
- Wireless Radio

**Printer Server Settings**

This menu supports configuration of following items:

- Basic Information about the administrator
- TCP/IP
- SNMP Traps
- SNMP Community
- SNMPv3
- SLP
- UPnP (SSDP)
- IPP
- EtherTalk
- Telnet

**Fax Settings**
Configure fax settings such as fax cover, receive mode, phone book, and fax server settings.

Fax server setting is needed for sending fax using a fax server.

For information about configuring fax server parameters, contact the fax server administrator.

**Available Options for FAX Server**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fax Server Menu</strong></td>
<td></td>
</tr>
<tr>
<td>Fax Server</td>
<td>When you select Enable, you are able to do fax server setting.</td>
</tr>
<tr>
<td>Default Scan Resolution</td>
<td>Select the default scanning resolution.</td>
</tr>
<tr>
<td>Default Attachment Type</td>
<td>Select the file format of an attachment.</td>
</tr>
<tr>
<td>Default [From:] Address</td>
<td>Enter your email address.</td>
</tr>
<tr>
<td>Default [To:] Address</td>
<td>Enter the recipient’s email address</td>
</tr>
<tr>
<td>Customization Field</td>
<td>You can customize the from, to or subject field.</td>
</tr>
<tr>
<td>Prefix</td>
<td>Input characters which shall be added in front of the customized field.</td>
</tr>
<tr>
<td>Suffix</td>
<td>Input characters which shall be appended at the end of the customized field.</td>
</tr>
</tbody>
</table>

**Email Settings**

Receive an email when the printer needs supplies or intervention. Type your name or the key operator’s name in the email list box to be notified.

Through this menu following features can be programmed:

- SMTP Server Setup
- SMTP Client Setup
- Email Alert Setup
- LDAP Server Setup

Following table information can be useful to assist you in setting up above mention deliverable:

**Available Options for Email Alert**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>IP</td>
</tr>
</tbody>
</table>
### Alert Setup

<table>
<thead>
<tr>
<th><strong>Alert Setup</strong></th>
<th><strong>Address or Host Name</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary SMTP Gateway</strong></td>
<td>Sets the primary SMTP gateway.</td>
</tr>
<tr>
<td><strong>SMTP Port Number</strong></td>
<td>Specifies the SMTP port number. This must be 25 or between 5000 and 65535.</td>
</tr>
<tr>
<td><strong>Enable Primary SMTP Auth</strong></td>
<td>Specifies the authentication method for outgoing e-mail.</td>
</tr>
<tr>
<td><strong>Primary SMTP Account Name</strong></td>
<td>Specifies the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td><strong>Primary SMTP Account Password</strong></td>
<td>Specifies the SMTP account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td><strong>Primary From</strong></td>
<td>Sender's e-mail address registered in the Primary server.</td>
</tr>
<tr>
<td><strong>SMTP Timeout</strong></td>
<td>Sets the timeout period from 30 to 120 seconds.</td>
</tr>
<tr>
<td><strong>Reply Address</strong></td>
<td>Designates the reply e-mail address sent with each E-mail Alert.</td>
</tr>
</tbody>
</table>

### Setup POP3 before SMTP

<table>
<thead>
<tr>
<th><strong>Setup POP3 before SMTP</strong></th>
<th><strong>POP3 Server and Port</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>POP3 Server and Port</strong></td>
<td>Specifies the POP3 server address in IP address format of &quot;aaa.bbb.ccc.ddd&quot; or as a DNS host name up to 63 characters. And specifies the POP3 server port number up to 15 alphanumeric characters.</td>
</tr>
<tr>
<td><strong>POP3 User Name</strong></td>
<td>Specifies the POP3 account user name. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td><strong>POP3 User Password</strong></td>
<td>Specifies the POP3 account password up to 31 alphanumeric characters.</td>
</tr>
</tbody>
</table>

### Email Alert Setup

<table>
<thead>
<tr>
<th><strong>Email Alert Setup</strong></th>
<th><strong>Email List</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email List</strong></td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
</tr>
<tr>
<td><strong>Email List</strong></td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Select Alerts for List 1</strong></th>
<th><strong>Supply Alert</strong></th>
<th>Select the check box to receive an E-Mail Alert for consumables.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Handling Alert</strong></td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Select Alerts for List 2</strong></th>
<th><strong>Supply Alert</strong></th>
<th>Select the check box to receive an E-Mail Alert for consumables.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Handling Alert</strong></td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
<td></td>
</tr>
</tbody>
</table>
Available Options for LDAP Server

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP Server Setup</td>
<td>Specifies the LDAP server address in IP address format of &quot;aaa.bbb.ccc.ddd&quot; or as a DNS host name up to 63 characters. And specifies the LDAP server port number up to 15 alphanumeric characters.</td>
</tr>
<tr>
<td>Search Root Directory</td>
<td>Enter the top search level of the LDAP directory tree.</td>
</tr>
<tr>
<td>Authentication method</td>
<td>Specifies the authentication method for outgoing LDAP server.</td>
</tr>
<tr>
<td>Append Root to Base DN</td>
<td>Check if it is needed to append base DN at the end of the user DN.</td>
</tr>
<tr>
<td>Login Name</td>
<td>Specifies the LDAP account user name. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies the LDAP account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td>Maximum Number of Search Results</td>
<td>'0' means that the number of LDAP search results does not have limit. It shall be 5 ~ 100 entries.</td>
</tr>
<tr>
<td>Search Timeout</td>
<td>Sets the timeout period from 5 to 100 seconds.</td>
</tr>
<tr>
<td>LDAP Referral</td>
<td>Check if it is necessary.</td>
</tr>
<tr>
<td>Search Name Order</td>
<td>- Choose Common Name if user id has &quot;cn=&lt;user name&gt;&quot; form.</td>
</tr>
<tr>
<td></td>
<td>- Choose Email Address if user id has &quot;mail=&lt;user name&gt;&quot; form.</td>
</tr>
<tr>
<td></td>
<td>- Choose Surname Given Name otherwise.</td>
</tr>
</tbody>
</table>

Copy Printer Settings

Quickly clone the printer’s settings to another printer or printers on the network just by typing each printer’s IP address.

⚠️ **NOTE:** You must be a network administrator to use this feature.

Printing Statistics
Keep track of printing trends, such as paper usage and the types of jobs being printed.

**Set Password**

* Dell Printer Configuration Web Tool (**Embedded Web Service**) can be locked by setting password. When any of the printer settings are changed using this tool, it will prompt for User name and Password.

**Locking Operator Panel:**

This feature is enabled using **Embedded Web Service** and locks the user from altering the operator panel setting unless password is specified.

⚠️ **NOTE:** You must be a network administrator to use this feature.

⚠️ **NOTE:** The default user name is admin and the default password is left blank (NULL).

⚠️ **NOTE:** If you forget the password, please call for service.

**Wireless**

Please refer to Wireless Quick Reference Guide for more details on wireless module settings with the printer.

⚠️ **NOTE:** The **Wireless** menu appears only when you install the wireless network interface card to your machine.

**Online Help**

Click **Help** to visit the Dell website for printer troubleshooting.

⚠️ **NOTE:** For more information about the All-In-One Main page, View Saved Images page, or the Maintain/Troubleshoot page, click the **Help** link located in the upper right corner of the screen.

**Installing Software in Microsoft® Windows® Operating System**

Before you begin, ensure that your system meets the "Minimum Requirements".


**Supported Operating Systems**

- Windows 2000 Professional or Advanced Server
- Windows XP Home edition or Professional
- Windows Vista
- Windows 7

**Minimum Requirements**

- Disk space: Windows 2000: 300 MB
  - Windows 7: 16 GB
  - Windows Server 2008 R2: 10GB
- Memory: Windows 2000: 64 MB
  - Windows XP/Server 2003: 128 MB
  - Windows Vista/Server 2008: 512 MB
  - Windows 7: 1 GB
  - Windows Server 2008 R2: 512MB(2048MB)
- CPU: Windows 2000: Pentium II 400 MHZ or higher
  - Windows XP/Server 2003/Server 2008/Vista: Pentium III 933 MHZ or higher
  - Windows 7: Pentium IV 1 GHz 32 bit or 64 bit processor or higher
  - Windows Server 2008 R2: Pentium IV 1 GHz (x86) or 1.4 GHz (x64) processors (2 GHz or faster)
- Required software: Internet Explorer 5.0 or higher

**Installing Dell Software for Local Printing**

A local printer is a printer attached to your computer using a USB cable. *If your printer is attached to a network instead of your computer*, skip this step and go on to "Installing Dell Software for Network Printing".

A printer driver is software that lets your computer communicate with your printer. The procedure to install drivers depends on the operating system you are using.

**NOTE:** If you attach a USB printer cable while your printer and computer are powered on, the Windows hardware wizard launches immediately. Cancel the screen and use the DRIVERS AND UTILITIES CD to install the Dell software.

1. Ensure that the printer is connected to your computer and powered on. All applications should be closed on your computer before beginning installation.
NOTE: If the printer is not connected to your computer when you install the *DRIVERS AND UTILITIES CD*, the *No Printer Found* screen appears. Follow the instructions on the screen to install the software.

2. Insert the *DRIVERS AND UTILITIES CD*.

   **NOTE:** For Windows Vista/Windows 7/Server 2008 R2, click *Continue* when the *User Account Control* screen appears.

   **NOTE:** If user has disabled auto continue. Then please open *setup.exe* from CD root folder.

3. *If necessary*, select a language by pressing the *Language* button on the main screen.

4. Select *Personal Installation*.

5. Select *Typical Installation* to install the software and the *User's Guide*.

   If you select *Custom Installation*, select the components to be installed. You can also change the destination folder. Click *Next*.
NOTE: If your printer is not connected to the computer, the following printer not founder windows will appear.

6. When the installation is complete, you may print a test page. Click Finish to complete the installation and close the wizard. You are now ready to print.

Network Installation

Assigning an IP Address

Before using the printer on the network, you must set an IP address, subnet mask, and gateway for the printer. If you want DHCP or BOOTP to automatically set the IP address, a DHCP or BOOTP server must exist on the network.

If the network is using DHCP/BOOTP, an IP address is automatically assigned after connecting the network cable to the printer. In case no DHCP or BOOTP the printer will automatically assign a legacy IP address 192.0.0.192 or local link address 169.254.xxx.xxx.

To configure the IP address manually, you can use the supplied DRIVERS AND UTILITIES CD. Print the Configuration page of the printer to see the current network configuration and MAC address. You will need this information to configure the printer for the network.

1. Ensure that the printer is connected to your network and powered on. Close all programs.

2. Insert the DRIVERS AND UTILITIES CD.

   NOTE: For Windows Vista/Windows 7/Server 2008 R2, click Continue when the User Account Control screen appears.

   NOTE: If user has disabled auto continue. Then please open setup.exe from CD root folder.
3. If necessary, select a language by pressing the Language button on the main screen.

4. Select Set IP Address. The list of printers is available on the network displays.

5. Select the printer you want to assign an MAC address to. The printer's MAC address can be found on the Configuration page for the printer.

6. When you finish setting the IP address for the printer, exit the program.

**Installing Dell Software for Network Printing**

When you connect your printer to the network, you must first configure the TCP/IP settings for the printer. After assigning and verifying the TCP/IP settings, you are ready to install the Dell software on each network printer.

You can install the Dell software on the network computers locally or remotely.

**NOTE:** You need administrative access to install printer drivers on the network computers.
1. Ensure that the printer is connected to your network and powered on. All applications should be closed on your computer before beginning installation. For details about connecting on the network, see "Connecting the printer to the Network".

2. Insert the **DRIVERS AND UTILITIES CD**.
   
   **NOTE:** For Windows Vista/Windows 7/Server 2008 R2, click **Continue** when the **User Account Control** screen appears.
   
   **NOTE:** If user has disabled auto continue. Then please open **setup.exe** from CD root folder.

3. If necessary, select a language by pressing the **Language** button on the main screen.

4. Select **Network Installation**.

5. If you want to install the drivers on this computer for network operation, select **Local Installation**, and then click **Next**.

   *If you want to install the Dell software on remote computers or network servers on the same network, select **Remote Installation**. The domain administrator's ID and password are required. Select the client computer(s) in the same domain on a network and then click **Next**.*

NOTE: The server computer should be able to resolve the client computer name into an IP address.

6. The list of printers available on the network appears. Select the printer that you want to install from the list and then click Next.

If you do not see your printer in the list, click Refresh to refresh the list or click Add Printer to add your printer to the network. To add the printer to the network, enter the port name and an existing IP address for the printer.

If you want to install the printer on a server, select the I am setting up this printer on a server check box.

7. The screen displays the printer drivers installed on your computer.

You can change the printer name, set the printer to be shared on the network, and set the printer as the default printer. Click Next.
8. Select **Custom Installation**. Click **Next**.

   If you select **Typical Installation**, go to step 10.

9. Select the components to be installed, and you can also change the destination folder. Click **Next**.

10. When the printer installation is complete, you may print a test page. Click **Finish** to complete the installation and close the wizard. You are now ready to print.

**NOTE:** For information about installing the wireless network interface card and configuring the network parameters, refer to Wireless Network Quick Install Guide.

---

**Uninstalling Software**

You should remove the printer drivers if you are upgrading the software or if your driver installation fails. You can remove the software using the *DRIVERS AND UTILITIES CD* or the Windows uninstall option.
NOTE: Close all programs before uninstalling software, and then restart your computer after uninstalling the software.

1. From the Start menu, select Programs → Dell Printers → Dell 2335dn MFP → Dell MFP Software Uninstall.

2. Select the software you want to remove. Click Next.

The selected driver and all of its components are removed from your computer.

3. After the software is removed, click Finish.

Using the Dell Toner Management System

The Printer Status Monitor displays the status of printer which connect with local or network. Printer Ready, Printer Offline, and Error-Check Printer, and the toner level or Toner Low will be appeared for your printer.

Printer Status Monitor

The Printer Status Monitor screen launches when you send a print job to the printer. This only appears on the computer screen. Depending on the remaining toner level, the launched Printer Status Monitor screen is different.
NOTE: Help me on Printer Status Monitor window will show you the printer troubleshooting guide. Click Help me to show an animation details about the error condition.

Or

From the Start menu, select Programs → Dell Printers → Dell 2335dn MFP → Printer Status Monitor.

Printer Settings Utility

By using the Printer Settings Utility window, you can set up fax system data options, and create and edit Phonebook entries from your computer.

When you install the software, the Printer Settings Utility is automatically installed.

For information about installing the software, see "Installing Software in Microsoft® Windows® Operating System".

To open the Printer Settings Utility:

1. From the Start menu, select Programs → Dell Printers → Dell 2335dn MFP → Printer Settings Utility.

The Printer Settings Utility window opens.
2. The **Printer Settings Utility** window provides several features; **Directory** *(Phonebook, Address Book)*, **Fax Setting**, and **Setting**.

For further details, click the button.

To use the default settings, click the **Printer Default** button.

To exit, click the **Exit** button at the bottom of the window.

**The Directory Section**

Click the **Phonebook** or **Address Book** section and the **Setting** button to create and edit Phonebook or Emailbook entries.

**The Fax Setting Section**

Click each items under **Fax Setting** to setup the fax configuration. The printer setup contains the printer ID and printer fax number. Your can select **Printer Setup**, **Toll Save**, and **Default Output Options**.
The Setting Section

Click the Setting section and select the power save from the drop-down list.

You can select Power Save and Emulation Type.

The Layout Section

Click the Layout section and select the orientation from the drop-down list.

You can select Orientation, Duplex, and Duplex Margin.

The Paper Option Section

Click the Paper Option section and select the basic paper handling specifications from the drop-down list.

You can select Copies, Paper Size, Paper Type, Paper Source, and Tray Linking.

The Graphic Section

Click the Graphic section and select the degree of darkness from the drop-down list.

You can select Darkness.

The Emulation Section

Click the Emulation section and select the emulation from the drop-down list. Also you can add additional fonts.

You can select Emulation Setting.

If you want additional PCL or PS font, select Store PCL Font and Macro in Emulation Setting.

The Network(IPv4) Section
Click the **Network(IPv4)** section and select the network environment from the drop-down list.

You can select **Configure Network** and **Print Network Configuration Page**.

---

**Firmware Update Utility**

You can machine firmware update using **Firmware Update Utility**.

1. From the **Start** menu, select **Programs ➔ Dell Printers ➔ Dell 2335dn MFP ➔ Firmware Update Utility**.

2. Download the latest firmware. Click [http://support.dell.com](http://support.dell.com).

3. If your printer is connected with an USB cable, click **USB Connected Printer**.

   Or if your printer is connected with a network cable, click **Network Connected Printer**.

4. Click **Browse** and select downloaded firmware file.

5. Click **Update Firmware**.
Set IP Address Utility

This program is for the network IP setting using the MAC address which is the hardware serial number of the network printer card or interface. Especially, it is for the network administrator to set several network IPs at the same time.

**NOTE:** You can only use Set IP Address Utility when your printer is connected to a network.

1. Connect the network cable to your machine.
2. Print the Network Configuration page of the printer to see the current network configuration and MAC address.
3. From the Start menu, select Programs ➔ Dell Printers ➔ Dell 2335dn MFP ➔ Set IP Address Utility.

4. Click in the SetIP window to open the TCP/IP configuration window.
5. Enter the network card’s MAC address, IP address, subnet mask, default gateway, and then click Apply.

**NOTE:** when you enter the MAC address, enter it without colon(:).

6. Click OK.
7. Click Exit to close the SetIP program.
Print Media Guidelines

Print media is paper, card stock, transparencies, labels, and envelopes. Your printer provides high quality printing on a variety of print media. Selecting the appropriate print media for your printer helps you to avoid printing problems. This chapter provides information on how to help you make print media selections, how to care for the print media, and how to load it in the tray 1, optional tray 2, or MPF.

Paper

For the best print quality, use 75 g/m\(^2\) (20 lb) xerographic, long grain paper. Try a sample of any paper you are considering using with the printer before buying large quantities.

When loading paper, note the recommended print side on the paper package, and load the paper accordingly. See "Loading Print Media in the Paper Tray" and "Using the MPF (Multi purpose feeder)" for detailed loading instructions.

Paper Characteristics

The following paper characteristics affect print quality and reliability. We recommend that you follow these guidelines when evaluating new paper stock.

**Weight**

The printer can automatically feed paper weights from 60 to 105 g/m\(^2\) (16 to 24lb bond) grain long in the DADF and from 60 to 105g/m\(^2\) (16 to 24 lb bond) grain long in the paper tray. Paper lighter than 60 g/m\(^2\) (16 lb) may not be stiff enough to feed properly, causing jams. For best performance, use 75 g/m\(^2\) (20 lb bond) long grain paper.

For duplex printing, use 75 to 90 g/m\(^2\) (20 to 24 lb bond) paper.
Curl

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl usually occurs after the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in humid conditions, even in the paper tray, can contribute to paper curling prior to printing and can cause feeding problems.

Smoothness

The degree of smoothness of the paper directly affects the print quality. If the paper is too rough, the toner does not fuse to the paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding problems. Smoothness should be between 100 and 300 Sheffield points; however, smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture Content

The amount of moisture in the paper affects both print quality and the ability of the printer to feed the paper properly. Leave the paper in its original wrapper until you are ready to use it. This limits the exposure of the paper to moisture changes that can degrade its performance.

Grain Direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either long grain, running the length of the paper, or short grain, running the width of the paper.

For 60 to 90 g/m² (16 to 24 lb bond) paper, grain long fibers are recommended. For papers heavier than 90 g/m² (24 lb bond), grain short is preferred. For the MPF, 60 to 90 g/m² (16 to 24 lb bond) paper, grain long fibers are recommended.

Fiber Content

Most high-quality xerographic paper is made from 100% chemically pulped wood. This content provides the paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing fibers such as cotton possess characteristics that can result in degraded paper handling.

Recommended Paper

To ensure the best print quality and feed reliability, use 75 g/m² (20 lb) xerographic paper. Business papers designed for general business use may also provide acceptable print quality.

Always print several samples before buying large quantities of any type of print media. When choosing any print media, consider the weight, fiber content, and color.

Use only paper which can withstand these temperatures without discoloring, bleeding, or releasing
hazardous emissions. Check with the paper manufacturer or vendor to determine whether the paper you have chosen is acceptable for laser printers.

**Unacceptable Paper**

The following papers are not recommended for use with the printer:

- Chemically treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless copy paper (CCP), or no carbon required (NCR) paper
- Preprinted papers with chemicals that may contaminate the printer
- Preprinted papers that can be affected by the temperature in the printer fuser
- Preprinted papers that require a registration (the precise print location on the page) greater than ± 0.09 in., such as optical character recognition (OCR) forms
- Coated papers (erasable bond), synthetic papers, thermal papers
- Rough-edged, rough or heavily textured surface papers or curled papers
- Recycled papers containing more than 25% post-consumer waste that do not meet DIN 19 309
- Recycled paper having a weight less than 60 g/m² (16 lb)
- Multiple-part forms or documents

**Selecting Paper**

Proper paper loading helps prevent jams and ensures trouble-free printing.

To help avoid jams or poor print quality:

- Always use new, undamaged paper.
- Before loading paper, know the recommended print side of the paper you are using. This information is usually indicated on the paper package.
- Do not use paper that you have cut or trimmed yourself.
- Do not mix print media sizes, weights, or types in the same source; mixing results in jams.
- Do not use coated papers.
- Remember to change the paper size setting when you use a source that does not support auto size sensing.
- Do not remove trays while a job is printing.
- Ensure that the paper is properly loaded in the source.
- Flex paper back and forth. Do not fold or crease the paper. Straighten the edges on a level surface.
Selecting Preprinted Forms and Letterhead paper

Use the following guidelines when selecting preprinted forms and letterhead paper for the printer:

- Use long grain papers for best results.
- Use only forms and letterheads printed using an offset lithographic or engraved printing process.
- Choose papers that absorb ink, but do not bleed.
- Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat-resistant inks which have been designed for use in xerographic copiers. The ink must withstand temperatures of 180° C (356° F) without melting or releasing hazardous emissions. Use inks that are not affected by the resin in the toner or the silicone in the fuser. Inks that are oxidation-set or oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier.

Preprinted papers such as letterheads must be able to withstand temperatures up to 180° C (356° F) without melting or releasing hazardous emissions.

Printing on a Letterhead paper

Check with the manufacturer or vendor to determine whether the preprinted letterhead paper that you have chosen is acceptable for laser printers.

Page orientation is important when printing on a letterhead paper. Use the following table for help when loading a letterhead paper in the print media sources.
<table>
<thead>
<tr>
<th>Print Media Source</th>
<th>Top of Page</th>
<th>Print Side</th>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td>tray 1 (standard tray)</td>
<td>Front of tray</td>
<td>Print side face down for simplex (single sided) printing</td>
<td>Front of tray</td>
<td>Left side of tray</td>
</tr>
<tr>
<td>optional tray 2</td>
<td>Logo enters the printer first</td>
<td>Print side face up for duplex printing</td>
<td>Left side of tray</td>
<td></td>
</tr>
<tr>
<td>MPF</td>
<td>Left side of tray</td>
<td>Face up</td>
<td>Logo enters the printer first</td>
<td></td>
</tr>
</tbody>
</table>

### Selecting Prepunched Paper

Prepunched paper brands can differ in the number and placement of holes and in manufacturing techniques.

Use the following guidelines to select and use prepunched paper:

- Test paper from several manufacturers before ordering and using large quantities of pre-punched paper.
- Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled paper can cause jams when multiple sheets feed through the printer.
- Prepunched paper can include more paper dust than standard paper. Your printer may require more frequent cleaning and feed reliability may not be as good as that of standard paper.
Transparencies

Try a sample of any transparencies you are considering using with the printer before buying large quantities:

- Use transparencies designed specifically for laser printers. Transparencies must be able to withstand temperatures of 180° C (356° F) without melting, discoloring, offsetting or releasing hazardous emissions.

- Avoid getting fingerprints on the transparencies, as this can cause poor print quality.

- Before loading transparencies, fan the stack to prevent the sheets from sticking together.

- Load one transparency into the MPF.

Selecting Transparencies

The printer can print directly on transparencies which have been designed for use in laser printers. Print quality and durability depends on the transparency used. Always print samples on the transparencies you are considering before buying large quantities.

Check with the manufacturer or vendor to determine whether your transparencies are compatible with laser printers that heat transparencies to 180° C (356° F). Use only transparencies that are able to withstand these temperatures without melting, discoloring, offsetting, or releasing hazardous emissions.

Envelopes

Try a sample of any envelopes you are considering using with the printer before buying large quantities. See "Using the MPF (Multi purpose feeder)" for instructions on loading an envelope.

When printing on envelopes:

- To achieve the best possible print quality, use only high-quality envelopes that are designed for use in laser printers.

- For best performance, use envelopes made from 75 g/m² (20 lb bond) paper. You can use up to 90 g/m² (24 lb bond) weight for the MPF as long as the cotton content is 25 percent or less.

- Use only new, undamaged envelopes.

- For best performance and to minimize jams, do not use envelopes that:
  
  - Have excessive curl or twist
  
  - Are stuck together or damaged in any way
  
  - Contain windows, holes, perforations, cutouts or embossing
  
  - Use metal clasps, string ties, or metal folding bars
  
  - Have an interlocking design
- Have postage stamps attached
- Have any exposed adhesive when the flap is in the sealed or closed position
- Have nicked edges or bent corners
- Have rough, cockle, or laid finishes
  Use envelopes that can withstand temperatures of 180° C (356° F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions. *If you have any doubts about the envelopes you are considering using,* check with the envelope supplier.
- Adjust the width guide to fit the width of the envelopes.
- Load an envelope with the flap side down and with the stamp area on the top left side. The end of the envelope with the stamp area enters the MPF first.

See "Using the MPF (Multi purpose feeder)" for instructions on loading an envelope.

**NOTE:** You can improve the printing quality of envelopes by pulling down the rear door to open and pushing the two blue pressure levers down. This instruction will be especially helpful for DL, and C5 size envelopes.

- A combination of high humidity (over 60%) and the high printing temperatures may seal the envelopes.
Labels

Your printer can print on many labels designed for use with laser printers. These labels are supplied in letter size, A4 size, and legal size sheets. Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 180° C (356° F) and pressure of 25 pounds per square inch (psi). You can load one label sheet at a time in the MPF.

Try a sample of any label you are considering using with the printer before purchasing a large quantity:

- Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets also contaminate your printer and your cartridge with adhesive, and could void your printer and cartridge warranties.
- Use labels that can withstand temperatures of 180° C (356° F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions.
- Do not print within 0.04 in. (1 mm) of the edge of the label, of the perforations, or between die-cuts of the label.
- Do not use label sheets that have adhesive to the edge of the sheet. We recommend zone coating of the adhesive at least 0.04 in. (1 mm) away from edges. Adhesive material contaminates your printer and could void your warranty.
- If zone coating of the adhesive is not possible, a 0.125 in. (3 mm) strip should be removed on the leading and driver edge, and a non-oozing adhesive should be used.
- Remove a 0.125 in. (3 mm) strip from the leading edge to prevent labels from peeling inside the printer.
- Portrait orientation is preferred, especially when printing bar codes.
- Do not use labels that have exposed adhesive.

Card Stock

Card stock is single ply, and has a large array of properties, such as the moisture content, thickness, and texture, that can significantly affect print quality. See "Identifying Print Media Sources and Specifications" for information on the preferred weight for the grain direction of print media.

Try a sample of any card stock you are considering using with the printer before purchasing a large quantity:

- Be aware that preprinting, perforation, and creasing can significantly affect the print quality and cause print media handling or jamming problems.
- Avoid using card stock that may release hazardous emissions when heated.
- Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting introduces semi-liquid and volatile components into the printer.
Storing Print Media

Use the following guidelines for proper print media storage. These help avoid print media feeding problems and uneven print quality:

- For best results, store print media in an environment where the temperature is approximately 21° C (70° F) and the relative humidity is 40%.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- *If you store individual packages of print media out of the original carton*, ensure that they rest on a flat surface so the edges do not buckle or curl.
- Do not place anything on top of the print media packages.

Identifying Print Media Sources and Specifications

The following tables provide information on standard and optional sources, including the print media sizes that you can select from the paper size menu and supported weights.

**NOTE:** *If you use a print media size not listed, select the next larger size.*

### Media Input Capacity

<table>
<thead>
<tr>
<th>Papera</th>
<th>Paper Tray (tray 1 and optional tray 2)</th>
<th>MPFb</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>250 sheets of 75 g/m² bond (20 lb)</td>
<td>50 sheet of 75 g/m² bond (20 lb)</td>
</tr>
<tr>
<td>Transparencyc, Labels, Cards, Envelopes</td>
<td>-</td>
<td>5 sheets of 75 g/m² bond (20 lb)</td>
</tr>
</tbody>
</table>

a. Recommend the use of manual for special media such as transparency, envelope, and card.
b. For special media in MPF, the feeding quality may be degraded depending on the status of paper.
c. Recommend the use of short edge for the paper-backed transparency.

### Media Output Capacity
<table>
<thead>
<tr>
<th>Output Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face down</td>
<td>150 sheets of 75 g/m² bond (20 lb) paper</td>
</tr>
<tr>
<td></td>
<td>5 sheets of transparency, envelope, label, and card.</td>
</tr>
<tr>
<td>Face up</td>
<td>1 sheet b</td>
</tr>
</tbody>
</table>

a. The face up is mainly for envelope and thick paper.
b. Push the two blue pressure levers down for better printing quality of envelope, label, card, and thick paper.

**Print Media Sizes and Support**

<table>
<thead>
<tr>
<th>Print Media Size</th>
<th>Dimensions</th>
<th>Paper Tray (tray 1 and optional tray 2)</th>
<th>MPF</th>
<th>Duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>8.27 x 11.7 in. (210 x 297 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A5 b</td>
<td>5.83 x 8.27 in. (148 x 210 mm)</td>
<td>Y</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>A6</td>
<td>4.13 x 5.85 in. (105 x 148.5 mm)</td>
<td>-</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>JIS B5</td>
<td>7.17 x 10.1 in. (182 x 257 mm)</td>
<td>Y</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>ISO B5</td>
<td>6.93 x 9.84 in. (176 x 250 mm)</td>
<td>Y</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>Letter</td>
<td>8.5 x 11 in. (215.9 x 279.4 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Legal</td>
<td>8.5 x 14 in. (215.9 x 355.6 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Executive</td>
<td>7.25 x 10.5 in. (184.2 x 266.7 mm)</td>
<td>Y</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>Oficio</td>
<td>8.5 x 13.5 in. (216 x 343 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Folio</td>
<td>8.5 x 13 in. (216 x 330 mm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Envelope 7-3/4 (Monarch)</td>
<td>3.875 x 7.5 in. (98.4 x 190.5 mm)</td>
<td>-</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>Envelope COM-10</td>
<td>4.12 x 9.5 in. (105 x 241 mm)</td>
<td>-</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>Envelope DL</td>
<td>4.33 x 8.66 in. (110 x 220 mm)</td>
<td>-</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>Envelope C5</td>
<td>6.38 x 9.01 in. (162 x 229 mm)</td>
<td>-</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>Envelope C6</td>
<td>4.49 x 6.38 in. (114 x 162 mm)</td>
<td>-</td>
<td>Y</td>
<td>-</td>
</tr>
<tr>
<td>Custom</td>
<td>3 x 5 in. to 8.5 x 14 in. (76 x 127 mm to 216 x 356 mm)</td>
<td>-</td>
<td>Y</td>
<td>-</td>
</tr>
</tbody>
</table>

a. Ensure the A5 paper is NOT A4 paper that has been cut in half.

**Print Media Supported**

<table>
<thead>
<tr>
<th>Print Media (Paper) Types</th>
<th>Paper Tray (tray 1 and optional tray 2)</th>
<th>MPF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain, Thin, Recycled, Letterhead</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Thick, Bond, Preprinted, Colored</td>
<td>-</td>
<td>Y</td>
</tr>
<tr>
<td>Card Stock</td>
<td>-</td>
<td>Y</td>
</tr>
<tr>
<td>Transparencies</td>
<td>-</td>
<td>Y</td>
</tr>
<tr>
<td>Labels</td>
<td>-</td>
<td>Y</td>
</tr>
<tr>
<td>Dual-web and Integrated Labels</td>
<td>-</td>
<td>Y</td>
</tr>
</tbody>
</table>
## Print Media Types and Weights

<table>
<thead>
<tr>
<th>Print Media</th>
<th>Type</th>
<th>Print Media Weight</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Tray 1 and Optional Tray 2</td>
<td>MPF</td>
</tr>
<tr>
<td>Paper</td>
<td>Xerographic or business paper</td>
<td>60-90 g/m² grain long (16-24 lb bond)</td>
<td>60-135 g/m² grain long (16 to 36 lb bond)</td>
</tr>
<tr>
<td>Paper</td>
<td>Index Bristol</td>
<td>-</td>
<td>120 g/m² (31 lb)</td>
</tr>
<tr>
<td>Paper</td>
<td>Tag</td>
<td>-</td>
<td>120 g/m² (31 lb)</td>
</tr>
<tr>
<td>Paper</td>
<td>Cover</td>
<td>-</td>
<td>135 g/m² (35 lb)</td>
</tr>
<tr>
<td>Card stock-maximum (grain long)²</td>
<td>Index Bristol</td>
<td>-</td>
<td>163 g/m² (43 lb)</td>
</tr>
<tr>
<td>Card stock-maximum (grain short)²</td>
<td>Tag</td>
<td>-</td>
<td>163 g/m² (43 lb)</td>
</tr>
<tr>
<td>Card stock-maximum (grain short)²</td>
<td>Cover</td>
<td>-</td>
<td>163 g/m² (43 lb)</td>
</tr>
<tr>
<td>Transparencies²</td>
<td>Laser printer</td>
<td>-</td>
<td>138-146 g/m² (37-39 lb bond)</td>
</tr>
<tr>
<td>Labels-maximum</td>
<td>Paper</td>
<td>-</td>
<td>163 g/m² (43 lb bond)</td>
</tr>
<tr>
<td>Labels-maximum</td>
<td>Dual-web paper</td>
<td>-</td>
<td>163 g/m² (43 lb bond)</td>
</tr>
<tr>
<td>Labels-maximum</td>
<td>Polyester</td>
<td>-</td>
<td>163 g/m² (43 lb bond)</td>
</tr>
<tr>
<td>Labels-maximum</td>
<td>Vinyl</td>
<td>-</td>
<td>163 g/m² (43 lb liner)</td>
</tr>
<tr>
<td>Integrated Forms</td>
<td>Pressure-sensitive area (must enter the printer first)</td>
<td>-</td>
<td>135-140 g/m² (36-40 lb bond)</td>
</tr>
<tr>
<td>Integrated Forms</td>
<td>Paper base (grain long)</td>
<td>-</td>
<td>75-135 g/m² (20-36 lb bond)</td>
</tr>
</tbody>
</table>
### Selecting an Output Location

The printer has two output locations; the output tray (face down) and the rear door (face up).

To use the output tray, ensure that the rear door is closed. To use the rear door, open it.

- **NOTE:** If paper coming out of the output tray has problems, such as excessive curl, try printing to the rear door.
- **NOTE:** To avoid paper jams, do not open or close the rear door while the printer is printing.

#### Printing to the Output Tray (*Face down*)

The output tray collects printed paper face-down, in the correct order. The tray should be used for most print jobs.
If necessary, expand the paper output extension to keep the print media from falling off the output tray.

Printing to the Rear Door *(Face up)*

Using the rear door, the paper comes out of the printer face up.

Printing from the MPF to the rear door provides a straight paper path. Using the rear door might improve the output quality with special materials.

To use the rear door:

Open the rear door by pulling it.

⚠️ **CAUTION:** The fuser area inside of the rear door of your printer becomes very hot when in use. Take care when you access this area.

Loading Print Media in the Paper Tray
You can load approximately 250 sheets of plain paper in the tray 1 or the optional tray 2. If you purchased the optional tray 2, see "Installing an Optional Tray 2" for installing instructions. For faxing, you can use A4, letter or legal paper only. For copying or printing, you can use many different types and sizes of paper; see "Identifying Print Media Sources and Specifications".

Follow these instructions to load print media into the tray 1 or optional tray 2. These trays are loaded the same way.

1. Pull open the paper tray and load paper with the print side face down.

You can load letterhead paper with the design side face down. The top edge of the sheet with the logo should be placed at the front side of the tray.

For details about loading paper in the paper tray, see "Loading Paper".

**NOTE:** If you experience problems with paper feed, place the paper in the MPF.

**NOTE:** You can load previously printed paper. The printed side should be facing up with an uncurled edge at the front. If you experience problems with paper feed, turn the paper around. Note that the print quality is not guaranteed.

---

**Using the MPF (Multi purpose feeder)**

Use the MPF to print transparencies, labels, envelopes or postcards in addition to making quick runs of paper types or sizes that are not currently loaded in the paper tray.

Postcards, 3.5 by 5.83 in. (index) cards and other custom-sized materials can be printed with this printer. The minimum size is 3.0 by 5.0 in. (76 by 127 mm) and the maximum size is 8.5 by 14 in. (216 by 356 mm).
Acceptable print materials are plain paper with sizes ranging from 3.0 by 5.0 in. (76 by 127 mm) to Legal, 8.5 by 14 in. (216 by 356 mm), the largest size acceptable, and weighing between 16 lb and 43 lb.

**NOTE:** Always load only the print materials specified in the Specifications on "Paper Specifications" to avoid paper jams and print quality problems.

**NOTE:** Flatten any curl on postcards, envelopes and labels before loading them into the MPF.

To use the MPF:

1. Open the MPF and unfold the paper support extension, as shown.

2. *If you are using paper,* flex or fan the edge of the paper stack to separate the pages before loading.

For transparencies, hold them by the edges and avoid touching the print side. Oils from your fingers can cause print quality problems.

3. Load the print material **with the side to be printed on facing up.**
Depending on the paper type you are using, keep the following loading method:

- Envelopes: load them with the flap side down and with the stamp area on the top left side.
- Transparencies: load them with the print side up and the top with the adhesive strip entering the printer first.
- Labels: load them with the print size up and the top short edge entering the printer first.
- Preprinted paper: load with the design face up, top edge toward the printer.
- Card stock: load them with the print side up and the short edge entering the printer first.
- Pre printed paper: the printed side should be facing down with an uncurled edge toward the printer.

4. Squeeze the width guide and adjust it to the width of the print material. Do not force too much, or the paper will be bent, which will result in a paper jam or skew.

5. After loading paper, set the paper type and size for the MPF. See "Setting the Paper Type" for copying and faxing or "Paper Tab" for Computer printing.
NOTE: The settings made from the printer driver override the settings on the operator panel.

CAUTION: Ensure that to open the rear door when you print on transparencies. If not, they may tear while exiting the machine.

6. After printing, fold away the paper support extension and close the MPF.

Tips on using the MPF

- Load only one size of print material at a time in the MPF.
- To prevent paper jams, do not add paper when there is still paper in the MPF. This also applies to other types of print materials.
- Print materials should be loaded face up with the top edge going into the MPF first and be placed in the center of the tray.
- Always load only the print materials specified in "Print Media Guidelines" to avoid paper jams and print quality problems.
- Flatten any curl on postcards, envelopes, and labels before loading them into the MPF.
- When you print on 3 by 5 in. (76 by 127 mm) sized media on the MPF, open the rear door for a straight paper path to avoid paper jams.
- Ensure that to open the rear door when you print on transparencies. If not, they may tear while exiting the machine.

Setting the Paper Size

After loading paper in the paper tray, you need to set the paper size using the operator panel buttons. This setting will apply to Fax and Copy modes. For Computer printing, you need to select the paper type in the application program you use.

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).
2. Press Scroll ( or ) to highlight Paper Setup and then press Select ( ).
3. Press Scroll ( or ) to select the paper tray you want to use and then press Select ( ).
4. Press Scroll ( or ) to highlight Paper Size and then press Select ( ).
5. Press Scroll ( or ) to find the paper size you are using and then press Select ( ).
6. Press Cancel ( ) to return to the Standby mode.
Setting the Paper Type

After loading paper in the paper tray or the MPF, you need to set the paper type using the operator panel buttons. This setting will apply to Fax and Copy modes. For faxing, you can only set the paper type to the Plain Paper mode. For Computer printing, you need to select the paper type in the application program you use.

1. Press Scroll ( < or > ) to highlight Setup and then press Select ( ✓ ).
2. Press Scroll ( ▲ or ▼ ) to highlight Paper Setup and then press Select ( ✓ ).
3. Press Scroll ( ▲ or ▼ ) to select the paper tray you want to use and then press Select ( ✓ ).
4. Press Scroll ( ▲ or ▼ ) to highlight Paper Type and then press Select ( ✓ ).
5. Press Scroll ( ▲ or ▼ ) to find the paper type you are using and then press Select ( ✓ ).
6. Press Cancel ( X ) to return to the Standby mode.

Setting the Paper Tray

This feature allows you to select the tray and paper that you want to use for a printing job. Paper size and paper tray can be adjusted here.

Setting the Tray linking

If tray 1 and tray 2 are filled with letter size paper, when tray1 is empty and this option is On, then the machine continues printing using the paper in tray 2.

1. Press Scroll ( < or > ) to highlight Setup and then press Select ( ✓ ).
2. Press Scroll ( ▲ or ▼ ) to highlight Tray Behaviour and then press Select ( ✓ ).
3. Press Scroll ( ▲ or ▼ ) to highlight Tray Linking and then press Select ( ✓ ).
4. Press Scroll ( ▲ or ▼ ) to highlight On and then press Select ( ✓ ).
5. Press Cancel ( X ) to return to the Standby mode.

Substitute Tray

When the paper is mismatched, meaning that tray 1 is filled with the letter size paper, but the printing job needs A4 size paper, the machine automatically starts printing with Letter sized paper.

1. Press Scroll ( < or > ) to highlight Setup and then press Select ( ✓ ).
2. Press Scroll (▲ or ▼) to highlight Tray Behaviour and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Substitute Tray and then press Select (✓).
4. Press Scroll (▲ or ▼) to highlight Nearest Size and then press Select (✓).
5. Press Cancel ( X ) to return to the Standby mode.

Setting the Default Tray

You can select the tray you want to use for printing job.

1. Press Scroll ( < or > ) to highlight Setup and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Tray Behaviour and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Default Source and then press Select (✓).
4. Press Scroll (▲ or ▼) to find the paper tray you are using and then press Select (✓).
5. Press Cancel ( X ) to return to the Standby mode.

Setting the paper feeding flow

1. Press Scroll ( < or > ) to highlight Setup and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Tray Behaviour and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Configure MPF and then press Select (✓).
4. Press Scroll (▲ or ▼) to find the paper tray you are using and then press Select (✓).
   - Bypass Mode: When sending a print job from the computer and the MPF is filled with paper, the printer uses the paper in the MPF first. In this mode the printer pulls the paper from MPF first unless it is closed or empty. MPF gets the highest priority and pulls whatever media present in the MPF. Bypass Mode is set as a default setting.
   - Tray Mode: When sending a print job from the computer, the printer uses paper in the tray which you have already set in Printer properties. In this mode the MPF is treated as another paper tray. Instead of treating MPF as first preference paper source, printer pulls paper from the tray that matches the size and type. The first preference goes to the default source.
5. Press Cancel ( X ) to return to the Standby mode.

Setting the paper auto feeding

When the paper is mismatched, the machine waits for a while (about few seconds) and starts printing automatically even if the paper mismatches.

1. Press Scroll ( < or > ) to highlight Setup and then press Select (✓).
2. Press Scroll (↑ or ↓) to highlight Tray Behaviour and then press Select (✓).
3. Press Scroll (← or →) to highlight Auto Continue and then press Select (✓).
4. Press Scroll (↑ or ↓) to highlight On and then press Select (✓).
5. Press Cancel (X) to return to the Standby mode.

---

Tray Behavior

Tray Linking

Tray linking enables the automatic linking feature for trays when you load the same size and type of print media in multiple sources. The printer automatically links the trays; when one tray is not available for paper empty or mismatch, the printer will use the next available linked tray to feed print media for the printing.

For example, if you have the same size and type of print media loaded in tray 2, the printer selects print media from tray 2 until it becomes empty, and then the printer automatically feeds print media from the next linked tray.

By linking all trays (standard and optional), you effectively create a single source with a capacity of up to 550 sheets.

Make sure you load the same size and type of print media in each tray in order to link the trays. Set the paper size and type for each tray.

To disable tray linking you can either choose unique paper size/type for each tray or using operator panel to disable tray linking.

⚠️ NOTE: You can use this feature in print, copy, and fax job.

⚠️ NOTE: Do not open the tray 1, while the machine is printing with tray 2. Because paper jam might occur.

1. Press Scroll (◁ or ▷) to highlight Setup and then press Select (✓).
2. Press Scroll (← or →) to highlight Tray Behaviour and then press Select (✓).
3. Press Scroll (← or →) to highlight Tray Linking and then press Select (✓).
4. Press Scroll (↑ or ↓) to On for enable and Off to disable tray linking and press Select (✓).
5. Press Cancel (X) to return to the Standby mode.

Substitute Size
This setting is used to determine whether the printer can substitute with another paper size when the requested paper size is not available in any of the input trays. The Printer will substitute A4/Letter, A5/Statement, B5/ISO B5, and Folio/Oficio. For example if A4 is requested paper size and there is no A4 paper in any of the input source then the printer will print on Letter size paper, if available.

Substitute size set to Off means no substitution is allowed for the requested paper size. This option is not applied for received fax printing.

NOTE: You can use this feature in print and copy job.

MPF

MPF can be configured to behave in Tray Mode or in Bypass Mode by setting the Configure MPF menu in the operator panel.

Bypass Mode

In this mode the printer pulls the paper from MPF first unless it is closed or empty. MPF gets the highest priority and pulls whatever media present in the MPF.

NOTE: You can use this feature in print and copy job.

Tray Mode

In this mode the MPF is treated as another paper tray. Instead of treating MPF as first preference paper source, printer pulls paper from the tray that matches the size and type. The first preference goes to the default source.

NOTE: You can use this feature in print, copy, and fax job.

Setting the Paper Margin

You can set the paper margin for simplex or duplex printing.

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Paper Setup and then press Select (✓).
3. Press Scroll(▲ or ▼) to highlight Margin and then press Select (✓).
4. Press Scroll(▲ or ▼) to select Common Margin, specific paper tray you want to use, or PCL Margin Shift and then press Select (✓).
5. Select a target such as Top Margin, Left Margin, Short Binding, Long Binding, and etc. to set the paper margin.

6. Enter the value you want using the number keypad.

7. Press Cancel (X) to return to the Standby mode.
Printing

- Printing a Document
- Printer Settings
- Printing Posters
- Printing Booklets
- Printing Multiple Pages on One Sheet of the Paper
- Printing on Both Sides of Paper
- Printing a Reduced or Enlarged Document
- Using Watermarks
- Using Overlays
- Fitting Your Document to a Selected Paper Size
- Printing on Both Sides of Paper

Printing a Document

Your printer prints documents using the Printer Control Language (PCL) or PostScript (PS) printer driver. When you install the Dell software, your printer automatically installs the PCL printer driver. Installing the PS printer driver is optional. See "Installing Dell Software for Local Printing".

The drivers provided with your printer allow a wide variety of options. Use the chart below to determine which print driver is best suited for the job.

The features provided by each printer driver are as follows:

<table>
<thead>
<tr>
<th>Feature</th>
<th>PCL</th>
<th>PS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print quality option</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Poster</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Multiple Pages per Side</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Fit to Page</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Watermark</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Overlay</td>
<td>Y</td>
<td>N</td>
</tr>
</tbody>
</table>

The following procedure describes the general steps required for printing from various Windows applications. The exact steps for printing a document may vary depending on the application program you are using. Refer to your software application's User's Guide for the exact printing procedure.

1. Open the document you want to print.
2. Select Print from the File menu.

The Print window displays. It may look slightly different depending on your application.

The basic print settings are selected within the Print window. These settings include the number of copies and print range.
3. Select the printer driver that you want to use from the Print window.

4. To take advantage of the printer features provided by your printer, click Preferences or Properties, depending on the program or operating system in the above window and go to step 5.

   If you see Setup, Printer or Options, click that button instead. Then click Properties on the next screen.

5. Click OK to close the printer properties window.

6. To start the print job, click Print or OK, depending on the program or operating system in the Print window.

**Canceling a Print Job**

There are two ways to cancel a print job:

**To stop a print job from the operator panel:**

Press Cancel ( ).
Your printer finishes printing the page in progress and deletes the rest of the print job. Pressing the button cancels only the current job. If more than one print job is in the printer’s memory, you need to press the button once for each job.

To stop a print job from the Printers folder:

- **NOTE:** You can access this window simply by double-clicking the printer icon at the bottom right corner of the Windows desktop.

1. From the Windows Start button.
2. For Windows 2000, click **Settings** and point to **Printers**.
   - For Windows XP/Server 2003, click **Printers and Faxes**.
   - For Windows Vista/Server 2008, click **Control Panel → Hardware and Sound → Printers**.
   - For Windows 7, click **Control Panel → Hardware and Sound → Devices and Printers**.
   - For Windows Server 2008 R2, click **Control Panel → Hardware → Devices and Printers**.
   - For Windows 7, right click your printer icon → **See what’s printing**.
4. From the **Document** menu, click **Cancel**.
Printer Settings

You can use the printer properties window, which allows you to access all of the printer options you may need when using your printer. When the printer properties are displayed, you can review and change any settings needed for your print job.

The printer properties window may differ, depending on the printer driver you select and your operating system. For details about selecting a printer driver, see "Printing a Document". The User's Guide shows the Printing Preferences window of the PCL printer driver on Windows XP.

**NOTE:** Most Windows applications override settings you specified in the printer driver. Change all of the print settings available in the software application first, and change any remaining settings using the printer driver.

**NOTE:** The settings you change remain in effect only while you are using the current program. To make your changes permanent, make them in the **Printers** folder. Follow these steps:

a. Click the Windows **Start** button.

b. For Windows 2000, click **Settings** and point to **Printers**.
   - For Windows XP/Server 2003, click **Printers and Faxes**.
   - For Windows Vista/Server 2008, click **Control Panel → Hardware and Sound → Printers**.
   - For Windows 7, click **Control Panel → Hardware and Sound → Devices and Printers**.
   - For Windows Server 2008 R2, click **Control Panel → Hardware → Devices and Printers**.

c. Point to the **Dell 2335dn MFP** printer.

d. Right-click on the printer icon and click **Print Setup** or click **Properties**.

e. Change the settings on each tab and click **OK**.

Layout Tab

The **Layout** tab provides options for you to adjust how the document appears on the printed page. The **Layout Options** section includes advanced printing options, such as **Multiple Pages per Side** and **Poster Printing**.
Paper Tab

Use the following options to set the paper handling needs when you access the printer properties. Click the Paper tab to access the paper properties.

**NOTE:** When you select an option in properties, you may see an exclamation (¡) mark or (,) mark. An exclamation mark means you can select that certain option but it is not recommended, and (,) mark means you cannot select that option due to the printer's setting or environment.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Orientation</strong></td>
<td><strong>Paper Orientation</strong> allows you to select the direction in which information is printed on a page.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Portrait</strong> prints across the width of the page, letter style.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Landscape</strong> prints across the length of the page, spreadsheet style.</td>
</tr>
<tr>
<td></td>
<td><em>If you want to rotate the page 180-degrees, select 180 from the Rotate drop-down list.</em></td>
</tr>
<tr>
<td><strong>Layout Options</strong></td>
<td><strong>Layout Options</strong> allows you to select advanced printing options. For details, see &quot;Printing Multiple Pages on One Sheet of the Paper&quot;, &quot;Printing Posters&quot; and &quot;Printing Booklets&quot;.</td>
</tr>
<tr>
<td><strong>Double-sided Printing</strong></td>
<td><strong>Double-sided Printing</strong> allows you to print on both sides of paper. For details, see &quot;Printing on Both Sides of Paper&quot;.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Copies</strong></td>
<td><strong>Copies</strong> allows you to choose the number of copies to be printed. You can enter up to 999.</td>
</tr>
<tr>
<td><strong>Paper size</strong></td>
<td>The <strong>Paper size</strong> option allows you to choose the size of paper loaded in the paper tray. If the required size is not listed in the <strong>Paper size</strong> box, click <strong>Custom</strong>. When the Custom Paper Setting window appears, set the paper size and click <strong>OK</strong>. The setting appears on the list so that you can select it.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Ensure that <strong>Source</strong> is set to the corresponding paper tray. If the paper source is set to <strong>Auto Selection</strong>, the printer automatically picks up print materials from the MPF first and then the paper tray.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Ensure that <strong>Type</strong> is set to <strong>Printer Default</strong>. If you load a different type of print material, select the corresponding paper type. For more information about print materials, refer to &quot;Print Media Guidelines&quot;.</td>
</tr>
</tbody>
</table>
First Page

This property allows you to print the first page using a different paper type from the rest of the document. You can select the paper source for the first page.

Output size allows you to select advanced printing options.

For details, see "Printing a Reduced or Enlarged Document" and "Fitting Your Document to a Selected Paper Size".

Graphic Tab

Use the following graphic options to adjust the print quality for your specific printing needs. Click the Graphic tab to display the properties shown below.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>You can select the printing resolution by choosing 1200 dpi (Best), 600 dpi (Normal) or Draft Mode. The higher the setting, the sharper the clarity of printed characters and graphics. Higher settings may increase the time it takes to print a document.</td>
</tr>
<tr>
<td>TrueType Options</td>
<td>This option determines what the driver tells the printer about how to image the text in your document. Select the appropriate setting according to the status of your document.</td>
</tr>
<tr>
<td></td>
<td>• Download as Outline: When this option is selected, the driver will download any TrueType fonts, that are used in your documents, which is not stored (resident) on your printer. If, after printing a document, you find that the fonts did not print correctly, choose Download as bit image and resubmit your print job. The Download as bit image setting is often useful when printing Adobe.</td>
</tr>
<tr>
<td></td>
<td>• Download as Bitmap: When this option is selected, the driver downloads the font data as bitmap images. Documents with</td>
</tr>
</tbody>
</table>
complicated fonts, such as Korean or Chinese, print faster in this setting.

- **Print as Graphics**: When this option is selected, the driver downloads any fonts as graphics. When printing documents with high graphic content and relatively few TrueType fonts, printing performance (speed) may be enhanced in this setting.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Watermark</strong></td>
<td>You can create a background image of text to print on each page of your document. See &quot;Using Watermarks&quot;. This feature is not available when using the PostScript (PS) driver.</td>
</tr>
<tr>
<td><strong>Overlay</strong></td>
<td>Overlays are often used to take the place of preprinted forms and letterhead paper. See &quot;Using Overlays&quot;.</td>
</tr>
<tr>
<td><strong>Output Options</strong></td>
<td><strong>Print Subset</strong>&lt;br&gt;You can set the sequence for the pages to print. Select the print order from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Normal (1, 2, 3)</strong>: Your printer prints all pages from the first page to the last page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Reverse All Pages (3, 2, 1)</strong>: Your printer prints all pages from the last page to the first page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Print Odd Pages</strong>: Your printer prints only the odd pages of the document.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Print Even Pages</strong>: Your printer prints only the even pages of the document.</td>
</tr>
</tbody>
</table>
Use Printer Fonts

When Use Printer Fonts is checked, the printer uses the fonts that are stored in its memory (resident fonts) to print your document, rather than downloading the fonts that have been used in your document. Because downloading fonts takes time, selecting this option can speed up your printing time. When using Printer fonts, the printer will try to match the fonts used in your document to those stored in its memory. If, however, you use fonts in your document that are very different from those resident in the printer, your printed output will appear very different from what it looks like on the screen.

Job Type

You can set the usage of the HDD, such as whether you store the data file in the HDD inside the machine or print directly.

Job Type

- **Normal**: Your printer does not store the print data.
- **Confidential**: You can set the password not to delete the print data file by mistake.
- **Proof**: When printing several copies of print, the printer prints out the first copy of print and continue to print the rest of them.

User ID

You can enter the user name with combination of alphabet and number. This information will be displayed on the touch screen when you find the file.

Job Name

You can enter the job name with combination of alphabet and number. This information will be displayed on the touch screen when you find the file.

About Tab

Use the About tab to display the copyright notice and the version number of the driver. If you have an Internet browser, you can connect to the Internet by clicking the Dell Website icon.

Using a Favorite Setting

The Favorites option, which is visible on each properties tab, allows you to save the current properties settings for future use.

To save a Favorites item:

1. Change the settings on each tab, as needed.
2. Enter a name for the item in the Favorites input box.
3. Click **Save**.

To use a saved setting, select it from the **Favorites** drop-down list.

To delete a favorite setting item, select it from the list and click **Delete**.

You can also restore the printer driver's default settings by selecting **Printer Default** from the list.

**Using Help**

Your printer has a help screen that can be activated by the **Help** button in the printer's properties window. These help screens give detailed information about the printer features provided by the printer driver.

You can also click ![Help icon](image) from the upper right hand corner, and then click on any setting.

**Printing Multiple Pages on One Sheet of the Paper**
You can select the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will appear decreased in size and arranged on the sheet. You can print up to 16 pages on one sheet.

1. When you change the print settings from your software application, access the printer properties.

2. From the Layout tab, choose Multiple Pages per Side on the Layout Options drop-down list.

3. Select the number of pages you want to print per sheet (1, 2, 4, 6, 9, or 16) on the Pages per Side drop-down list.

4. If necessary, select the page order on the Pages Order drop-down list.

5. Click Print Page Border to print a border around each page on the sheet. Print Page Border is enabled only if the Pages per Side setting is set to a number greater than one.

6. Click OK and print the document.
Printing a Reduced or Enlarged Document

You can scale your print job on a page.

1. When you change the print settings from your software application, access the printer properties.
2. From the Paper tab, select Reduce/Enlarge on the Output size drop-down list.
3. Enter the scaling rate in the Percentage input box.

   You can also click the ▼ or ▲ button.

4. Select the paper source, size and type.
5. Click OK and print the document.

Fitting Your Document to a Selected Paper Size
You can scale your print job to any selected paper size regardless of the original document size. This can be useful when you want to check fine details on a small document.

1. When you change the print settings from your software application, access the printer properties.

2. From the Paper tab, select **Fit to Page** on the **Output size** drop-down list.

3. Select the correct size from the **Fit to Page** drop-down list.

4. Select the paper source, size and type.

5. Click **OK** and print the document.

---

**Printing Posters**
You can print a single-page document onto 4, 9, or 16 sheets of paper, for the purpose of pasting the sheets together to form one poster-size document.

1. When you change the print settings from your software application, access the printer properties.
2. From the Layout tab, select Poster Printing on the Layout Options drop-down list.

3. Configure the poster option:

   You can select the page layout from Poster<2x2>, Poster<3x3>, Poster<4x4> or Custom. If you select Poster<2x2>, the output will be automatically stretched to cover 4 physical pages. If the option is set to Custom, you can enlarge the original from 150% to 400%. Depending on the level of the enlargement, the page layout is automatically adjusted to Poster<2x2>, Poster<3x3>, Poster<4x4>.

Specify an overlap in millimeters or inches to make it easier to reconstruct the resulting poster.
4. Click the **Paper** tab and select the paper source, size and type.

5. Click **OK** and print the document. You can complete the poster by reconstructing the results.

---

**Printing Booklets**

This printer feature allows you to print your document on both sides of the paper and arranges the pages so that the paper can be folded in half after printing to produce a booklet.

1. When you change the print settings from your software application, access the printer properties.

2. From the **Layout** tab, select **Booklet Printing** on the **Layout Options** drop-down list.

---

**NOTE:** The **Booklet Printing** option is not available for all paper sizes. In order to find out the available paper size for this feature, select the paper size in the **Paper size** option on the **Paper** tab, then check if the **Booklet Printing** in a **Layout Options** drop-down list on the **Layout** tab is activated.
3. Select the paper source, size and type.
4. Click **OK** and print the document.

---

**Printing on Both Sides of Paper**

Your printer prints on both sides of the paper automatically.

Before printing, decide on which edge you will be binding your finished document. The binding options are:

- **Long Edge**, which is the conventional layout used in book binding.
- **Short Edge**, which is the type often used with calendars.

![Long Edge](image1.png)
![Short Edge](image2.png)

**NOTE:** Do not print on both sides of labels, transparencies, envelopes, or thick paper. Damage to the printer and paper jamming might result.

**NOTE:** To use the double-sided printing, you can use only the following paper size: A4, Letter, Legal and Folio.

1. When you change the print settings from your software application, access the printer properties.
2. From the **Layout** tab, select the paper orientation.
3. From the **Double-sided Printing** section, select the desired binding option.
3. Click the **Paper** tab and select the paper source, size and type.

4. Click **OK** and print the document.

Your printer prints on both sides of the paper automatically.

---

**Using Watermarks**

The Watermark option allows you to print text over an existing document. For example, you may want to have large gray letters reading "DRAFT" or "CONFIDENTIAL" printed diagonally across the first page or all pages of a document.

There are several predefined watermarks that come with your printer. They can be modified or you can add new ones to the list.

**Using an Existing Watermark**

1. When you change the print settings from your software application, access the printer properties.

2. Click the **Other Options** tab and select a watermark on the **Watermark** drop-down list. It appears in the preview image window.
3. Click **OK** and start printing.

**Creating a Watermark**

1. When you change the print settings from your software application, access the printer properties.

2. Click the **Other Options** tab and click **Edit** in the **Watermark** section. The Edit Watermarks window appears.

3. Enter the text message you want to print in the **Watermark Message** box.

The message displays in the preview image window. The preview image is provided so that you can see how the watermark will appear on the printed page.

When the **First Page Only** box is checked, the watermark is printed on the first page only.
4. Select the watermark options.

   You can select the font name, style and size and gray scale level from the **Font Attributes** section and set the angle of the watermark from the **Message Angle** section.

5. Click **Add** to add a new watermark to the list.

6. When you finish creating, click **OK** and start printing.

To stop printing the watermark, select **No Watermark** on the **Watermark** drop-down list.

### Editing a Watermark

1. When you change the print settings from your software application, access the printer properties.

2. Click the **Other Options** tab and click **Edit** in the **Watermark** section. The **Edit Watermarks** window appears.

3. Select the watermark you want to edit on the **Current Watermarks** list, and change the watermark message and the options.

4. Click **Update** to save the changes.

5. Click **OK**.

### Deleting a Watermark

1. When you change the print settings from your software application, access the printer properties.

2. Click the **Other Options** tab and click **Edit** in the **Watermark** section. The **Edit Watermarks** window appears.

3. Select the watermark you want to delete on the **Current Watermarks** list and click **Delete**.

4. Click **OK**.

### Using Overlays
What is an Overlay?

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. Overlays are often used to take the place of preprinted forms and letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing the exact same information that is currently on your letterhead. To print a letter with your company's letterhead, you do not need to load preprinted letterhead paper in the printer. You need only tell the printer to print the letterhead overlay on your document.

Creating a New Page Overlay

To use a page overlay, you must create a new page overlay containing your logo or image.

**NOTE:** The overlay document size must be the same as documents you will print with the overlay. Do not create an overlay with a watermark.

1. Create or open a document containing text or an image for use in a new page overlay. Position the items exactly as you wish them to appear when printed as an overlay. *If needed,* save the file for later use.

2. When you change the print settings from your software application, access the printer properties.

3. Click the **Other Options** tab and click **Edit** in the **Overlay** section.

4. In the Edit Overlays window, click **Create Overlay**.
5. In the Create Overlay window, type a name of up to eight characters in the **File name** box. Select the destination path, if necessary. (The default is `C:\FormOver`).

6. Click **Save**. You can see the name in the **Overlay List**.

7. Click **OK** or **Yes** until you complete creating.

The file is not printed out; it is stored in your computer.

**Using a Page Overlay**

After an overlay has been created, it is ready to be printed with your document. To print an overlay with a document:

> **NOTE:** The resolution of the overlay must be the same as the resolution of the document that will print with the overlay.

1. Create or open the document you want to print.

2. When you change the print settings from your software application, access the printer properties.

3. Click the **Other Options** tab.
4. Select the overlay you want to print from the **Overlay** drop-down list box.

5. If the overlay file does not appear on the **Overlay List**, click **Edit** and then **Load Overlay**, and select the overlay file.

6. If you have stored the overlay file you want to use on an external source, such as a CD or floppy disk, you can also load the file when you access this **Load Overlay** window.

   After you select the file, click **Open**. The file is now shown in the **Overlay List** box and is available for printing. Select the overlay from the **Overlay List** box.

6. If necessary, click **Confirm Page Overlay When Printing**. When this box is checked, a message window appears each time you submit a document for printing, asking you to confirm that you want to print an overlay on your document.

   Answering **Yes** to the window means that the selected overlay will be printed with your document. Answering **No** to the window cancels the use of the overlay page.

   If this box is empty and an overlay has been selected, the overlay will be automatically printed with your document.

7. Click **OK** or **Yes** until the printing starts.

   The overlay is downloaded with your print job and printed on your document.
Deleting a Page Overlay

You can delete page overlays that are no longer used.

1. In the printer properties window, click the Other Options tab.
2. Click Edit in the Overlay section.
3. Select the overlay you want to delete from the Overlay List box.
4. Click Delete Overlay.
5. When a confirming message window appears, click Yes.
6. Click OK until you exit the Print window.
Loading Paper for Copying

The instructions for loading print materials are the same whether you are printing, faxing, or copying. For further details, see "Loading Paper" for loading paper in the paper tray and "Using the MPF (Multi purpose feeder)" for loading paper in the multi purpose tray.

Selecting the Paper Tray

After loading the print media for copy output, you have to select the paper tray that you will use for the copy job.

1. Press Scroll (← or →) to highlight Copy and then press Select (✓).
2. Press Scroll (△ or ▽) to highlight Select Tray and then press Select (✓).
3. Press Scroll (△ or ▽) to display the paper tray you want.

You can select from Tray1, Tray2 (option) and MPF (multi purpose tray). If you do not install the optional tray 2, the Tray2 (option) menu item will not appear on the display.

4. Press Select (✓) to save the selection.
5. Press Cancel (X) to return to the Standby mode.

Preparing a Document

You can use the document glass or the DADF (Duplex Automatic Document Feeder) to load an original document for copying, scanning and sending a fax. Using the DADF, you can load up to 50 sheets of 75 g/m² (20 lb) documents for one job. Using the document glass, you can load one sheet at a time.
NOTE: To get the best scan quality, especially for color or gray scale images, use the document glass instead of the DADF.

When you use the DADF:

- Do not load documents smaller than 5.59 by 5.83 in. (142 by 148 mm) or larger than 8.5 by 14 in. (216 by 356 mm).
- Do not attempt to feed the following types of documents:
  - Carbon-paper or carbon-backed paper
  - Coated paper
  - Onion skin or thin paper
  - Wrinkled or creased paper
  - Curled or rolled paper
  - Torn paper
  - Corner damage caused by excessive stapling/removal.
- Remove all staples and paper clips before loading documents.
- Ensure that any glue, ink or correction fluid on the paper is completely dry before loading documents.
- Do not load documents containing different sizes or weights of paper.
- Do not load booklets, pamphlets, transparencies or documents having other unusual characteristics.

Loading an Original Document

You can use the DADF (Duplex Automatic Document Feeder) or the document glass to load an original document. Using the DADF, you can load up to 50 sheets of 75 g/m² (20 lb) paper at a time. Using the document glass, you can load one sheet at a time.

NOTE: Ensure that no document is in the DADF. If any document is detected in the DADF, it has priority over the document on the document glass.

NOTE: To get the best scan quality, especially for color or gray scale images, use the document glass instead of the DADF.

NOTE: If you use duplex copy features, see "Printing Copies on Both Sides of Paper".

To load the document in the DADF:

1. Place the document(s) face up on the DADF with the top edge of the documents in first
1. Adjust the document width guides to the correct document size. Ensure that the bottom of the document stack matches the paper size marked on the document input tray.

For detailed guidelines for preparing an original document, see "Preparing a Document".

To load the document in the document glass:

1. Open the document cover.
2. Place the document *face down* on the document glass and align it with the registration guide on the top left corner of the glass.

For detailed guidelines for preparing an original document, see "Preparing a Document".

3. Close the document cover.

**NOTE:** If you are copying a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close the cover. *If the book or magazine is thicker than 30 mm*, start copying with the cover open.

**NOTE:** Leaving the cover open while copying may affect the copy quality and toner consumption.
Making Copies

NOTE: A computer connection is not required for copying.

NOTE: Contaminates on the document glass may cause black spots on the printout. For best results, clean the document glass before use. See "Cleaning the scanner".

1. Load the document(s) face up with the top edge in first into the DADF.

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Loading an Original Document".

2. Customize the copy settings including the number of copies, copy size, the contrast, and the image quality by using the operator panel buttons. See "Setting Copy Options".

   To clear the settings, use the Cancel (X) button.

3. If necessary, you can use special copy features, such as Auto Fit, Clone, Poster, and ID copying referring to "Using Special Copy Features".

4. Press Start ( ) to begin copying. The display shows the copy processing.

   NOTE: You can cancel the copy job at any time. Press Cancel (X), and the copying will stop.

Setting Copy Options

The Copy menus on the operator panel let you customize all the basic copy options; number of copies, copy size, contrast and image quality. Set the following options for the current copy job before pressing Start ( ) to make copies.

NOTE: If you press Cancel (X) while you set the copy options, all of the options you have set for the current copy job will be canceled and return to their default status. Or, they automatically return to their default status after copying.
Number of Copies

You can select the number of copies from 1 to 199.

1. Press Scroll (← or →) to highlight Copy and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight # of copies and then press Select (✓).
3. Enter the value you want using the number keypad.
4. Press Start (✓).

Enlarge/Reduce Copy

You can reduce or enlarge the size of a copied image, from 25 percent to 400 percent when you copy original documents from the document glass or the DADF. Note that the zoom rate available is different depending on the document loading method.

NOTE: When you make a reduced copy, black lines may appear at the bottom of your copy.

To select from the predefined copy sizes:

1. Press Scroll (← or →) to highlight Copy and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Zoom and then press Select (✓).
3. Press Scroll (▲ or ▼) to find the size setting you want and then press Select (✓).

You can select from 100%, 78%, 83%, 94% and 104%.

To fine-tune the size of copies:

1. Press Scroll (← or →) to highlight Copy and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Zoom and then press Select (✓).
3. Press Scroll (▲ or ▼) to display Other(25-400) and then press Select (✓).
4. If you select Other(25-400) and then enter the value you want using the number keypad and then press Select (✓).

Contrast

Adjust the contrast to make the copy lighter or darker than the original.

1. Press Scroll (← or →) to highlight Copy and then press Select (✓).
2. Press Scroll (↑ or ↓) to highlight Contrast and then press Select (✓).
3. Press Scroll (< or >) to adjust the contrast and then press Select (✓).

### Original Size

You can set the size of a copied image, when you copy original documents from the documents glass or the DADF.

1. Press Scroll (< or >) to highlight Copy and then press Select (✓).
2. Press Scroll (↑ or ↓) to highlight Original Size and then press Select (✓).
3. Press Scroll (↑ or ↓) to select the original size and then press Select (✓).

### Original Type

The original type setting is used to improve the image quality by selecting the document type for the current copy job.

1. Press Scroll (< or >) to highlight Copy and then press Select (✓).
2. Press Scroll (↑ or ↓) to highlight Original Type and then press Select (✓).
3. Press Scroll (↑ or ↓) to select the image quality mode and then press Select (✓).
   - **Text**: Use for documents with fine details, such as fine text.
   - **Text&Photo**: Use for documents with both text and photo/gray tones.
   - **Photo**: Use for documents with photo or gray tones.

### Using Special Copy Features

- **NOTE**: Some features may not be available depending on where you loaded the document, on the document glass or in the DADF.
- **NOTE**: The menu items of Collation, 2 up, and 4 up may be available only when you loaded the document in the DADF.

You can use the following copy features using the Layout menu:

- **Off**: Prints in normal mode.
- **ID Copy**: Prints a 2-sided original document onto one sheet of paper. See "ID Copying".
- **Auto Fit**: Automatically reduces or enlarges the original image to fit on the paper currently loaded in
the printer. See "Auto Fit Copying".

- **Poster**: Prints an image onto 9 sheets of paper (3 by 3). You can paste the printed pages together to make one poster-size document. See "Poster Copying".

- **Clone**: Prints multiple image copies from the original document on a single page. The number of images is automatically determined by the original image and paper size. See "Clone Copying".

- **Collation**: Prints output in sets to match the sequence of originals. See "Deciding the form of copy output".

- **2 up, 4 up**: Prints 2 or 4 original images to fit onto one sheet of paper. See "2-up or 4-up copying (N-up)".

### ID Copying

When you copy using this feature, the printer prints one side on the upper half of the paper and the other side on the lower half without reducing the original. This feature is helpful for copying a small-sized document, such as a name card.

*If the original document is larger than the printable area, some portions may not be printed.*

This special copy mode can be applied when you load a document using only the document glass. *If a document is detected in the DADF, the ID copying feature does not work.*

ɨ **NOTE**: You cannot adjust the copy size using the **Zoom** menu for ID copying.

To make the ID copying:

1. Load the document to be copied on the document glass, and close the cover.

2. Press **Scroll** (← or →) to highlight **Copy** and then press **Select** (✓).

3. Press **Scroll** (✓ or ✗) to highlight **Layout** and then press **Select** (✓).

4. Press **Scroll** (✓ or ✗) to highlight **ID Copy** and then press **Select** (✓).

5. *If necessary, customize the copy settings including the number of copies, contrast, and image quality by using the Copy menus. See "Setting Copy Options".*

6. Press **Start** (✓) to begin copying.

Your printer begins scanning the front side.

7. When **Place Rear Side** displays on the bottom line, open the document cover and flip the document over with the second side facing down. Close the document cover.
NOTE: If you press the Cancel (X) button or if no buttons are pressed for about 30 seconds, the printer cancels the copy job and returns to Standby mode.

8. Press Start ( > ) again.

Auto Fit Copying

This special copy mode can be applied when you load a document using only the document glass. If a document is detected in the DADF, the Auto Fit does not work.

NOTE: You cannot adjust the copy size using the Zoom menu while the Auto Fit copying is enabled.

To make the Auto Fit copying:

1. Load the document to be copied on the document glass, and close the document cover.
2. Press Scroll (< or >) to highlight Copy and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Layout and then press Select (✓).
4. Press Scroll (▲ or ▼) to highlight Auto Fit and then press Select (✓).
5. If necessary, customize the copy settings including the number of copies, contrast, and image quality by using the Copy menus. See "Setting Copy Options".
6. Press Start ( > ) to begin copying.

Poster Copying
This special copy mode can be applied when you load a document using only the document glass. *If a document is detected in the DADF, the Poster copying feature does not work.*

**NOTE:** You cannot adjust the copy size using the **Zoom** menu button for making a poster.

To make the Poster copying:

1. Load the documents to be copied on the document glass and close the cover.
2. Press **Scroll** (<< or >>) to highlight **Copy** and then press **Select** (✓).
3. Press **Scroll** (▲ or ▼) to highlight **Layout** and then press **Select** (✓).
4. Press **Scroll** (▲ or ▼) to highlight **Poster** and then press **Select** (✓).
5. *If necessary,* customize the copy settings including the number of copies, contrast, and image quality by using the Copy menus. See "Setting Copy Options".
6. Press **Start** (▶) to begin copying.

Your original document is divided into 9 portions. Each portion is scanned and printed one by one in the following order:

![Clone Copying Image]

**Clone Copying**
This special copy mode can be applied when you load a document using only the document glass. *If a document is detected on the DADF, the Clone copying feature does not work.*

**NOTE:** You cannot adjust the copy size using the Zoom menu while making a clone copy.

To make the Clone copying:

1. Load the document to be copied on the document glass, and close the cover.
2. Press **Scroll** (← or →) to highlight **Copy** and then press **Select** (✓).
3. Press **Scroll** (▲ or ▼) to highlight **Layout** and then press **Select** (✓).
4. Press **Scroll** (▲ or ▼) to highlight **Clone** and then press **Select** (✓).
5. *If necessary, customize the copy settings including number of copies, contrast, and image quality by using the Copy menus. See "Setting Copy Options".*
6. Press **Start** (▶) to begin copying.

**Deciding the form of copy output**

This special copy mode can be applied when you load a document using only the DADF.

1. Load the document to be copied in the DADF.
2. Press **Scroll** (← or →) to highlight **Copy** and then press **Select** (✓).
3. Press **Scroll** (▲ or ▼) to highlight **Layout** and then press **Select** (✓).
4. Press **Scroll** (▲ or ▼) to highlight **Collation** and then press **Select** (✓).
5. *If necessary, customize the copy settings including number of copies, contrast, and image quality by using the Copy menus. See "Setting Copy Options".*
6. Press **Start** (▶) to begin copying.

**2-up or 4-up copying (N-up)**
The machine reduces the size of the original images and prints 2 or 4 pages onto one sheet of paper. This special copy mode can be applied when you load a document using only the DADF.

**NOTE:** You cannot adjust the copy size using the *Zoom* menu for making a 2 Up or 4 Up copy.

1. Load the document to be copied in the DADF.
2. Press *Scroll* (← or →) to highlight *Copy* and then press *Select* (✓).
3. Press *Scroll* (∨ or ∨) to highlight *Layout* and then press *Select* (✓).
4. Press *Scroll* (∨ or ∨) to highlight *2 up* or *4 up*.
   - 2 up: Copies two separate originals onto one page.
   - 4 up: Copies four separate originals onto one page.
5. Press *Scroll* (∨ or ∨) to highlight *Portrait* or *Landscape* according to the original paper's orientation.
6. Press *Select* (✓).
7. *If necessary,* customize the copy settings including number of copies, contrast, and image quality by using the Copy menus. See "Setting Copy Options".
8. Press *Start* (بدء) to begin copying.

---

**Printing Copies on Both Sides of Paper**

You can set the printer to print copies on both sides of paper.

1. Load the documents to be copied in the DADF.
2. Press *Scroll* (← or →) to highlight *Copy* and then press *Select* (✓).
3. Press *Scroll* (∨ or ∨) to highlight *Duplex* and then press *Select* (✓).
4. Press *Scroll* (∨ or ∨) to select the binding option you want and then press *Select* (✓).
   - 1->1 sided: Prints in normal mode.
   - 1->2sided long edge: Prints pages to be read like a book.
   - 1->2sided short edge: Prints pages to be read by flipping through it like a note pad.
o **2->1sided long edge**: Scans both sides of the originals and prints each of them on a separate sheet.

o **2->1sided short edge**: Scans both sides of the originals and prints each one on a separate sheet, but the information on the back side of the printout is rotated 180°.

o **2->2sided long edge**: Scans both sides of the original and prints on both sides of the paper. This function produces exactly the same printout from the originals.

5. If necessary, customize the copy settings including the number of copies, copy size, contrast, and image quality by using the Copy menus. See "Setting Copy Options".

6. Press **Start** ( ) to begin copying.

---

**Changing the Default Settings**

The copy options, including contrast, image quality, copy size, and the number of copies, can be set to the most frequently used modes. When you copy a document, the default settings are used unless they are changed by using the Copy menus.

**NOTE:** While you set copy options, pressing **Cancel** ( ) cancels the changed settings and returns to the default status.

To create your own default settings:

1. Press **Scroll** ( or ) to highlight **Copy** and then press **Select** ( ).
2. Press **Scroll** ( or ) to highlight **Copy Defaults** and then press **Select** ( ).
3. Press **Scroll** ( or ) to scroll through the setup options.
4. When the option you want to set appears, press **Select** ( ) to access the option.
5. Change the setting using the **Scroll** ( or ) or enter the value using the number keypad.
6. Press **Select** ( ) to save the selection.
7. Repeat steps 3 through 6, as needed.
8. Press **Cancel** ( ) to return to the Standby mode.
Scanning

Scanning Overview

Scanning with your machine lets you turn pictures and text into digital files that can be stored on your computer. Then you can fax or email the files, upload them to your website, or use them to create projects that you can print.

The scanning methods are scan to email, scan to computer (local and network), and scan to USB.

Dell ScanCenter

Use your Dell 2335dn MFP to convert pictures and text into editable images on your computer. After you install the software from the DRIVERS AND UTILITIES CD, you can start scanning images using Dell ScanCenter on your computer, or through the network using Dell Dell Scan Manager, which enables you to scan a document on your printer as a JPEG, TIFF or PDF and save it to a network-connected computer. Or, you can send the scanned image as an e-mail attachment directly from the printer.

NOTE: PaperPort is the scanning program provided with your printer.

The resolution setting to use when you scan an item using PaperPort depends on the item type and how you plan to use the image or document after you scan it to your computer. For best results, use these recommended settings.
<table>
<thead>
<tr>
<th>Item Type</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>300 dpi black-and-white or 200 dpi grayscale or color</td>
</tr>
<tr>
<td>Documents of poor quality or that contain small text</td>
<td>400 dpi black-and-white or 300 dpi grayscale</td>
</tr>
<tr>
<td>Photographs and pictures</td>
<td>100-200 dpi color or 200 dpi grayscale</td>
</tr>
<tr>
<td>Images for an inkjet printer</td>
<td>150 dpi to 300 dpi</td>
</tr>
<tr>
<td>Images for a high-resolution printer</td>
<td>300 dpi to 600 dpi</td>
</tr>
</tbody>
</table>

Scanning above these recommended resolutions may exceed the capabilities of the application. *If you require a resolution above those recommended in the above table, you should reduce the size of the image by previewing (or pre-scan) and cropping before scanning the image.*

**NOTE:** You can use PaperPort’s built-in OCR software to copy text from scanned documents so that you can use and edit the text in any text editing, word processing, or spreadsheet program. The OCR process requires textual images scanned at 150 to 600 dpi and 300 dpi or 600 dpi is recommended for graphics.

**NOTE:** The first time you use PaperPort you must open PaperPort on your computer before you start scanning in order for the scanned document to be stored in your computer.

**NOTE:** If you prefer to use another application, such as Adobe® PhotoShop®, you must assign the application to the printer by selecting it from the list of available applications. Please refer to “Scanning Using Dell Scan Manager”.

Dell ScanCenter is a PaperPort application that enables you to scan items and send them directly to PaperPort or other programs on your computer without first running PaperPort. Dell ScanCenter runs as a separate application from the Windows Start Menu and displays the Dell ScanCenter bar. For more information about using Dell ScanCenter, refer to PaperPort’s Help menu.

Icons on the Dell ScanCenter bar represent the programs that are limited to PaperPort and to Dell ScanCenter. To scan and send an item to a program, click the program icon and then scan the item. Dell ScanCenter automatically starts the selected program when the scan is complete.
Scanning Using Dell Scan Manager

About Dell Scan Manager

You just walk to the machine with the originals and scan them from the control panel, then the scanned data will be stored in the connected computers My Document folder. When the setup installation is completed, then you have installed the Dell Scan Manager on your computer already. This feature can be used via the local connection or the network connection.

Setting scan information in Dell Scan Manager

You can find out about Dell Scan Manager program information and installed scan driver’s condition. Also, you can change scan settings and add or delete the folders in which documents scanned to computer are saved in Dell Scan Manager program.

NOTE: Dell Scan Manager program can only be used in the Window system.

1. From the Start menu, select Programs ➔ Dell Printers ➔ Dell 2335dn MFP ➔ Dell Scan Manager.
2. Press Properties.

You can change the scanning machine by using Add Device. (Local or Network)
3. In the **Set Scan Button** window, select the scan setting option.
3. **Scan Destination**: You can change the add or delete application programs and file format.

4. **Scan Property**: You can change the saving destination, resolution, color and scan size.

   - Press **OK** after the setting is done.

---

**Setting Quick Scan Default**

The default scan destination can be set to the most frequently used one. When you scan a document, the default destination is shown for quick and simple scanning.

1. Press **Scroll** (← or →) to highlight **Scan** and then press **Select** (✓).

2. Press **Scroll** (△ or ▽) to highlight **Scan Defaults** and then press **Select** (✓).
3. Press Scroll ( or ) to highlight Quick Scan Defaults and then press Select ( ).
4. Change the default destination using the Scroll ( or ) buttons.
5. Press Select ( ) to save the selection.
6. Press Cancel ( ) to return to the Standby mode.

---

**Scanning to a PC Application**

1. Load the document(s) face up with top edge in first into the DADF (Duplex Automatic Document Feeder).

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Loading an Original Document" .

2. Press Scroll ( or ) to highlight Scan and then press Select ( ).
3. Press Scroll ( or ) to highlight PC Application and then press Select ( ).
4. Press Scroll ( or ) to highlight Local PC or Network PC and then press Select ( ).

   *If you select Network PC*, enter your computer ID and password using the number keypad and then press Select ( ).

5. Press Scroll ( or ) to select an application to which you want to send the scanned image.
   - Microsoft Paint: Sends the scanned image to Microsoft Paint.
   - Email: Sends the scanned image to your default email program on the computer. A new message window opens with the image attached.
   - My Document: Saves the scanned image in the My Documents folder on the computer.

**NOTE:** You can add more TWAIN-compliant software for scanning, such as Adobe® Photoshop®, from the Dell Scan Manager . See "Scanning Using Dell Scan Manager" .

6. Press Scroll ( or ) to highlight the resolution, 75 dpi, 150 dpi, 200 dpi, 300 dpi, or 600 dpi and then press Select ( ).
7. Press Scroll ( or ) to select the scan color mode, Color, 256 Color, Gray, or Mono, and then press Select ( ).

8. Press Scroll ( or ) to highlight the scan file format, BMP, TIFF, PDF, or JPEG and then press Select ( ).

If you select Mono in Scan Format, do not select JPEG.

9. If you place a single document face down on the document glass, skip to step 11.

10. Press Scroll ( or ) to highlight the duplex option, Off, 2side or 2->1 side rotate and then press Select ( ).
   
   - Off: For originals that are printed on one side only.
   - 2side: For originals that are printed on both sides.
   - 2->1 side rotate: For originals that are printed on both sides. But the back is rotated 180 degrees.

11. Press Scroll ( or ) to highlight the scan size, Letter, A4, Legal, Executive, A5, or B5 and then press Select ( ) or Start ( ).

12. Scanning is started.

13. The selected application window opens. Adjust the scan settings and start scan. For details, please refer to the user's guide of the application.

   NOTE: If you selected My Document scanned image is saved in computer's My Document → My Pictures → Dell folder.

   NOTE: You can use Twain driver to scan quickly in Dell Scan Manager program.

Sending an Email via Quick Email

1. Load the document(s) face up with top edge in first into the DADF (Duplex Automatic Document Feeder).

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Loading an Original Document".

2. Press Scroll ( or ) to highlight Scan and then press Start ( ).

3. Press Scroll ( or ) to highlight the option, Local Address Book, Global Address Book, Group
Address Book and then press Select (  ).

4. Enter the sender's name and then press Select (  ).

Sender's name is the one you have set in the User Setup setting. See "Available Options for Email Account Setup".

5. Enter your login ID and then press Select (  ).

Login ID is the one you have set in the User Setup setting. See "Available Options for Email Account Setup".

6. Enter your login password and then press Select (  ).

Password is the one you have set in the User Setup setting. See "Available Options for Email Account Setup".

7. Press Scroll ( or ) to enter the recipient's email address and then press Select (  ).

**NOTE:** You can enter the name you have stored in the Address Book. See "Setting up Address Book".

The display asks if you want to enter another address.

8. To enter an additional address, press Scroll ( or ) to select Add and repeat step 7.

To continue to the next step, press Select (  ) when Done appears.

9. The display asks if you want to review addresses.

Press Scroll ( or ) to review addresses, press Select (  ) to select Yes and check the address you have entered.

To continue to the next setup, press Scroll ( or ) to select No and then press Select (  ).

10. The display asks if you want to send the e-mail to yourself.

To send to your e-mail address, press Select (  ) to select Yes.

Or, press Scroll ( or ) to select No and then press Select (  ).
11. Enter the email subject and then press Select (✓).

12. Press Scroll (✓ or ✓) to select the file type to which the scanned image may be converted and then press Select (✓).

13. Press Scroll (✓ or ✓) to select the resolution you want and then press Select (✓).

14. Press Start (✓) or Select (✓).

The printer begins scanning and then sends the e-mail.

15. If the display asks if you want to log off your account, press Scroll (✓ or ✓) to select Yes or No and then press Select (✓).

Your printer returns to the Standby mode.

---

**Scanning Using the Windows Image Acquisition (WIA) Driver**

Your printer also supports the WIA driver for scanning images. WIA is one of the standard components provided by Microsoft Windows XP/Server 2003/Server 2008/Vista/7 and works with digital cameras and scanners. Unlike the TWAIN driver, the WIA driver enables you to scan an image and easily manipulate those images without using additional software.

⚠️ **NOTE:** The WIA driver works only on Windows XP/Server 2003/Server 2008/Vista/7.

1. Load the document(s) face up with top edge in first into the DADF.

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Loading an Original Document".

2. Click Start ➔ Control Panel ➔ Printers and Other Hardware ➔ Scanners and Cameras.

   For Windows Vista, click Start ➔ Control Panel ➔ Hardware and Sound ➔ Scanners and Cameras.

   For Windows 7, click Start ➔ Control Panel ➔ Hardware and Sound ➔ Devices and Printers.

3. Double click your scanner icon. The Scanners and Camera Wizard launches.

   For Windows 7, click right button of mouse on device driver icon in Printers and Faxes ➔ Start Scan. New Scan application appears.

4. Choose your scanning preferences and click Preview to see how your preferences will affect the
5. Enter a picture name, and select a file format and destination to save the picture.

6. Follow the on-screen instructions to edit the picture after it is copied to your computer.

**NOTE:** PaperPort's built-in OCR software can copy text from scanned documents to any text editing, word processing, or spreadsheet program. The OCR process requires textual images scanned at 150 to 600 dpi. 300 dpi or 600 dpi is recommended for graphics.

---

### Scanning to the USB Memory

You can scan a document and save the scanned image on the USB memory. There are two ways of doing this: you can scan to the USB Memory using the default settings, or you can manually select your own settings.

### About USB Memory

USB memory is available with various memory capacities to give you enough space to store documents, presentations, downloaded music and videos, high resolution photographs, or whatever other files you want to take with you.

You can do the following features using an optional USB memory:

- Scan documents and save them on the USB Memory.
- Format the USB Memory.
- Check the available memory space.
**CAUTION:** If your USB memory has certain features, such as security settings and password settings, your printer may not automatically detect it. For details about these features, see the User's Guide which came with your USB memory key.

**Plugging in a USB memory key**

The USB memory port on the front of your printer is designed for USB V1.1 and USB V2.0 memory. You must use only a USB memory key whose connector style is A Plug Type.

![USB memory key](image)

Insert a USB memory key into the USB memory port on the front of your printer.

**CAUTION:** Do not remove the USB memory key during scanning operation. This may damage your printer.

**Scanning Using the Default Settings**

<table>
<thead>
<tr>
<th>Image Size</th>
<th>Version</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter (USA), A4 (UK)</td>
<td>JPEG</td>
<td>200 dpi</td>
</tr>
</tbody>
</table>

1. Insert the USB memory key into the USB memory port on your printer.

**NOTE:** Insert the USB memory key as soon as the pop-up window appears.

2. Load the document(s) face up with top edge in first into the DADF.
OR

Place a single document face down on the document glass.
For details about loading a document, see "Loading an Original Document".

3. Press Scroll (← or →) to highlight Scan and then press Select (✓).

4. Press Scroll (↙ or ↩) to highlight USB Key and then press Select (✓).

5. Press Scroll (↖ or ↩) to highlight Quick Scan and then press Select (✓) or Start ( ).

Your printer begins scanning the document and saves it to your USB memory.
For the document loaded on the document glass, the display asks if you want to load another page. Select Yes to add. Otherwise, select No.

Scanning Using My Settings

The following table shows the options you can select.

<table>
<thead>
<tr>
<th>Image Size</th>
<th>Version</th>
<th>Color</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter, A4, Legal, Folio, Executive, A5, A6, B5</td>
<td>JPEG, BMP, TIFF, PDF</td>
<td>Color, Gray, Mono</td>
<td>100, 200, 300, 600dpi</td>
</tr>
</tbody>
</table>

NOTE: 600 dpi resolution is available in color scanning only when additional memory DIMM is installed.

1. Insert the USB memory key into the USB memory port on your printer.
2. Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass.
For details about loading a document, see "Loading an Original Document".

3. Press Scroll (← or →) to highlight Scan and then press Select (✓).

4. Press Scroll (↙ or ↩) to highlight USB Key and then press Select (✓).

5. Press Scroll (↖ or ↩) to highlight Custom Scan and then press Select (✓).
6. Press Scroll (˄ or ˅) to highlight Full Glass or Auto and then press Select (✔).

7. If you select Full Glass and place a single document face down on the document glass, skip to step 10.

8. Press Scroll (˄ or ˅) to highlight the duplex option, Off, 2side or 2->1 side rotate and then press Select (✔).

   - Off: For originals that are printed on one side only.
   - 2side: For originals that are printed on both sides.
   - 2->1 side rotate: For originals that are printed on both sides. But the back is rotated 180 degrees.

9. Press Scroll (˄ or ˅) to highlight the image size, Letter, A4, Legal, Folio, Executive, A5, B5, or A6 and then press Select (✔).

10. Press Scroll (˄ or ˅) to highlight the file format, BMP, TIFF, PDF, or JPEG and then press Select (✔).

11. Press Scroll (˄ or ˅) to select the scan color mode, Color, Gray, or Mono, and then press Select (✔).

12. Press Scroll (˄ or ˅) to highlight to the resolution, 100 dpi, 200 dpi, 300 dpi, or 600 dpi and then press Select (✔).

13. If you place a single document face down on the document glass and select TIFF, or PDF, press Scroll (˄ or ˅) to select multi page option and then press Select (✔) or Start (✔).

14. Scanning is started.

   For the document loaded on the document glass, the display asks if you want to load another page. Select Yes to add. Otherwise, select No.

---

**Managing the USB Memory**

You can delete image files stored in the USB memory one by one or all at once by formatting the memory.

**Deleting an Image File**

To delete an image file that you scanned and saved on your USB memory stick.

1. Insert the USB memory key into the USB memory port on your printer.
2. Press **Scroll** ( or ) to highlight **Scan** and then press **Select** ( ).

3. Press **Scroll** ( or ) to highlight **USB Key** and then press **Select** ( ).

4. Press **Scroll** ( or ) to highlight **File Manage** and then press **Select** ( ).

5. Press **Scroll** ( or ) to highlight **Delete** and then press **Select** ( )

6. Press **Scroll** ( or ) to select the folder or file you want and then press **Select** ( ).

   *If you see "/" in the front of a folder name, there are one or more folders in the selected folder.

7. *If you selected a file in step 6, the display shows the size of the file for about 2 seconds. Go to the next step.

   *If you selected a folder, press **Scroll** ( or ) to select the file you want to delete and then press **Select** ( ).

8. Press **Select** ( ) when **Yes** appears to confirm your selection.

9. The display asks if you want to delete another file.

   Select **Yes** or **No**.

10. Press **Cancel** ( ) to return to the Standby mode.

**Formatting the USB Memory**

1. Insert the USB memory key into the USB memory port on your printer.

2. Press **Scroll** ( or ) to highlight **Scan** and then press **Select** ( ).

3. Press **Scroll** ( or ) to highlight **USB Key** and then press **Select** ( ).

4. Press **Scroll** ( or ) to highlight **File Manage** and then press **Select** ( ).

5. Press **Scroll** ( or ) to highlight **Format** and then press **Select** ( ).

6. Press **Select** ( ) when **Yes** appears to confirm your selection.

7. Press **Cancel** ( ) to return to the Standby mode.


**Printing from the USB Memory Key**

You can print files stored in the USB memory key. TIFF, BMP, TXT, PDF, and PRN file formats are supported.

⚠️ **NOTE:** Only English TXT files, PDF files generated by this printer, and TIFF 6.0 files are available.

1. Insert the USB memory key into the USB memory port on your printer.

2. Press Scroll ( or ) to highlight USB and then press Select ( ).

3. Press Scroll ( or ) to highlight Print From and then press Select ( ).

4. Press Scroll ( or ) to select the folder or file you want and then press Select ( ).

5. If you selected a file in step 4, go to the next step.

   If you selected a folder, press Scroll ( or ) to select the file you want to print and press Select ( ).

6. Enter the number of prints and then press Select ( ).

   Printing is started.

   If the selected file format is not supported, **File Format Not Supported** appears.

7. The display asks if you want to print another file.

   Select Yes or No.

8. Press Cancel ( ) to return to the Standby mode.

**Viewing the USB Memory Status**

You can check the amount of memory space available for scanning and saving documents.

1. Insert the USB memory key into the USB memory port on your printer.

2. Press Scroll ( or ) to highlight Scan and then press Select ( ).

3. Press Scroll ( or ) to highlight USB Key and then press Select ( ).

4. Press Scroll ( or ) to highlight Show Space and then press Select ( ).
The available memory space appears on the display.

5. Press **Cancel** (X) to return to the Standby mode.

---

**Scan to Email Setup**

To use e-mail features such as Scanning to E-mail and Fax Forward to E-mail addresses, you first need to configure the network settings and set up your e-mail account. See "Setting Up a Network-connected Printer" for network parameters.

**Setting up the Email Account**

1. Press **Scroll** (< or >) to highlight **Setup** and then press **Select** (✓).

2. Press **Scroll** (< or >) to highlight **Email Setup** and then press **Select** (✓).

3. Press **Scroll** (< or >) to highlight the menu item you want and then press **Select** (✓).

4. *If necessary,* press **Scroll** (< or >) until the submenu item you want appears and then press **Select** (✓).

5. Enter the required information or select the desired status and then press **Select** (✓).

6. Repeat steps 3 through 5 to change other options.

7. Press **Cancel** (X) to return to the Standby mode.

**Available Options for Email Account Setup**
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SMTP Server</strong></td>
<td>You can set the printer to access an SMTP server for outgoing mail.</td>
</tr>
<tr>
<td></td>
<td>- <strong>SMTP Server IP</strong>: Enables you to enter the IP address or host name of the SMTP server. This can be given in dotted decimal notation or as a domain name. (e.g. 111.222.333.444 or smtp.xyz.com)</td>
</tr>
<tr>
<td></td>
<td>- <strong>Max Mail Size</strong>: Enables you to specify the maximum size of mail which can be sent.</td>
</tr>
<tr>
<td><strong>User Setup</strong></td>
<td>You can register a user to use an email account.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Log off Reminder</strong>: You can set whether the printer reminds an authorized user about log off each time an email transmission is completed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Users</strong>: Enables you to add a user's login name, register login ID, and password. Login ID and password is needed when using the email.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Delete Users</strong>: Enables you to delete an authorized user.</td>
</tr>
<tr>
<td><strong>Send to Self</strong></td>
<td>You can set whether or not your outgoing emails are sent to your email account.</td>
</tr>
<tr>
<td><strong>Default From</strong></td>
<td>You can set the default email address for the &quot;From: &quot; address displays.</td>
</tr>
<tr>
<td><strong>Default Subject</strong></td>
<td>You can set the default subject in your emails.</td>
</tr>
<tr>
<td><strong>Email Forward</strong></td>
<td>You can set the printer to forward all of the outgoing or incoming faxes to specified e-mail addresses. See &quot;Fax Forward to E-mail addresses&quot;.</td>
</tr>
<tr>
<td><strong>Control Access</strong></td>
<td>You can protect the Email Setup feature with a passcode.</td>
</tr>
<tr>
<td><strong>Set Passcode</strong></td>
<td>You can change the passcode used for accessing the Email Setup feature.</td>
</tr>
</tbody>
</table>

a. If you want to use the host name in SMTP server, you must set the DNS server first.

---

**Scanning by a network connection**

If you have connected your machine to a network and set up network parameters correctly, you can scan and send images over the network.

**Preparing for network scanning**

Before using your machine's network scanning features, you need to configure the following settings depending on your scan destination:

- Registering as an authorized user for scanning to Email
- Setting up SMTP server for scanning to Email
User authentication for network scanning

To send an email, or Network, you need to register local or network authorized users using Embedded Web Service.

- If user authentication is activated, only authorized users in local or server DB (LDAP, Kerberos) can send scan data to network (Email, Network) using the machine.
- To use user authentication for network scanning, you need to register network or local authentication configuration using Embedded Web Service.
- User authentication has 3 types as no authentication (Default), network authentication and local Authentication.

Registering authorized users

1. Enter your machine's IP address as the URL in a browser and click Go to access the web site of your machine.
2. Click Email Settings ➔ Authentication.
4. Enter your auth ID, password.

You need to enter the registered user ID and password in the machine when you start scanning to email from the control panel.
5. Click Submit.

Setting up an e-mail account

To scan and send an image as an email attachment, you need to set up network parameters using Embedded Web Service.

1. Enter your machine's IP address as the URL in a browser and click Go to access the web site of your machine.
2. Click Email Settings ➔ SMTP Server Setup.
3. Enter the server port number, from 1 to 65535.

The default port number is 25.
4. Put a check mark in SMTP Requires Authentication to require authentication.
5. Enter your SMTP Server Login Name, SMTP Server Password, SMTP Server Connection Timeout, and Maximum Message Size.
6. Click Submit.
Network authorized user by LDAP

You can use not only local addresses stored in your machine's memory but also ones in the LDAP server. To use the global addresses, configure the LDAP server first via Embedded Web Service as following:

1. Enter your machine's IP address as the URL in a browser and click **Go** to access the web site of your machine.
2. Click **Email Settings** → **LDAP Server Setup**.
3. Enter the IP address in dotted decimal notation or as a host name.
4. Enter the server port number, from 1 to 65535.

   The default port number is 389.
5. Enter **Search Root Directory**. The top search level of the LDAP directory tree.
6. Enter your **Login Name**, **Password**, **Maximum Number of Search Results**, and **Search Timeout**.

   See "Email Settings" for network parameters.

   **NOTE: LDAP Referral**: LDAP client will search referral server in case LDAP server has no data to reply of query and LDAP server has any referral server.
7. Click **Submit**.

Available Options for LDAP Server

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **LDAP Server Setup**   | **LDAP Server and Port**
   - Specifies the LDAP server address in IP address format of "aaa.bbb.ccc.ddd" or as a DNS host name up to 63 characters.
   - And specifies the LDAP server port number up to 15 alphanumeric characters. |
<p>| <strong>Search Root Directory</strong> | Enter the top search level of the LDAP directory tree.                                                                                           |
| <strong>Authentication method</strong> | Specifies the authentication method for outgoing LDAP server.                                                                                     |
| <strong>Append Root to Base DN</strong> | Check if it is needed to append base DN at the end of the user DN.                                                                               |
| <strong>Login Name</strong>           | Specifies the LDAP account user name. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas. |</p>
<table>
<thead>
<tr>
<th><strong>Password</strong></th>
<th>Specifies the LDAP account password up to 31 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum Number of Search Results</strong></td>
<td>'0' means that the number of LDAP search results does not have limit. It shall be 5 ~ 100 entries.</td>
</tr>
<tr>
<td><strong>Search Timeout</strong></td>
<td>Sets the timeout period from 5 to 100 seconds.</td>
</tr>
<tr>
<td><strong>LDAP Referral</strong></td>
<td>Check if it is necessary.</td>
</tr>
</tbody>
</table>
| **Search Name Order** | - Choose **Common Name** if user id has "cn=<user name>" form.  
- Choose **Email Address** if user id has "mail=<user name>" form.  
- Choose **Surname Given Name** otherwise. |

### Setting up an e-mail alert

To configure detailed settings for email alert.

1. Enter your machine’s IP address as the URL in a browser and click **Go** to access the web site of your machine.
2. Click **Email Settings ➔ Email Alert Setup**.
3. Enter the item you want appears.
4. Click **Submit**.

⚠ **NOTE:** This feature is available only when DNS server is correctly set up.

### Available Options for Email Alert
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email Alert Setup</strong></td>
<td></td>
</tr>
<tr>
<td><strong>IP Address or Host Name</strong></td>
<td>Sets the IP address or Host name.</td>
</tr>
<tr>
<td><strong>Primary SMTP Gateway</strong></td>
<td>Sets the primary SMTP gateway.</td>
</tr>
<tr>
<td><strong>Enable Primary SMTP Auth</strong></td>
<td>Specifies the authentication method for outgoing e-mail.</td>
</tr>
<tr>
<td><strong>Primary SMTP Account Name</strong></td>
<td>Specifies the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td><strong>Primary SMTP Account Password</strong></td>
<td>Specifies the SMTP account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td><strong>Primary From</strong></td>
<td>Sender's e-mail address registered in the Primary server.</td>
</tr>
<tr>
<td><strong>SMTP Timeout</strong></td>
<td>Sets the timeout period from 30 to 120 seconds.</td>
</tr>
<tr>
<td><strong>Reply Address</strong></td>
<td>Designates the reply e-mail address sent with each E-mail Alert.</td>
</tr>
<tr>
<td><strong>Email Alert Setup</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Email List 1 ~ 2</strong></td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
</tr>
</tbody>
</table>
| **Select Alerts for List 1** | • **Supply Alert**: Select the check box to receive an E-Mail Alert for consumables.  
• **Paper Handling Alert**: Select the check box to receive an E-Mail Alert for paper handling. |
| **Select Alerts for List 2** | • **Supply Alert**: Select the check box to receive an E-Mail Alert for consumables.  
• **Paper Handling Alert**: Select the check box to receive an E-Mail Alert for paper handling. |

**Scanning and Sending an Email**

1. Ensure that your printer is connected to a network.
2. Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document".

3. Press **Scroll** (← or →) to highlight **Scan** and then press **Select** (✓).
4. Press **Scroll** (▲ or ▼) to highlight **Email** and then press **Select** ( ▀ ).

5. Enter your login ID and then press **Select** ( ▀ ).

   Login ID is the one you have set in the **User Setup** setting. See "Available Options for Email Account Setup".

6. Enter your login password and then press **Select** ( ▀ ).

   Password is the one you have set in the User Setup setting. See "Available Options for Email Account Setup".

7. Enter the recipient's email address and then press **Select** ( ▀ ).

   **NOTE:** You can enter the name you have stored in the **Address Book**. See "Setting up Address Book".

   The display asks if you want to enter another address.

8. To enter additional addresses, press **Scroll** (▲ or ▼) to select **Add** and repeat step 7.

   To continue to the next step, press **Select** ( ▀ ) when **Done** appears.

9. The display asks if you want to review addresses.

   Press **Scroll** (▲ or ▼) to review addresses, press **Select** ( ▀ ) to select **Yes** and check the address you have entered.

   To continue to the next setup, press **Scroll** (▲ or ▼) to select **No** and then press **Select** ( ▀ ).

10. The display asks if you want to send the e-mail to yourself.

    To send to your e-mail address, press **Select** ( ▀ ) to select **Yes**.

    Or, press **Scroll** (▲ or ▼) to select **No** and then press **Select** ( ▀ ).

11. Enter the email subject and then press **Select** ( ▀ ).

12. Press **Scroll** (▲ or ▼) to select the file type to which the scanned image may be converted and then press **Select** ( ▀ ).
12. Press **Scroll** ( ▲ or ▼ ) to select the resolution you want and then press **Select** ( ✔ ).

13. Press **Start** ( ▶ ) or **Select** ( ✔ ).

The printer begins scanning and then sends the e-mail.

14. If the display asks if you want to log off your account, press **Scroll** ( ▲ or ▼ ) to select **Yes** or **No** and then press **Select** ( ✔ ).

15. Press **Cancel** ( ✗ ) to return to the Standby mode.

---

### Setting up Address Book

You can set up your Address Book with the email addresses that you use frequently. You can then easily and quickly enter email addresses by entering the name you have assigned in the Address Book.

### Registering local email numbers

You can set up Address Book with the email addresses you use frequently via **Embedded Web Service** and then easily and quickly enter email addresses by entering the location numbers assigned to them in Address Book.

1. Enter your machine’s IP address as the URL in a browser and click **Go** to access the web site of your machine.

2. Click **Email Settings** ➔ **Address Book**.

3. Click **Local Address Book**.

4. Click **Add**.

5. Select a location number and enter the user name and e-mail address you want.

6. Click **Submit**.

**NOTE:** You can also click Import and obtain your address book from your computer.

### Adding an E-mail Address to Address Book

1. Press **Directory** ( ★ ) in the operator panel.

2. Press **Scroll** ( ▲ or ▼ ) to highlight **Email** and then press **Select** ( ✔ ).

3. Press **Scroll** ( ▲ or ▼ ) to highlight **Email Address** and then press **Select** ( ✔ ).
4. Press **Scroll** (△ or ▼) to highlight **New** and then press **Select** (✔
   ).

5. Enter the name you want to add and then press **Select** (✔
   ).

6. Enter the e-mail address for the name and then press **Select** (✔
   ).

7. Press **Cancel** (❌) to return to the Standby mode.

## Sending an Email using an Email Address

**NOTE:** You need to configure the **User Setup** settings in order to use the emails. See "Setting up an e-mail account".

**NOTE:** You can also send an email using an email address in **Scan → Email → Local Address Book**.

1. Load a document into the DADF or place it on the document glass.

2. Press **Directory** (зван) in the operator panel.

3. Press **Scroll** (△ or ▼) to highlight **Email** and then press **Select** (✔
   ).

4. Press **Scroll** (△ or ▼) to highlight **Email Address** and then press **Select** (✔
   ).

5. Press **Scroll** (△ or ▼) to highlight **Send** and then press **Select** (✔
   ).

6. Enter the sender's name and then press **Select** (✔
   ).

   Sender's name is the one you have set in the **User Setup** setting. See "Available Options for Email Account Setup".

7. Enter your login ID and then press **Select** (✔
   ).

   Login ID is the one you have set in the **User Setup** setting. See "Available Options for Email Account Setup".

8. Enter your login password and then press **Select** (✔
   ).

   Password is the one you have set in the **User Setup** setting. See "Available Options for Email Account Setup".

9. Press **Scroll** (△ or ▼) to enter the recipient's email address and then press **Select** (✔
   ).
NOTE: You can enter the name you have stored in the Address Book. See "Setting up Address Book".

The display asks if you want to enter another address.

10. To enter an additional address, press Scroll (▲ or ▼) to select Add and repeat step 8.

To continue to the next step, press Select (✓) when Done appears.

11. The display asks if you want to review addresses.

Press Scroll (▲ or ▼) to review addresses, press Select (✓) to select Yes and check the address you have entered.

To continue to the next setup, press Scroll (▲ or ▼) to select No and then press Select (✓).

12. The display asks if you want to send the e-mail to yourself.

To send to your e-mail address, press Select (✓) to select Yes.

Or, press Scroll (▲ or ▼) to select No and then press Select (✓).

13. Enter the email subject and then press Select (✓).

14. Press Scroll (▲ or ▼) to select the file type to which the scanned image may be converted and then press Select (✓).

15. Press Scroll (▲ or ▼) to select the resolution you want and then press Select (✓).

16. Press Start (✓) or Select (✓).

The printer begins scanning and then sends the e-mail.

17. If the display asks if you want to log off your account, press Scroll (▲ or ▼) to select Yes or No and then press Select (✓).

Your printer returns to the Standby mode.

Sending an Email using an Global Address via directory
NOTE: You need to configure the User Setup settings in order to use the emails. See "Setting up an e-mail account".

1. Load a document into the DADF or place it on the document glass.

2. Press Directory ( DIRECTORY ) in the operator panel.

3. Press Scroll ( left or right ) to highlight Email and then press Select ( SELECT ).

4. Press Scroll ( left or right ) to highlight Global Email and then press Select ( SELECT ).

5. Enter the sender's name and then press Select ( SELECT ).

Sender's name is the one you have set in the User Setup setting. See "Available Options for Email Account Setup".

6. Enter your login ID and then press Select ( SELECT ).

Login ID is the one you have set in the User Setup setting. See "Available Options for Email Account Setup".

7. Enter your login password and then press Select ( SELECT ).

Password is the one you have set in the User Setup setting. See "Available Options for Email Account Setup".

8. Press Scroll ( up or down ) to enter the recipient's email address and then press Select ( SELECT ).

NOTE: You can enter the name you have stored in the Address Book. See "Setting up Address Book".

The display asks if you want to enter another address.

9. To enter an additional address, press Scroll ( up or down ) to select Add and repeat step 8.

To continue to the next step, press Select ( SELECT ) when Done appears.

10. The display asks if you want to review addresses.

Press Scroll ( up or down ) to review addresses, press Select ( SELECT ) to select Yes and check the address you have entered.
To continue to the next setup, press Scroll ( or ) to select No and then press Select ( ).

11. The display asks if you want to send the e-mail to yourself.

To send to your e-mail address, press Select ( ) to select Yes.

Or, press Scroll ( or ) to select No and then press Select ( ).

12. Enter the email subject and then press Select ( ).

13. Press Scroll ( or ) to select the file type to which the scanned image may be converted and then press Select ( ).

14. Press Scroll ( or ) to select the resolution you want and then press Select ( ).

15. Press Start ( ) or Select ( ).

The printer begins scanning and then sends the e-mail.

16. If the display asks if you want to log off your account, press Scroll ( or ) to select Yes or No and then press Select ( ).

Your printer returns to the Standby mode.

**Sending an Email using an Global Address via LDAP server**

- **NOTE:** You first need to configure the LDAP server settings. See "Network authorized user by LDAP" for network parameters.

- **NOTE:** You need to configure the User Setup settings in order to use the emails. See "Setting up an e-mail account".

1. Load a document into the DADF or place it on the document glass.

2. Press Scroll ( or ) to highlight Scan and then press Select ( ).

3. Press Scroll ( or ) to highlight Email and then press Select ( ).

4. Press Scroll ( or ) to highlight Global Address Book and then press Select ( ).

5. Enter the sender's name and then press Select ( ).
Sender's name is the one you have set in the **User Setup** setting. See "Available Options for Email Account Setup".

6. Enter your login ID and then press **Select**.

Login ID is the one you have set in the **User Setup** setting. See "Available Options for Email Account Setup".

7. Enter your login password and then press **Select**.

Password is the one you have set in the **User Setup** setting. See "Available Options for Email Account Setup".

8. Press **Scroll** ( or ) to enter the recipient's email address and then press **Select**.

**NOTE:** You can enter the name you have stored in the **Address Book**. See "Setting up Address Book".

The display asks if you want to enter another address.

9. To enter an additional address, press **Scroll** ( or ) to select **Add** and repeat step 8.

To continue to the next step, press **Select** when **Done** appears.

10. The display asks if you want to review addresses.

Press **Scroll** ( or ) to review addresses, press **Select** ( ) to select **Yes** and check the address you have entered.

To continue to the next setup, press **Scroll** ( or ) to select **No** and then press **Select**.

11. The display asks if you want to send the e-mail to yourself.

To send to your e-mail address, press **Select** ( ) to select **Yes**.

Or, press **Scroll** ( or ) to select **No** and then press **Select**.

12. Enter the email subject and then press **Select**.

13. Press **Scroll** ( or ) to select the file type to which the scanned image may be converted and then press **Select**.
14. Press Scroll ( or ) to select the resolution you want and then press Select ( ).

15. Press Start ( ) or Select ( ).

The printer begins scanning and then sends the e-mail.

16. If the display asks if you want to log off your account, press Scroll ( or ) to select Yes or No and then press Select ( ).

Your printer returns to the Standby mode.

**Editing or Deleting an E-mail Address**

1. Press Directory ( ) in the operator panel.

2. Press Scroll ( or ) to highlight Email and then press Select ( ).

3. Press Scroll ( or ) to highlight Email Address and then press Select ( ).

4. Press Scroll ( or ) to highlight Edit and then press Select ( ).

5. Press Scroll ( or ) to select the e-mail address you want to edit or delete and then press Select ( ).

6. To delete the selected address, press Select ( ).

    OR

    To edit the selected address, press Scroll ( or ) to select Edit and then press Select ( ).

7. If you select Edit, edit the name and then press Select ( ). Edit the e-mail address and then press Select ( ).

8. Press Cancel ( ) to return to the Standby mode.

**Group Numbers**

If you frequently send the same document to several destinations, you can group these destinations and set them under a group dial location. This enables you to use a group dial number setting to send a document to
all destinations in the group. You can set up to 50 (1 through 50) group dial numbers.

**Configuring group email numbers**

You can set up Address Book with the email addresses you use frequently via Embedded Web Service and then easily and quickly enter email addresses by entering the location numbers assigned to them in Address Book.

1. Enter your machine’s IP address as the URL in a browser and click Go to access the web site of your machine.
2. Click Email Settings → Address Book.
3. Click Group Address Book.
4. Click Add.
5. Select a group number and enter the group name you want.
6. Select local email numbers that will be included in the group.
7. Click Submit.

**Assigning Email Addresses to a Group Number**

1. Press Directory ( ) in the operator panel.
2. Press Scroll ( or ) to highlight Email and then press Select ( ).
3. Press Scroll ( or ) to highlight Group Mail and then press Select ( ).
4. Press Scroll ( or ) to highlight New and then press Select ( ).
5. Enter a group location number between 1 and 50 and then press Select ( ).
6. Enter the group name and then press Select ( ).
7. Press Scroll ( or ) to enter the name you have saved and then press Select ( ).
8. At the Another Address prompt, press Scroll ( or ) to display Add and then press Select ( ). Repeat step 7.

OR

Press Select ( ) to select Done.

9. Press Cancel ( ) to return to the Standby mode.
Deleting a Group Number

1. Press **Directory ( )** in the operator panel.
2. Press **Scroll ( or )** to highlight **Email** and then press **Select ( )**.
3. Press **Scroll ( or )** to highlight **Group Mail** and then press **Select ( )**.
4. Press **Scroll ( or )** to highlight **Delete** and then press **Select ( )**.
5. Enter a group location number you want to delete and then press **Select ( )**.
6. Press **Select ( )** when **Yes** appears.
7. Press **Cancel ( )** to return to the Standby mode.

Editing Group Numbers

1. Press **Directory ( )** in the operator panel.
2. Press **Scroll ( or )** to highlight **Email** and then press **Select ( )**.
3. Press **Scroll ( or )** to highlight **Group Mail** and then press **Select ( )**.
4. Press **Scroll ( or )** to highlight **Edit** and then press **Select ( )**.
5. Enter a group location number you want to edit and then press **Select ( )**.
6. Edit the group name and then press **Select ( )**.
7. Press **Select ( )** when **View** appears to check the group address(es) list.

OR

Press **Scroll ( or )** to display **Add** and then press **Select ( )** to add another e-mail address(es). Enter the recipient name you have saved and then press **Select ( )**.

OR
Press **Scroll** (▲ or ▼) to display **Delete** and then press **Select** (✓✓) to delete the e-mail address(es) in the group.

### Sending an Email using a Group Number

**NOTE:** You can also send an email using a group number in **Scan → Email → Group Mail**.

1. Load the document(s) face up with top edge in first into the DADF.

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Adjusting the Document Contrast".

2. Press **Directory** ( hypertarget ) in the operator panel.

3. Press **Scroll** (▲ or ▼) to highlight **Email** and then press **Select** (✓✓).

4. Press **Scroll** (▲ or ▼) to highlight **Group Mail** and then press **Select** (✓✓).

5. Press **Scroll** (▲ or ▼) to highlight **Send** and then press **Select** (✓✓).

6. Enter the sender's name and then press **Select** (✓✓).

7. The e-mail address you have assigned for the name appears. Press **Select** (✓✓).

8. The display asks you if you want to send e-mail to yourself.

   Select **Yes** or **No** and then press **Select** (✓✓).

9. Enter the group location number and then press **Select** (✓✓).

10. The display asks if you want to review addresses.

    Press **Scroll** (▲ or ▼) to review addresses, press **Select** (✓✓) to select **Yes** and check the address you have entered.

    To continue to the next setup, press **Scroll** (▲ or ▼) to select **No** and then press **Select** (✓✓).

11. Enter the email subject and then press **Select** (✓✓).

12. Press **Scroll** (▲ or ▼) to select the file type to which the scanned image may be converted and then
11. Press Select ( ).

12. Press Scroll ( ▲ or ▼ ) to select the resolution you want and then press Select ( ).

13. Press Start ( ) or Select ( ).

The printer begins scanning and then sends the e-mail.

14. If the display asks if you want to log off your account, press Scroll ( ▲ or ▼ ) to select Yes or No and then press Select ( ).

Your printer returns to the Standby mode.

**Printing Address Book**

You can check your Address Book list by printing it on the paper.

1. Press Directory ( ) in the operator panel.

2. Press Scroll ( ▲ or ▼ ) to highlight Email and then press Select ( ).

3. Press Scroll ( ▲ or ▼ ) to highlight Email Address and then press Select ( ).

4. Press Scroll ( ▲ or ▼ ) to highlight Print and then press Select ( ).

5. Press Scroll ( ▲ or ▼ ) to select Individual, Group Address or All and then press Select ( ).

The selected list prints out.

---

**Changing Default Settings**

You can set up default scan settings.

1. Press Scroll ( ▲ or ▼ ) to highlight Scan and then press Select ( ).

2. Press Scroll ( ▲ or ▼ ) to highlight Scan Defaults and then press Select ( ).

3. Press Scroll ( ▲ or ▼ ) to scroll through the setup options.
4. When the option you want to set appears, press Select (✓) to access the option.
5. Change the setting using the Scroll (✓ or ✓) buttons or enter the value using the number keypad.
6. Press Select (✓) to save the selection.
7. Repeat steps 3 through 6, as needed.
8. Press Cancel (✗) to return to the Standby mode.

---

**Scan to Fax Server**

Fax server will decipher the fax/e-mail data to send out the job. The e-mail is automatically processed by fax server and sent to the given recipient.

First, the printer sends the scanned data to the fax server. Then, the fax server uses PSTN to send a fax/e-mail data to recipient.

To use fax server features as scan to e-mail, you first need to configure the network settings. See "Dell Printer Configuration Web Tool" for network parameters.

1. Press Scroll (✓ or ✓) to highlight Scan and then press Select (✓).
2. Press Scroll (✓ or ✓) to highlight Fax Server and then press Select (✓).
3. Enter the remote fax phone number using the number keypad.
4. If you place a single document face down on the document glass, skip to step 6.
5. Press Scroll (✓ or ✓) to highlight the duplex option, Off, 2side or 2->1 side rotate and then press Select (✓).
   - Off: For originals that are printed on one side only.
   - 2side: For originals that are printed on both sides.
   - 2->1 side rotate: For originals that are printed on both sides. But the back is rotated 180 degrees.
6. Press Start (✓) or Select (✓).
   - The printer begins scanning and then sends the fax.
7. Press Cancel (✗) to return to the Standby mode.
Networking

- About Sharing the Printer on a Network
- Setting Up the Locally Shared Printer
- Setting Up a Network-connected Printer

About Sharing the Printer on a Network

Locally-shared Printer

You can connect the printer directly to a selected computer, which is called the "host computer" on the network. The printer can then be shared by other users on the network through a Windows 2000, XP, Server 2003, Server 2008, Vista, 7 or Server 2008 R2 network printer connection.

Wired Network-connected Printer

Your printer has a built-in network interface. For details, see "Connecting the printer to the Network".

Printing Across a Network

Whether the printer is locally connected or network-connected, you need to install the Dell 2335dn MFP software on each computer that prints documents using the printer.

Setting Up the Locally Shared Printer

You can connect the printer directly to a selected computer, which is called the "host computer," on the network. Your printer can be shared by other users on the network through a Windows 2000, XP, Server 2003, Server 2008, or Vista network printer connection.


![NOTE: This process assumes that drivers have already been installed.](image)

Share the Printer

1. For Windows 2000, click the Start button ➔ Settings ➔ Printer.
1. For Windows XP/Server 2003, click the **Start** button and point to **Printers and Faxes**.
   
   For Windows Vista/Server 2008, click the **Start** button and click **Control Panel** ➔ **Hardware and Sound** ➔ **Printers**.
   
   For Windows 7, click the **Start** button and click **Control Panel** ➔ **Hardware and Sound** ➔ **Devices and Printers**.
   
   For Windows Server 2008 R2, click the **Start** button and click **Control Panel** ➔ **Hardware** ➔ **Devices and Printers**.
   
   Double-click your printer icon.
   
2. **2.** Click the **Printer** menu and point to **Sharing**.
   
3. If you are using Windows Vista, you may be prompted to change the sharing options before you can continue. Press the **Change Sharing Options** button, and the press **Continue** on the next dialog box.
   
4. For Windows 2000, check the **Shared As** box.
   
   For Windows XP/Server 2003/Server 2008/Vista/7/Server 2008 R2, check the **Share this printer** box.
   
5. **5.** Fill in the **Share Name** field.
   
6. Click **Additional Drivers** , and select the operating systems of all network clients printing to this printer.
   
7. Click **OK**.
   
   If you are missing files, you are prompted to insert the server operating system CD.
   
   a. Insert the **DRIVERS AND UTILITIES CD** , ensure that the drive letter is correct for your CD-ROM drive, and then click **OK**.
   
   b. If you are using Windows Vista/7: Brows to a client computer running the operating system, and then click **OK**. If you are using any other Windows version: Insert the operating system CD, ensure that the drive letter is correct for your CD-ROM drive, and then click **OK**.
   
8. **9.** Click **Close**.
   
To check that the printer was successfully shared:

- Make sure the printer object in the **Printers** folder shows it is shared. For example, in Windows 2000, a hand is shown underneath the printer icon.

- Browse **My Network Places** or **Network Neighborhood** . Find the host name of the server, and look for the shared name you assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the point and print method or the Peer-to-Peer method.

**Install the Shared Printer on Client Computers**
**Point and Print**

This method is the best use of system resources. The print server handles driver modifications and print job processing. This lets network clients return to their programs much faster.

If you use the Point and Print method, a subset of driver information is copied from the print server to the client computer. This is just enough information to send a print job to the printer.

1. Right-click the **Start** button and point to **Explore**.
2. Double-click **My Network Places** or **Network Neighborhood**.
3. Double-click the host name of the printer server computer.
4. Right-click the shared printer name, and then click **Install** or **Connect**.

   Wait for the driver information to copy from the print server computer to the client computer, and for a new printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other factors.
5. Close **My Network Places** or **Network Neighborhood**.
6. Print a test page to verify print installation.

   When a test page prints successfully, printer installation is complete. See "To print a test page:"

**Peer-to-Peer**

If you use the Peer-to-Peer method, the printer driver is fully installed on each client computer. Network clients retain control of driver modifications. The client computer handles the print job processing.

1. For Windows 2000, click the **Start** button ➔ **Settings** ➔ **Printer**.
   For Windows XP/Server 2003, click the **Start** button and point to **Printers and Faxes**.
   For Windows Vista/Server 2008, click the **Start** button and click **Control Panel** ➔ **Hardware and Sound** ➔ **Printers**.
   For Windows 7, click the **Start** button and click **Control Panel** ➔ **Hardware and Sound** ➔ **Devices and Printers**.
   For Windows Server 2008 R2, click the **Start** button and click **Control Panel** ➔ **Hardware** ➔ **Devices and Printers**.
2. Click **Add Printer** to launch the Add Printer wizard.
3. Click **A network printer, or a printer attached to another computer**.
4. Select the network printer from the Shared printers list. If the printer is not listed, type the path of the printer in the text box.

   For example: `\<print server host name>\<shared printer name>`

   The print server host name is the name of the print server computer that identifies it to the network. The shared printer name is the name assigned during the print server installation process.
5. Click **OK**.

   If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide a path to available drivers.

6. Select whether you want this printer to be the default printer for the client, and then click **Finish**.

7. Print a test page to verify printer installation.

   When a test page prints successfully, printer installation is complete.

**To print a test page:**

1. For Windows 2000, click the **Start** button ➔ **Settings** ➔ **Printer**.

   For Windows XP/Server 2003, click the **Start** button and point to **Printers and Faxes**.

   For Windows Vista/Server 2008, click the **Start** button and click **Control Panel** ➔ **Hardware and Sound** ➔ **Printers**.

   For Windows 7, click the **Start** button and click **Control Panel** ➔ **Hardware and Sound** ➔ **Devices and Printers**.

   For Windows Server 2008 R2, click the **Start** button and click **Control Panel** ➔ **Hardware** ➔ **Devices and Printers**.

2. Double-click your printer icon.

3. Click the **File** menu and point to **Properties**.

4. Click the **General** tab, and select **Print Test Page**.

---

**Setting Up a Network-connected Printer**

You must set up the network protocols on the printer to use it as your network printer. Protocols can be set up by the following two methods:

**1 Via Network Administration Programs**

You can configure your printer's print server settings and manage it via the following programs:

- **Set IP Address Utility** : A utility program allowing you to find your network printer and manually configure the addresses for use with the TCP/IP protocol.

- **Embedded Web Service** : A web server embedded to your network print server, which allows you to:

  Configure the network parameters necessary for the printer to connect to various network environments.

**2 Via the Operator Panel**
You can configure the basic network parameters through the printer’s operator panel. Use the printer operator panel to do the following:

- Print a Network Configuration Page
- Configure TCP/IP
- Configure EtherTalk
- Configure a Wireless network

**Configuring Network Parameters on the Operator Panel**

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Interface</td>
<td>• 10/100 Base-TX</td>
</tr>
<tr>
<td></td>
<td>• 802.11 b/g Wireless LAN (Optional)</td>
</tr>
<tr>
<td>Network Operating System</td>
<td>• Windows: WinNT4.0/2000/XP(32/64bits)/Vista(32/64bits)/2003 Server(32/64bits)/2008 Server(32/64bits)/7/Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Novell NetWare NDPS services via TCP/IP &amp; IPP on 5.x, 6.x, Mac OS 10.3 ~ 10.6</td>
</tr>
<tr>
<td></td>
<td>• Various Linux OS including Red Hat 8<del>9, Fedora Core 1</del>4, Mandrake 9.2<del>10.1, SuSE 8.2</del>9.2, Suse linux Enterprise Version 10, Redhat WS Linux 5.0</td>
</tr>
<tr>
<td></td>
<td>• UNIX(TBD, SUN 8,9,10, HP-UX 11i, IBM AIX 5.2, 5.3)</td>
</tr>
<tr>
<td></td>
<td>• Citrix, Windows Terminal Server, SAP</td>
</tr>
<tr>
<td>Network Protocols</td>
<td>TCP/IPv4, IPv6 (DHCP, DNS, 9100, LPR, SNMP, HTTP, IPSec), EtherTalk, Novell NetWare NDPS services via TCP/IP &amp; IPP on 5.x, 6.x, DHCP, BOOTP, SLP, SSDP, Bonjour (Rendezvous), DDNS, WINS, TCP (Port 2000), LPR (Port 515), Raw (Port 9100), SNMPv1/2/3, HTTP, Telnet, SMTP (E-mail Notification)</td>
</tr>
<tr>
<td>Dynamic Addressing Server</td>
<td>DHCP, BOOTP</td>
</tr>
</tbody>
</table>

**Printing a Network Configuration Page**

The Network Configuration page shows how the network interface card on your printer is configured. The default settings are suitable for most applications.

1. Press **Scroll (← or →)** to highlight **Setup** and then press **Select (✓)**.
2. Press **Scroll (↑ or ↓)** to highlight **Reports** and then press **Select (✓)**.
3. Press **Scroll (← or →)** to highlight **Network Settings** and then press **Select (✓)**.
The Network Configuration page prints out.

**Setting Network Protocols**

When you first install and power up the printer, all supported network protocols are enabled. *If a network protocol is enabled*, the printer may actively transmit on the network even when the protocol is not in use. This may slightly increase network traffic. To eliminate unnecessary traffic, you may disable unused protocols.

1. Press **Scroll** (◀ or ▶) to highlight **Setup** and then press **Select** (✔).
2. Press **Scroll** (▲ or ▼) to highlight **Network Setup** and then press **Select** (✔).
3. Press **Scroll** (▲ or ▼) until you see the desired protocol and then press **Select** (✔).
4. *If you selected Ethernet Speed*, select a network speed.

   *If you selected TCP/IP (IPv4) or TCP/IP (IPv6)*, assign a TCP/IP address. For details, see "Configuring TCP/IP".

   *If you selected AppleTalk*.

   a. Press **Scroll** (▲ or ▼) to select **Activate** and then press **Select** (✔).

   b. Press **Scroll** (▲ or ▼) to change the setting to **On** (enable) or **Off** (disable).

   
   **NOTE:** When you set AppleTalk, you must restart your machine to apply new settings.

5. Press **Select** (✔) to save the selection.

**Configuring TCP/IP**

- **Static Addressing:** TCP/IP address is assigned manually by the system administrator.
- **Dynamic Addressing:** BOOTP/DHCP (default): TCP/IP address is assigned automatically by a DHCP or BOOTP server on your network.

**NOTE:** Only the system administrator can set the IP address for TCP/IP (IPv6).

**Setting TCP/IP**
To enter the TCP/IP setting from your printer's operator panel, take the following steps:

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).

2. Press Scroll ( or ) to highlight Network Setup and then press Select ( ).

3. Press Scroll ( or ) to select the network protocol you want to use and then press Select ( ).

   If you selected TCP/IP (IPv4) .

      a. Press Scroll ( or ) to select IPv4 Activate and then press Select ( ).

      b. Press Scroll ( or ) to change the setting to On (enable) or Off (disable).

   If you selected TCP/IP (IPv6) .

      a. Press Scroll ( or ) to select IPv6 Activate and then press Select ( ).

      b. Press Scroll ( or ) to change the setting to On (enable) or Off (disable).

   d. Press Cancel ( ) to return to the Standby mode.

**Static Addressing**

To enter the TCP/IP address from your printer's operator panel, take the following steps:

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).

2. Press Scroll ( or ) to highlight Network Setup and then press Select ( ).

3. Press Scroll ( or ) to highlight TCP/IP (IPv4) and then press Select ( ).

4. Press Scroll ( or ) to highlight Set IP Address and then press Select ( ).

5. The first available menu item, Manual , appears and then press Select ( ).

6. The first available menu item, Set IP Address displays.

7. Press Select ( ) to access the IP Address menu.
An IP address consists of 4 bytes.

8. Enter the numbers from the keypad and use Scroll (← or →) to move between octets and then press Select (✓).

9. Enter other parameters, such as the Subnet Mask or Gateway, and then press Select (✓).

10. After entering all parameters, press Cancel (✗) to return to the Standby mode.

**Dynamic Addressing (BOOTP/DHCP)**

To assign the TCP/IP address automatically using a DHCP or BOOTP server on your network.

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).

2. Press Scroll (◄ or ►) to highlight Network Setup and then press Select (✓).

3. Press Scroll (◄ or ►) to highlight TCP/IP (IPv4) and then press Select (✓).

4. Press Scroll (◄ or ►) to highlight Set IP Address and then press Select (✓).

5. Press Scroll (◄ or ►) to highlight DHCP and then press Select (✓).

   To assign the address from the BOOTP server, press Select (✓) when BOOTP displays.

**Restoring the Network Configuration**

You can return the network configuration to its default settings.

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).

2. Press Scroll (◄ or ►) to highlight Network Setup and then press Select (✓).

3. Press Scroll (◄ or ►) to highlight Clear Settings and then press Select (✓).

4. Press Scroll (◄ or ►) to highlight Yes and then press Select (✓) to restore the network configuration.

5. Power the printer off and back on or reset the network interface card.
Setting For Special Solutions

When you use a specific printing solution such as Novell iPrint, you have to configure this feature. The interpretation of printer status information may differ from the printing solution system. If the client computer shows a different printer’s status from the status on your printer, try to set this option.

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).

2. Press Scroll ( or ) to highlight Network Setup and then press Select ( ).

3. Press Scroll ( or ) to highlight iPrint Notification and then press Select ( ).

4. Press Scroll ( or ) to select the client operating system.
   - Win (XP, 2K, 2003)
   - Windows Vista
   - Windows 7

5. Press Select ( ) to save the selection.
Faxing

- Setting the Printer ID
- Using the Number Keypad to Enter Characters
- Setting the Time and Date
- Setting Daylight Savings Time
- Changing the Clock Mode
- Setting Sounds
- Toll Save Mode
- Setting up the Fax System
- Sending a Fax
- Receiving a Fax
- Automatic Dialing
- Other Ways to Fax
- Additional Features
- Sending a fax from a Computer
- Fax data back-up

Setting the Printer ID

In most countries, you are required by law to indicate your fax number on any fax you send. The printer ID, containing your telephone number and name or company name, will be printed at the top of each page sent from your printer.

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).
2. Press Scroll ( or ) to highlight Machine Setup and then press Select ( ).
3. Press Scroll ( or ) to highlight Machine ID and then press Select ( ).
4. Enter your fax number using the number keypad.

   **NOTE:** If you make a mistake while entering numbers, press the left Scroll ( ) button to delete the last digit.
5. Press Select ( ) when the number on the display is correct. The display asks you to enter the ID.
6. Enter your name or company name using the number keypad.
7. You can enter alphanumeric characters using the number keypad, including special symbols by pressing the 1 button.

   For details on how to use the number keypad to enter alphanumeric characters, see "Using the Number Keypad to Enter Characters".
8. Press **Select** (✓) when the name on the display is correct.

9. Press **Cancel** (✗) to return to the Standby mode.

---

**Using the Number Keypad to Enter Characters**

As you perform various tasks, you may need to enter names and numbers. For example, when you set up your printer, you enter your name or your company's name and telephone number. When you store fax numbers in memory, you may also enter the corresponding names.

- When prompted to enter a letter, press the appropriate button until the correct letter appears on the display.
  
  For example, to enter the letter O, press 6.
- Each time you press 6, the display shows a different letter, M, N, O and finally 6.
- To enter additional letters, repeat the first step.
- Press 1 to enter a space or special characters.
- Press **Select** (✓) when you are finished.

**Keypad Letters and Numbers**
### Key

<table>
<thead>
<tr>
<th>Key</th>
<th>Assigned numbers, letters or characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 @ . _ space , /* # &amp; $ + - `</td>
</tr>
<tr>
<td>2</td>
<td>A B C 2</td>
</tr>
<tr>
<td>3</td>
<td>D E F 3</td>
</tr>
<tr>
<td>4</td>
<td>G H I 4</td>
</tr>
<tr>
<td>5</td>
<td>J K L 5</td>
</tr>
<tr>
<td>6</td>
<td>M N O 6</td>
</tr>
<tr>
<td>7</td>
<td>P Q R S 7</td>
</tr>
<tr>
<td>8</td>
<td>T U V 8</td>
</tr>
<tr>
<td>9</td>
<td>W X Y Z 9</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

### Changing Numbers or Names

*If you make a mistake while entering a number or name, press the left Scroll (_left button to delete the last digit or character. Then enter the correct number or character.*

### Inserting a Pause

For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must be entered in order for the access code to function. For example, enter the access code 9 and then press Pause (Pause) before entering the telephone number. A "–" appears on the display to indicate when a pause is entered.

### Setting the Time and Date

The time and date are printed on all faxes.

**NOTE:** It may be necessary to reset the correct time and date if loss of power to the printer occurs.

To set the time and date:

1. Press Scroll (left or right) to highlight Setup and then press Select (Select).
2. Press Scroll (left or right) to highlight Machine Setup and then press Select (Select).
3. Press Scroll (left or right) to highlight Date & Time and then press Select (Select).
4. Enter the correct time and date using the number keypad.
Month = 01 ~ 12
Day = 01 ~ 31
Year = 2000 ~ 2099
Hour = 01 ~ 12 (12-hour mode)
00 ~ 23 (24-hour mode)
Minute = 00 ~ 59

You can also use Scroll ( or ) to move the cursor under the digit you want to correct and enter a new number.

5. To select AM or PM for a 12-hour format, press the ⬅️ or the ⬅️ button.

When the cursor is not under the AM or PM indicator, pressing the ⬅️ or the ⬅️ button immediately moves the cursor to the indicator.

You can change the clock mode to a 24-hour format (e.g. 01:00 PM as 13:00). Press Scroll ( or ) to highlight AM or PM and then press Scroll ( or ).

6. Press Select ( ) when the time and date on the display is correct.

⚠️ NOTE: The printer beeps and does not allow you to proceed to the next step if a wrong number is entered.

---

**Setting Daylight Savings Time**

If your country switches to Daylight Savings Time each year, use this procedure to automatically switch to Daylight Savings Time and to Standard time.

1. Press Scroll ( or ) to highlight Setup and then press Select ( ).
2. Press Scroll ( or ) to highlight Machine Setup and then press Select ( ).
3. Press Scroll ( or ) to highlight Day Light Saving and then press Select ( ).
4. Press Scroll ( or ) to highlight On and then press Select ( ).
5. Enter Start Date and then press Select ( ).
6. Enter End Date and then press Select ( ).
7. Press Cancel ( ) to return to the Standby mode.
Changing the Clock Mode

You can set your printer to display the current time using either the 12-hour or the 24-hour format.

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Machine Setup and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Clock Mode and then press Select (✓).

   The printer displays the Clock mode that is currently set.

4. Press Scroll (▲ or ▼) to select the other mode and then press Select (✓) to save the
   selection.
5. Press Cancel (X) to return to the Standby mode.

Setting Sounds

Speaker, Ringer, Button and Alarm Sounds

1. Press Scroll (← or →) to highlight Setup and then press Select (✓).
2. Press Scroll (▲ or ▼) to highlight Machine Setup and then press Select (✓).
3. Press Scroll (▲ or ▼) to highlight Sound/Volume and then press Select (✓).

4. Press Scroll (▲ or ▼) to scroll through the options. Press Select (✓) when you see the
   sound option you want.
5. Press Scroll (▲ or ▼) to display the status or loudness you want for the option you have selected.

   For the ringer volume, you can select from Off, Low, Med and High. Setting Off means that the
   ringer turns off. The printer works normally even if the ringer is turned off.

6. Press Select (✓) to save the selection.
7. If necessary, repeat steps 4 through 6.
8. Press Cancel (  ) to return to the Standby mode.

---

**Toll Save Mode**

The Toll Save mode can be used to save scanned documents for transmission at a specified time in order to take advantage of lower long distance rates.

To turn the Toll Save mode on:

1. Press Scroll ( or ) to highlight Setup and then press Select (  ).
2. Press Scroll ( or ) to highlight Fax Setup and then press Select (  ).
3. Press Scroll ( or ) to highlight Toll Save and then press Select (  ).
4. Press Scroll ( or ) to display On and then press Select (  ).
5. After 1 second, enter the time and date when your printer starts sending toll save faxes, using the number keypad.
   - To select AM or PM for 12-hour format, press Scroll ( or ) to highlight AM or PM and then press Scroll ( or ).
6. Press Select (  ) when the starting time on the display is correct.
7. After 1 second, enter the time and date when the toll save transmission ends, using the number keypad.
8. Press Select (  ) to save the setting.
9. Press Cancel (  ) to return to the Standby mode.

Once Toll Save mode is activated, your printer stores all of the documents to be faxed into its memory and sends them at the programmed time.

To turn Toll Save mode off, follow steps 1 and 3 in "Toll Save Mode" and then press Scroll ( or ) until Off displays and then press Select (  ).

---

**Setting up the Fax System**
Changing the Fax Setup Options

1. Press Scroll (◄ or ► ) to highlight Fax and then press Select (✓).

2. Press Scroll (◄ or ► ) to highlight Fax Defaults and then press Select (✓).

3. Press Scroll (◄ or ► ) to display the desired menu item and then press Select (✓).

4. Use Scroll (◄ or ► ) to find the status or use the number keypad to enter the value for the option you have selected.

5. Press Select (✓) to save the selection.

6. If necessary, repeat steps 3 through 5.

7. Press Cancel (✗) to return to the Standby mode.

Available Fax Defaults Options

You can use the following setup options for configuring the fax system:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contrast</strong></td>
<td>You can select the default contrast value to fax your documents lighter or darker.</td>
</tr>
<tr>
<td><strong>Send Quality</strong></td>
<td>You can select the default resolution setting to Standard, Fine, Super Fine, Photo, or Color.</td>
</tr>
<tr>
<td><strong>Ring To Answer</strong></td>
<td>You can specify the number of times the printer rings, 1-7, before answering an incoming call.</td>
</tr>
<tr>
<td><strong>Receive Mode</strong></td>
<td>You can select the default fax receiving mode.</td>
</tr>
<tr>
<td><strong>Fax mode (automatic receive mode)</strong></td>
<td>The printer answers an incoming call and automatically goes into receive mode. The number of rings before the printer answers can be set in the Ring To Answer option. If the user memory is full, the printer can no longer receive any incoming fax. Secure free memory to resume by canceling Priority Fax or printing received faxes.</td>
</tr>
<tr>
<td><strong>Tel mode (manual receive mode)</strong></td>
<td>Manual receive mode is enabled when the automatic fax reception is turned off.</td>
</tr>
<tr>
<td></td>
<td>You can receive a fax by:</td>
</tr>
<tr>
<td></td>
<td>o picking up the handset of the extension phone not directly connected to the back of the printer and then pressing the remote receive code, or</td>
</tr>
<tr>
<td></td>
<td>o picking up the handset of the extension phone directly connected to the back of the multi-function printer and pressing Start (✓), or</td>
</tr>
</tbody>
</table>
- accessing **Fax ➔ On Hook Dial ➔ Yes** when the bell is ringing (you can hear voice or fax tones from the remote machine) and then pressing **Start** on the operator panel.

- **Ans/Fax mode**: The printer can share one telephone line with an answering machine. In this mode, the printer may monitor the fax signal and pick up the line if there are fax tones. If the phone communication in your country is serial, this mode is not available.

- **DRPD mode**: Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Redial Delay</strong></td>
<td>Your printer can automatically redial a remote fax machine <em>if it was busy</em>. Intervals from 1-15 minutes can be entered.</td>
</tr>
<tr>
<td><strong>Redial Attempt</strong></td>
<td>You can specify the number of redial attempts, 0-13.</td>
</tr>
<tr>
<td><strong>MSG Confirm</strong></td>
<td>You can set your printer to print a report showing whether the transmission was successful, how many pages were sent, and more. The available options are <strong>On</strong>, <strong>Off</strong> and <strong>On-Error</strong>, which prints only when a transmission is not successful.</td>
</tr>
<tr>
<td><strong>Auto Report</strong></td>
<td>A report with detailed information about the previous 50 communications operations, including time and date. The available options are <strong>On</strong> or <strong>Off</strong>.</td>
</tr>
<tr>
<td><strong>Auto Reduction</strong></td>
<td>When receiving a document as long as or longer than the paper loaded in the paper tray, the printer can reduce the size of the document to fit the size of paper loaded in the printer. Select <strong>On</strong> if you want to automatically reduce the incoming document. With this feature set to <strong>Off</strong>, the printer cannot reduce the document to fit onto one page. The document is divided and printed in actual size on two or more pages.</td>
</tr>
</tbody>
</table>
| **Discard Size** | When receiving a document as long as or longer than the paper installed in your printer, you can set the printer to discard any excess at the bottom of the page. *If the received page is outside the margin you set, it will print on two sheets of paper at the actual size.*  

  When the document is within the margin and the Auto Reduction feature is turned on, the printer reduces the document to fit it onto the appropriate sized paper and discarding does not occur. *If the Auto Reduction feature is turned off or fails, the data within the margin will be discarded.* Settings range from 0-30 mm. |
| **Receive Code**  | The Receive Code enables you to initiate fax reception from an extension phone plugged into the extension telephone socket on the back of the printer. *If you pick up the extension phone and hear fax tones, enter the Receive Code*. The Receive Code is preset to *9* at the factory. Settings range from 0-9. See "Receiving Manually Using an Extension Telephone" for more information about using the code. |
**DRPD Mode**
You can receive a call using the Distinctive Ring Pattern Detection (DRPD) feature which enables a user to use a single telephone line to answer several different telephone numbers. In this menu, you can set the printer to recognize the ring patterns to answer. For details about this feature, see "Receiving Faxes Using the DRPD Mode".

**Select Tray**
You can set the tray that you want to use for a received fax printing job.

**Print Duplex**
You can set the machine to print received faxes on both sides of paper. The available options are **Off**, **Long Edge**, and **Short Edge**.

---

**Testing Fax line connection**

1. Press Scroll (← or →) to highlight Fax and then press Select (✓).

2. Press Scroll (← or →) to highlight Fax Line Test and then press Select (✓).

3. Press Scroll (← or →) to select the option you want and then press Select (✓).
   - **Line Test**: Check the fax line connection.
   - **Dial Tone Test**: Check the dial tone.

The printer displays the test result.

If the fax line connection test has failed, check the telephone line cord connection or contact your telephone service provider.

**NOTE:** If test pass - you can start using the Fax functionality
If test fail - Need to direct them to the troubleshooting section for fax.

If you cannot hear the dial tone during the Dial Tone Test, contact your telephone service provider.

---

**Printing Fax When Toner Low**

When the toner cartridge is nearly empty, the machine shows the Toner Low message and stops printing. You can set the machine to disregard this message when it appears and to continue printing, even though print quality is not optimal.

1. Press Scroll (← or →) to highlight Fax and then press Select (✓).

2. Press Scroll (← or →) to highlight Allow Toner Low and then press Select (✓).

3. Press Scroll (← or →) to change the setting to On (enable) or Off (disable).

   If you select Off, the received fax cannot be printed until you install a new toner cartridge. However, faxes can be received into memory as long as it allows.
4. Press Cancel (     ) to return to the Standby mode.

---

**Sending a Fax**

**Adjusting the Document Contrast**

Use the Contrast setting to fax your documents lighter or darker.

1. Press Scroll (❮ or ❯) to highlight Fax and then press Select (✓).
2. Press Scroll (✓ or ✗) to highlight Contrast and then press Select (✓).
3. Press Scroll (✓ or ✗) to select the Contrast mode you want and then press Select (✓).
   - Normal works well with standard typed or printed documents.
   - Darker works well with light print or faint pencil markings.
   - Lighter works well with dark print.

**Adjusting the Document Resolution**

Use the Quality setting to improve the output quality of the original or to scan photographs.

1. Press Scroll (❮ or ❯) to highlight Fax and then press Select (✓).
2. Press Scroll (✓ or ✗) to highlight Send Quality and then press Select (✓).
3. Press Scroll (✓ or ✗) to display the mode you want and then press Select (✓).

The document types recommended for the resolution settings are described in the table below.
<table>
<thead>
<tr>
<th>Mode</th>
<th>Recommended for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Documents with normal sized characters.</td>
</tr>
<tr>
<td>Fine</td>
<td>Documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td>Super Fine</td>
<td>Documents containing extremely fine detail. The super fine mode is enabled only if the remote printer also supports the Super Fine resolution. See the notes below.</td>
</tr>
<tr>
<td>Photo</td>
<td>Documents containing shades of gray or photographs.</td>
</tr>
<tr>
<td>Color</td>
<td>Documents with colors. Sending a color fax is enabled only if the remote printer supports color fax reception and you send the fax manually. In this mode, the memory transmission is not available.</td>
</tr>
</tbody>
</table>

**NOTE:** Faxes scanned in Super Fine resolution will transmit at the highest resolution supported by the receiving device.

**Sending a Fax Automatically**

1. Load the document(s) face up with top edge in first into the DADF (Duplex Automatic Document Feeder).

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Adjusting the Document Contrast".

2. Adjust the document contrast and resolution to suit your fax needs.

3. Press Scroll ( or ) to highlight Fax.

4. Enter the remote fax phone number using the number keypad.

   You can use one, two or three-digit speed or group dial numbers. For details, see "Automatic Dialing".

5. Press Start ( ).

6. When the document is loaded from the document glass, the display shows Another Page? on the top line after the document is scanned into the memory. If you have additional pages, remove the scanned page and load the next page from the glass and select Yes. Repeat as necessary.

   After all of the pages are scanned, select No when the display shows Another Page?

7. When the printer establishes contact with the receiving machine, it dials the number and sends the fax.

   **NOTE:** Press Cancel ( ) to cancel the fax job at any time while sending the fax.
Sending a Fax Manually

1. Load the document(s) face up with top edge in first into the DADF.

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Adjusting the Document Contrast".

2. Adjust the document contrast and resolution to suit your fax needs.

3. Press Scroll ( or ) to highlight Fax and then press Select ( ).

4. Press Scroll ( or ) to highlight On Hook Dial and then press Select ( ).

5. Press Select ( ) to select Yes .

6. Enter the remote fax machine's fax number using the number keypad.

7. When you hear a high-pitched fax tone from the remote fax machine, press Start ( ).

   NOTE: Press Cancel ( ) to cancel the fax job at any time while sending the fax.

Confirming Transmissions

When the last page of your document has been sent successfully, the printer beeps and returns to Standby mode.

If something goes wrong while sending your fax, an error message appears on the display. For a listing of error messages and their meanings, see "Clearing LCD Error Messages".

If you receive an error message, press Cancel ( ) to clear the message and try to send the document again.

You can set your printer to print a confirmation report automatically after each fax transmission. For further details, see the MSG Confirm item in "Available Fax Defaults Options".

Automatic Redialing

When the number you have dialed is busy or there is no answer when you send a fax, the printer automatically redials the number every three minutes, up to seven times.

When the display shows Waiting Redial press Select ( ) to redial the number without waiting.
To cancel the automatic redialing, press Cancel ( ).

To change the time interval between redials and the number of redial attempts, see "Available Fax Defaults Options".

**Redialing fax number**

When you want to redial the last fax number you have sent, you can use this feature.

1. Load the document(s) face up with top edge in first into the DADF.

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Adjusting the Document Contrast".

2. Adjust the document contrast and resolution to suit your fax needs.

3. Press Scroll (或其他 ) to highlight Fax and then press Select ( ).

4. Press Scroll (或其他 ) to highlight Redial and then press Select ( ).

5. When the printer establishes contact with the receiving machine, it dials the number and sends the fax.

---

**Receiving a Fax**

⚠️ **NOTE:** The Dell 2335dn MFP can print mono faxes only. If a color formatted fax is received, the data will be automatically changed to mono fax.

**About Receiving Modes**

⚠️ **NOTE:** To use the Ans/Fax mode, attach an answering machine to the extension telephone socket ( ) on the back of your printer.

When the memory is full, the printer can no longer receive any incoming fax. Secure free memory to resume by canceling Priority Fax or printing received faxes.

**Loading Paper for Receiving Faxes**

The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying, except that faxes can only be printed on Letter-, A4-, or Legal-sized paper. For details about loading paper, see "Loading Paper". For details about setting the paper type and size in the tray, see "Setting the Paper Type" and "Setting the Paper Size".
Receiving Automatically in the Fax Mode

Your printer is preset to the fax mode at the factory.

When you receive a fax, the printer answers the call on a specified number of rings and automatically receives the fax.

To change the number of rings, see "Available Fax Defaults Options".

If you want to adjust the ringer volume, see "Setting Sounds".

Receiving Manually in the Tel Mode

You can receive a fax by picking up the handset of the extension phone and then pressing the remote receive code (see "Receive Code"), or by accessing Fax → On Hook Dial → Yes when the bell is ringing (you can hear voice or fax tones from the remote printer) and then pressing Start ( ) on the operator panel.

The printer begins receiving a fax and returns to Standby mode when the reception is completed.

Receiving Automatically in the Ans/Fax Mode

If you are using an answering machine in this mode, attach it to the extension telephone socket ( ) on the back of your printer.

If your printer does not detect a fax tone, the answering machine will take the call. If your printer detects a fax tone, it automatically initiates reception of the fax.

NOTE: If you have set your printer to Ans/Fax mode and your answering machine is switched off, or no answering machine is connected to your machine, your printer may automatically go into Fax mode after a predefined number of rings.

Receiving Manually Using an Extension Telephone

This features works best when you are using an extension telephone connected to the extension telephone socket ( ) on the back of your printer. You can receive a fax from someone you are talking to on the extension telephone without having to go to the fax machine.

When you receive a call on the extension phone and hear fax tones, press the keys *9* (star nine star) on the extension telephone.

The printer receives the document.

Press the buttons slowly in sequence. If you still hear the fax tone from the remote printer, try pressing *9* once again.

*9* is the remote receive code preset at the factory. The first and the last asterisks are fixed, but you can change the middle number to whatever you choose. The code should be one digit. For details on changing the code, see "Available Fax Defaults Options".

Receiving Faxes Using the DRPD Mode
"Distinctive Ring" is a telephone company service which enables a user to use a single telephone line to answer several different telephone numbers. The particular number someone uses to call you on is identified by different ringing patterns, available in combinations of long and short ringing sounds.

Using the Distinctive Ring Pattern Detection feature, your fax machine can "learn" the ring pattern you designate to be answered by the FAX machine. This ringing pattern may be recognized and answered as a FAX call, and all other ringing patterns will be forwarded to the extension telephone or answering machine plugged into the extension telephone socket (فقد) on the back of your printer. You can easily suspend or change Distinctive Ring Pattern Detection at any time.

Before using the Distinctive Ring Pattern Detection option, Distinctive Ring service must be installed on your telephone line by the telephone company. To set up Distinctive Ring Pattern Detection, you may need another telephone line at your location, dial your FAX number from another line.

To set up the DRPD mode:

1. Press Scroll (< or >) to highlight Fax and then press Select (✓).
2. Press Scroll (❖ or ❖) to highlight Fax Defaults and then press Select (✓).
3. Press Scroll (❖ or ❖) to highlight DRPD Mode and then press Select (✓).
   - The LCD displays Waiting Ring.
4. Press Scroll (❖ or ❖) to highlight Set and then press Select (✓).
5. Call your fax number from another telephone. It is not necessary to place the call from a fax machine.
6. When your printer begins to ring, do not answer the call. The printer requires several rings to learn the pattern.
7. When the printer completes learning, the display shows Completed DRPD.
8. Press Cancel (❌) to return to the Standby mode.

When the DRPD feature is set up, the DRPD option is available in the Receive Mode menu. To receive faxes in the DRPD mode, you need to set the menu to DRPD; see "Available Fax Defaults Options".

**NOTE:** DRPD must be set up again if you re-assign your fax number, or connect the printer to another telephone line.

**NOTE:** After DRPD has been set up, call your fax number again to verify that the printer answers with a fax tone. Then call a different number assigned to that same line to ensure the call is forwarded to the extension telephone or answering machine plugged into the extension telephone socket (فقد) on the back of the printer.

**Receiving Faxes in the Memory**

Since your printer is a multi-tasking device, it can receive faxes while performing other tasks. If you receive a fax while you are copying, printing, or run out of paper or toner, your printer stores incoming faxes in the
memory. As soon as you finish copying, printing, or resupply the consumables, the printer automatically prints the fax.

**Automatic Dialing**

**Speed Dialing**

You can store up to 400 frequently dialed numbers in one, two or three-digit speed dial locations (0-399).

**Storing a Number for Speed Dialing**

1. Press **Directory (�)** in the operator panel.

   OR

   Press **Scroll (/octet)** to highlight **Fax** and then press **Select (✓)**.

2. Press **Scroll (/octet)** to highlight **Phone Book** and then press **Select (✓)**.

3. Press **Scroll (/octet)** to highlight **Add Person** and then press **Select (✓)**.

4. Enter a name and then press **Select (✓)**. For details about how to enter names, see "Using the Number Keypad to Enter Characters" .

5. Enter a one, two or three-digit speed dial number between 0-399, using the number keypad and then press **Select (✓)**.

   Or select the location by pressing **Scroll (/octet)** and then press **Select (✓)**.

6. Enter the fax number you want to store using the number keypad and then press **Select (✓)**.

   To insert a pause between numbers, press **Pause (✓)** and a "," appears on the display.

7. To store more fax numbers, repeat steps 3 through 6 .

   OR

   Press **Cancel (✗)** to return to the Standby mode.

**Editing Speed Dial Numbers**
You can edit a specific speed dial number.

1. Press **Directory** ( ) in the operator panel.

   OR

   Press **Scroll** ( or ) to highlight **Fax** and then press **Select** ( ).

2. Press **Scroll** ( or ) to highlight **Phone Book** and then press **Select** ( ).

3. Press **Scroll** ( or ) to highlight **Edit** and then press **Select** ( ).

4. Press **Scroll** ( or ) to highlight **Edit Person** and then press **Select** ( ).

5. Enter the speed dial number you want to edit or select the speed dial number by pressing **Scroll** ( or ) and then press **Select** ( ).

6. Enter the correct fax number you want and then press **Select** ( ).

7. Enter the correct name you want and then press **Select** ( ).

8. If you want to edit another speed dial number, repeat from step 5.

   OR

   Press **Cancel** ( ) to return to the Standby mode.

**Sending a Fax using a Speed Number**

1. Load the document(s) face up with top edge in first into the DADF.

   OR

   Place a single document face down on the document glass.
   
   For details about loading a document, see "Loading an Original Document" .

2. Adjust the document contrast and resolution to suit your fax needs.

3. Press **Scroll** ( or ) to highlight **Fax** and then press **Select** ( ).

4. Press **Scroll** ( ).

5. Press **Scroll** ( or ) to highlight **Enter Number:** and then press **Select** ( ).

6. Enter the speed dial number.
5. For a one-digit speed dial number, press and hold the appropriate digit button.
   For a two-digit speed dial number, press the first digit button and hold the last digit button.
   For a three-digit speed dial number, press the first and second digit buttons and hold the last digit button.

   The corresponding entry's name briefly displays.

7. The document scans into the memory.

   When the document is loaded on the document glass, the LCD display asks if you want to send another page. Select Yes to add more documents or No to begin sending the fax immediately.

8. The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote fax machine answers.

**Group Dialing**

*If you frequently send the same document to several destinations, you can create a group of these destinations and set them under a one, two or three-digit group dial locations. This enables you to use a group dial number setting to send the same document to all the destinations in the group.*

- **NOTE:** You cannot include one group dial number within another group dial number.

**Setting Group Dial**

1. Press **Directory ( )** in the operator panel.

   OR

   Press **Scroll ( or )** to highlight **Fax** and then press **Select ( )**.

2. Press **Scroll ( or )** to highlight **Phone Book** and then press **Select ( )**.

3. Press **Scroll ( or )** to highlight **Add Group** and then press **Select ( )**.

4. Enter a name and then press **Select ( )**.

5. Enter a group number between 0-399 and then press **Select ( )**.

   Or select the location you want by pressing **Scroll ( or )** and then press **Select ( )**.

6. Enter a one, two or three-digit speed number you want to assign to the group and then press **Select ( )**.
6. Or select the location by pressing Scroll ( or ) and then press Select ( ).

7. At the Add Another? prompt, press Select ( ) to enter other speed dial numbers into the group.

   Or, press Scroll ( or ) to display No and then press Select ( ) when you have entered all of the desired numbers.

8. If you want to assign another group, repeat from step 3.

   OR

   Press Cancel ( ) to return to the Standby mode.

**Editing Group Dial Numbers**

You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1. Press Directory ( ) in the operator panel.

   OR

   Press Scroll ( or ) to highlight Fax and then press Select ( ).

2. Press Scroll ( or ) to highlight Phone Book and then press Select ( ).

3. Press Scroll ( or ) to highlight Edit and then press Select ( ).

4. Press Scroll ( or ) to highlight Edit Group and then press Select ( ).

5. Enter the group number you want to edit or select the group number by pressing Scroll ( or ) and then press Select ( ).

6. Edit the name and then press Select ( ).

7. To add a speed dial number, press Select ( ).

   To delete the speed dial number, press Scroll ( or ) to display Delete Person and then press Select ( ).
8. Enter a speed dial number to be added or deleted.

**NOTE:** When you delete the last speed dial in a group, the group itself is deleted.

9. Press Select (✓).

10. If you want to edit another group, repeat from step 4.

    OR

    Press Cancel (x) to return to the Standby mode.

### Sending a Fax Using Group Dialing (Multi-address Transmission)

You can use group dialing for Broadcasting or Delayed transmissions.

Follow the procedure of the desired operation (Broadcasting transmission; see "Sending Broadcasting Faxes", Delayed transmission; see "Sending a Delayed Fax"). When you come to a step in which the display asks you to enter the remote fax number:

- For a one-digit group number, press and hold the appropriate digit button.
- For a two-digit group number, press the first digit button and hold the last digit button.
- For a three-digit speed dial number, press the first and second digit buttons and hold the last digit button.

You can use only one group number for one operation. Then continue the procedure to complete the desired operation.

Your printer automatically scans the document loaded in the DADF or on the document glass into the memory. The printer dials each of the numbers included in the group.

### Searching for a Number in the Memory

There are two ways to search for a number in the memory. You can either scan from A to Z sequentially, or you can search using the first letter of the name associated with the number.

### Searching Sequentially through the Memory

1. Load the document(s) face up with top edge in first into the DADF.

    OR

    Place a single document face down on the document glass.

    For details about loading a document, see "Loading an Original Document".
2. Press Scroll ( <<< or >>> ) to highlight Fax and then press Select ( ✔ ).

3. Press Scroll ( v or v ) to highlight Phone Book and then press Select ( ✔ ).

4. Press Scroll ( v or v ) to highlight Search and then press Select ( ✔ ).

5. Press Scroll ( v or v ) to scroll through the memory until the name and number you want to dial displays. You can search upwards or downwards through the entire memory in alphabetical order, from A to Z.

While searching through the printer’s memory, you can see that each entry is preceded by one of two letters; "S " for speed dial or "G " for group dial number. These letters tell you how the number is stored.

6. When the name and/or the number that you want displays, press Start ( ❡ ) or Select ( ✔ ) to dial.

**Searching with a Particular First Letter**

1. Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document".

2. Press Directory ( DIRECTORY ) in the operator panel.

OR

Press Scroll ( <<< or >>> ) to highlight Fax and then press Select ( ✔ ).

3. Press Scroll ( v or v ) to highlight Phone Book and then press Select ( ✔ ).

4. Press Scroll ( v or v ) to highlight Search and then press Select ( ✔ ).

5. Press the button labeled with the letter you want to search for. A name beginning with the letter displays.

For example, if you want to find the name “MOBILE”, press the 6 button, which is labeled with "MNO".

6. Press Scroll ( v or v ) to display the next name.

7. When the name and/or the number that you want displays, press Start ( ❡ ) or Select ( ✔ ).
Printing a Phonebook List

You can check your automatic dial setting by printing a Phonebook list.

1. Press Directory ( ) in the operator panel.

OR

Press Scroll ( or ) to highlight Fax and then press Select ( ).

2. Press Scroll ( or ) to highlight Phone Book and then press Select ( ).

3. Press Scroll ( or ) to highlight Print and then press Start ( ) or Select ( ).

A list showing your speed dial and group dial entries prints out.

Other Ways to Fax

Sending Broadcasting Faxes

The broadcasting fax feature allows you to send a document to multiple locations. Documents are automatically stored in the memory and sent to a remote station. After transmission, the documents are automatically erased from the memory.

1. Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass.

For details about loading a document, see "Loading an Original Document".

2. Press Scroll ( or ) to highlight Fax and then press Select ( ).

3. Adjust the document contrast and resolution to suit your fax needs.

For details, see "Adjusting the Document Contrast" and "Adjusting the Document Resolution".

4. Press Scroll ( or ) to highlight Broadcast Fax and then press Select ( ).

5. Enter the number of the remote printer using the number keypad.
You can also use one, two, or three-digit speed dial or group dial numbers.

6. Press **Select** (✓) to confirm the number. The display asks you to enter another fax number.

7. Press **Select** (✓) to enter other number.

   Or, press **Scroll** (◀ or ▶) to select **No** and then press **Select** (✓).

8. *If you want to enter more fax numbers, repeat steps 5 and 7.* You can add up to 10 destinations.

   **NOTE:** You cannot use more than one group dial number per broadcast operation.

9. When you finish entering fax numbers, press **Start** (✓).

   The document is scanned into the memory before transmission. The display shows the memory capacity and the number of pages being stored in the memory.

   For documents loaded on the document glass, the display asks if you want to load another page. Select **Yes** to add. Otherwise, select **No**.

10. The printer begins sending the document in the order of the numbers that you have entered.

---

**Sending a Delayed Fax**

You can set your printer to store and then send a fax at a later time.

1. Load the document(s) face up with top edge in first into the DADF.

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Loading an Original Document".

2. Press **Scroll** (◀ or ▶) to highlight **Fax** and then press **Select** (✓).

3. Adjust the document contrast and resolution to suit your fax needs.

   For details, see "Adjusting the Document Contrast" and "Adjusting the Document Resolution".

4. Press **Scroll** (◀ or ▶) to highlight **Delay Fax to:** and then press **Select** (✓).

5. Enter the number of the remote machine using the number keypad.
6. Press Select (✓) to confirm the number on the display. The display asks you to enter another fax number.

7. Press Select (✓) to enter other number.

Or, press Scroll ( or  ) to select No and then press Select (✓).

8. If you want to assign a name to the transmission, enter the name. If not, skip this step.

For details on how to enter the name using the number keypad, see "Using the Number Keypad to Enter Characters".

9. Press Select (✓). The display shows the current time and asks you to enter the start time when the fax is to be sent.

10. Enter the time using the number keypad.

To select AM or PM for a 12-hour format, press the or the button.

When the cursor is not under the AM or PM indicator, pressing the or the button immediately moves the cursor to the indicator.

If you set a time earlier than the current time, the document will be sent at that time the following day.

11. Press Select (✓) when the start time displays correctly.

12. The document is scanned into the memory before transmission. The display shows the memory capacity and the number of pages being stored in memory.

For the document loaded on the document glass, the display asks if you want to load another page. Select Yes to add. Otherwise, select No.

13. The printer returns to the Standby mode. The display reminds you that you are in the Standby mode and that a delayed fax is set.

NOTE: If you want to cancel the delayed transmission, see "Canceling a Scheduled Fax".

### Sending a Priority Fax

Using the Priority Fax feature, a high priority document can be sent ahead of reserved operations. The document is scanned into the memory and transmitted when the current operation is finished. In addition, the priority transmission interrupts a broadcast operation between stations (i.e., when the transmission to station A ends, before transmission to station B begins) or between redial attempts.
1. Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass.

For details about loading a document, see "Adjusting the Document Contrast".

2. Press Scroll (○ or □) to highlight Fax and then press Select (✓).

3. Adjust the document contrast and resolution to suit your fax needs.

   For details, see "Adjusting the Document Contrast" and "Adjusting the Document Resolution".

4. Press Scroll (○ or □) to highlight Priority Fax and then press Select (✓).

5. Enter the number of the remote machine using the number keypad.

   To enter the number, you can use one, two, or three-digit speed dial or group dial numbers.

6. Press Select (✓) to confirm the number on the display.

7. If you want to assign a name to the transmission, enter the name. If not, skip this step.

   For details on how to enter the name using the number keypad, see "Using the Number Keypad to Enter Characters".

8. Press Select (✓).

   The document is scanned into the memory before transmission. The display shows the memory capacity and the number of pages being stored in the memory.

   For the document loaded on the document glass, the display asks if you want to load another page. Select Yes to add. Otherwise, select No.

9. The printer shows the number being dialed and begins sending the document.

Adding Documents to a Scheduled Fax

You can add documents to the delayed transmission previously reserved in your printer’s memory.

1. Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass.
For details about loading a document, see "Adjusting the Document Contrast".

2. Press Scroll (◄ or ►) to highlight Fax and then press Select (✓).

3. Adjust the document contrast and resolution to suit your fax needs.

   For details, see "Adjusting the Document Contrast" and "Adjusting the Document Resolution".

4. Press Scroll (◄ or ►) to highlight Add Pages and then press Select (✓).

   The display shows the jobs reserved in memory.

5. Press Scroll (◄ or ►) until you see the fax job to which you want to add documents to and then press Select (✓).

   The printer automatically stores the documents in the memory, and the display shows the memory capacity and the number of pages.

   For the document loaded on the document glass, the display asks if you want to load another page. Select Yes to add. Otherwise, select No.

6. After storing, the printer displays the numbers of total pages and added pages and then returns to the Standby mode.

**Canceling a Scheduled Fax**

1. Press Scroll (◄ or ►) to highlight Fax and then press Select (✓).

2. Press Scroll (◄ or ►) to highlight Cancel Job and then press Select (✓).

   The display shows the jobs reserved in memory.

3. Press Scroll (◄ or ►) until you see the fax job you want to cancel, and then press Select (✓).

4. When the confirming message displays, press Select (✓).

   The selected job is canceled.

**Fax Forward to E-mail addresses**

You can set the printer to forward all outgoing or incoming faxes to the e-mail addresses.
1. Press Scroll (↖ or ↘) to highlight Setup and then press Select (✓).
2. Press Scroll (↙ or →) to highlight Email Setup and then press Select (✓).
3. Press Scroll (↖ or →) to highlight Email Forward and then press Select (✓).
4. Press Scroll (↙ or →) to highlight Fax Forwarding and then press Select (✓).
5. Select the desired status by pressing Scroll (↖ or →) and then press Select (✓).
   - Off: Enables you to turn this feature off.
   - All Faxes: Enables you to forward both incoming and outgoing faxes to a specified e-mail address.
   - Tx Only: Enables you to forward only outgoing faxes to a specified e-mail address.
   - Rcv Only: Enables you to forward only incoming faxes to a specified e-mail address. When you select this option, you should choose whether the printer prints out the incoming faxes.
6. Press Scroll (↙ or →) to highlight Attachment Type and then press Select (✓).
7. Select the attachment type either TIFF or PDF by pressing Scroll (↖ or →) and then press Select (✓).
8. Press Scroll (↙ or →) to highlight From Address and then press Select (✓).
9. Enter the sender's name and then press Select (✓).
10. Press Scroll (↙ or →) to highlight To Address and then press Select (✓).
11. Press Scroll (↙ or →) to enter the recipient’s email address and then press Select (✓).
12. Press Scroll (↙ or →) to highlight Print Local Copy and then press Select (✓).
   - On: Prints the fax image in your local device after forwarding via email.
   - Off: Enables you to turn this feature off.
13. Press Cancel (✗) to return to the Standby mode.

---

**Additional Features**
Using the Secure Receiving Mode

You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the secure fax mode using the Secure Receive option to restrict printing out received faxes when the printer is unattended. In the secure fax mode, all incoming faxes may go into memory. When the mode turns off, any faxes stored may be printed.

**NOTE:** If the display shows a Memory Full message, your machine cannot receive fax. Delete any documents you no longer need from the memory.

To turn the secure receiving mode on:

1. Press **Scroll** ( or ) to highlight **Setup** and then press **Select** ( )
2. Press **Scroll** ( or ) to highlight **Fax Setup** and then press **Select** ( )
3. Press **Scroll** ( or ) to highlight **Secure Receive** and then press **Select** ( )
4. Press **Select** ( ) when **On** displays.
5. Enter a four-digit passcode you want to use, using the number keypad and then press **Select** ( )
6. Re-enter the passcode again and then press **Select** ( )
7. Press **Cancel** ( ) to return to the Standby mode.

When a fax is received in the secure receiving mode, your printer stores it into memory and displays Secure Receive to let you know that there is a fax stored.

To print received documents:

1. Access the Secure Receive menu by following steps 1 thorough 3 "To turn the secure receiving mode on:"
2. Press **Scroll** ( or ) to highlight **Print** and then press **Select** ( )
3. Enter the four-digit passcode and then press **Select** ( )

The faxes stored in the memory are printed.

To turn the secure receiving mode off:

1. Access the Secure Receive menu by following steps 1 thorough 3 "To turn the secure receiving mode on:"
2. Press **Scroll** (\(\wedge\) or \(\vee\)) to highlight **Off** and then press **Select** (✓). 

3. Enter the four-digit passcode and then press **Select** (✓).

The mode is deactivated and the printer prints all of the faxes which have been stored in memory.

4. Press **Cancel** (✗) to return to the Standby mode.

**Printing Reports**

The following reports are available:

**Printer Settings List**

This list shows the status of the user-selectable options. You may print this list to confirm your changes after changing any settings.

**Operator Panel Menu List**

This report shows information about the menu functions list.

**Phonebook List**

This list shows all of the numbers currently stored in the printer's memory as speed dial and group dial numbers.

You can print this Phonebook list using **Directory** (\(\mathcal{D}\)) on the operator panel; see "Printing a Phonebook List".

**Email Address Book**

This report shows information about the Email address list.

**Out-going Fax Report**

This report shows information about the faxes you recently sent.

**In-coming Fax Report**

This report shows information about the faxes you recently received.

**Scheduled Job Information**

This list shows the documents currently stored for Delayed faxes or Toll Save faxes. The list shows the starting time and the type of operation.
Message Confirmation

This report shows the fax number, the number of pages, the elapsed time of the job, the communication mode, and the communication results.

Junk Fax Number List

This list shows up to 10 fax numbers specified as junk fax numbers by using the Junk Fax Setup menu; see "Advanced Fax Setting Options". When the Junk Fax Setup feature is turned on, incoming faxes from those numbers will be blocked.

This feature recognizes the last 6 digits of the fax number set as a remote machine's ID.

Demo Page

Prints a demo page to ensure that the printer is operating correctly.

PCL or PS Font List

This report shows the PCL or PS font list.

Network Settings

This list shows the status of the network options. You may print this list to confirm your changes after changing any settings.

Email Report

This report shows information about the emails that you have recently sent.

Printing a Report

1. Press Scroll ( ◄ or ► ) to highlight Setup and then press Select ( ).

2. Press Scroll ( ◄ or ► ) to highlight Reports and then press Select ( ).

3. Press Scroll ( ◄ or ► ) to display the report or list that you want to print on the bottom line.
   - Printer Settings : Printer Settings list
   - Op-panel Menu Tree : Menu Tree list
   - Phone Book : Phonebook list
   - Email Address Book : Email Address Book list
   - Out-going Fax : Sent fax report
   - In-coming Fax : Received fax report
Scheduled Jobs: Scheduled job information

MSG Confirm: Message confirmation

Junk fax List: Junk fax number lists

Demo Page: Demo page

PCL Font List: PCL Font list

PS Font List: PS Font list

Network Settings: Network Settings list

Email: Sent e-mail report

4. Press Select (✓).

The selected information prints out.

Using Advanced Fax Settings

Your printer has various user-selectable setting options for sending or receiving faxes. These options are preset at the factory, but you may need to change them. To find out how the options are currently set, print the System Data list. For details about printing the list, see "Printing a Report".

Changing Setting Options

1. Press Scroll (< or > ) to highlight Setup and then press Select (✓).

2. Press Scroll (✓ or ○ ) to highlight Fax Setup and then press Select (✓).

3. Press Scroll (✓ or ○ ) until you see the desired menu item and then press Select (✓).

4. When the option that you want displays, choose the desired status by pressing Scroll (✓ or ○ ) or enter the desired value using the number keypad.

5. Press Select (✓) to save the selection.

6. You can exit from the setup mode at any time by pressing Cancel (✗).

Advanced Fax Setting Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Forward a</td>
<td>You can set the printer to always forward all of the outgoing faxes to the specified destination besides the fax numbers you entered.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Receive Forward a</td>
<td>You can set your printer to forward incoming faxes to another fax number during a specified time period. When a fax arrives at your printer, it is stored in the memory. Then, the printer dials the fax number that you have specified and sends the fax. Select <strong>Off</strong> to turn this feature off. Select <strong>On</strong> to turn this feature on. You can set the number of the remote fax machine to which the faxes are forwarded. You can forward incoming faxes up to 25 fax numbers.</td>
</tr>
<tr>
<td>Toll Save</td>
<td>You can set your printer to store your faxes in memory and to send them at the specified toll-saving time. For details about sending toll save faxes, see &quot;Toll Save Mode&quot;. Select <strong>Off</strong> to turn this feature off. Select <strong>On</strong> to turn this feature on. You can set the start time and date; and the end time and date for toll save mode.</td>
</tr>
<tr>
<td>Junk Fax Setup</td>
<td>Using the Junk Fax Setup feature, the system will not accept faxes sent from remote stations. Their numbers are stored in the memory as junk fax numbers. This feature is useful for blocking any unwanted faxes. Select <strong>Off</strong> to turn the feature off. Anybody can send you a fax. Select <strong>On</strong> to turn the feature on. You can set up to 10 fax numbers as junk fax numbers. After storing the numbers, you do not receive any faxes from the registered stations.</td>
</tr>
<tr>
<td>Secure Receive</td>
<td>You can keep your received faxes from being accessed by unauthorized people. For further details about setting this mode, see &quot;Using the Secure Receiving Mode&quot;.</td>
</tr>
<tr>
<td>Prefix Dial</td>
<td>You can set a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful for accessing the PABX exchange.</td>
</tr>
<tr>
<td>Stmp Rcvd Name</td>
<td>This option allows the printer to automatically print the page number, and the date and time of the reception at the bottom of each page of a received document. Select <strong>Off</strong> to turn this feature off. Select <strong>On</strong> to turn this feature on.</td>
</tr>
<tr>
<td>ECM Mode</td>
<td>The Error Correction Mode helps with poor line quality and ensures that faxes are sent smoothly to any other ECM-equipped fax machine. <em>If the line quality is poor, it takes more time to send a fax when you are using the ECM mode.</em> Select <strong>Off</strong> to turn this feature off. Select <strong>On</strong> to turn this feature on.</td>
</tr>
</tbody>
</table>

Select **Off** to turn this feature off. Select **On** to turn this feature on.
Select the maximum modem speed you want if the phone line fails to sustain a higher modem speed. You can select 33.6, 28.8, 14.4, 12.0, 9.6, or 4.8 kbps.

Frequently used functions are gathered for users to set fax settings easily.

You can set the printer to forward all outgoing or incoming faxes to specified e-mail addresses. Refer to "Fax Forward to E-mail addresses".

Using an Answering machine

You can connect a telephone answering device (TAD) directly to the back of your printer as shown in Figure 1.

Set your printer to Ans/Fax mode and set the Ring To Answer to a digit greater than the Rings to Answer setting for the TAD.

- When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts receiving the fax.
- If the answering device is off, the printer automatically goes into Fax mode after a predefined number of rings.
- If you answer the call and hear fax tones, the printer will answer the fax call if you access Fax → On Hook Dial → Yes and press Start ( ) and then hang up the receiver, or press the remote receive code *9* and hang up the receiver.

Using a Computer Modem
If you want to use your computer modem for faxing or for a dial-up internet connection, connect the computer modem directly to the back of your printer with the TAD as shown here in Figure 2.

- Set your printer to Ans/Fax mode and set the Ring To Answer to a digit greater than the rings to answer setting for the TAD.
- Turn off the computer modem's fax-receive feature.
- Do not use the computer modem if your printer is sending or receiving a fax.
- To fax via the computer modem, follow the instructions provided with your computer modem and fax application.
- You can capture images using your printer and Dell ScanDirect and send them using your fax application with the computer modem.

---

**Sending a fax from a Computer**

You can send a fax from your Computer without going to the printer. To send a fax from your Computer, install the PC-Fax software and customize the software’s settings.

---

**Installing PC-Fax Software**
Select **Custom Installation** when you install the Dell software and click the **PC-Fax** box. For details, see "Installing Software in Microsoft® Windows® Operating System".

### Customizing Fax Settings

1. From the **Start** menu, select **Programs** ➔ **Dell Printers** ➔ **Dell 2335dn MFP** ➔ **Configure PC Fax**.

![Customizing Fax Settings](image)

2. Enter your name and fax number.

   *If you want to skip cover page*, check **Skip Cover Page**.

3. Select the address book you will use.

   **NOTE:** If you **MS Office Outlook** and **Windows Address Book** are installed on your computer, **Select Address Book** field will be activated.

4. Select the multi-function printer to be used by choosing **Local** or **Network**.

   *If you select **Network**, click **Browse** and search or enter IP address the printer you will use.*

5. Click **OK**.

### Sending a fax from your Computer

1. Open the document to be sent.
2. Select **Print** from the **File** menu.

   The **Print** window is displayed. It may look slightly different depending on your application.

3. Select **Dell 2335 Fax** from the **Print** window.
4. Click **Print** or **OK**.

5. Compose the cover page and click **Continue**.

6. Enter the recipients' numbers and click **Continue**.

*If you want to skip cover page*, check **Skip Cover Page**.
7. Select the resolution and click **Send Fax**.

*If you want to notify on fax delivery*, check **Notify on delivery**.

*NOTE:* This function is available only when using network.

Your computer begins to send the fax data and printer sends the fax.

---

**Fax data back-up**

The Dell 2335dn MFP has 4 MB (Approx. 200 pages at ITU-T #1 Chart) back-up memory.

If there are no paper or no toner left during the fax receiving, the received fax data cannot be printed. In this case, the machine automatically saves fax data in the back-up memory. But, if the machine fails to complete the receiving fax, the rest of the fax data will not be saved the memory.
Macintosh

- Installing Software for Macintosh
- Setting Up the Printer
- Printing
- Scanning

Your printer supports Macintosh systems with a built-in USB interface or 10/100 Base-TX network interface card. When you print a file from a Macintosh computer, you can use the PostScript driver by installing the PPD file.

## Installing Software for Macintosh

The **DRIVERS AND UTILITIES CD** that came with your printer provides you with the PPD file that allows you to use the PostScript driver, for printing on a Macintosh computer.

Verify the following before you install the printer software:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Requirements</th>
<th>RAM</th>
<th>Free Disk Space</th>
</tr>
</thead>
</table>
| Mac OS X 10.4 or lower  | * Power PC G4/G5  
* Intel processors                                                                 | 128 MB for a Power PC based MAC (512 MB)  | 1 GB            |
| Mac OS X 10.5     | * 867MHz or faster Power PC G4/G5  
* Intel processors                                                                 | 512 MB (1 GB)                            | 1 GB            |
| Mac OS X 10.6     | * Intel processors                                                                                  | 1 GB (2 GB)                              | 1 GB            |

### Install the printer driver

1. Ensure that you connect your printer to the computer. Turn on your computer and printer.
2. Insert the **DRIVERS AND UTILITIES CD** which came with your printer into the CD-ROM drive.
3. Double-click **CD-ROM icon that appears** on your Macintosh desktop.
4. Double-click the **MAC_Installer** folder.
5. Double-click the **MAC_Printer** folder.
6. Double-click the **Dell Laser MFP Installer** icon.
7. Enter the password and click **OK**.
8. Click **Continue**.
9. Select **Easy Install** and then click **Install**.
10. After the installation is finished, click **Quit**.

**UnInstall the printer driver**

1. Insert the *DRIVERS AND UTILITIES CD* which came with your printer into the CD-ROM drive.
2. Double-click **CD-ROM icon** that appears on your Macintosh desktop.
3. Double-click the **MAC_Installer** folder.
4. Double-click the **MAC_Printer** folder.
5. Double-click the **Dell Laser MFP Installer** icon.
6. Enter the password and click **OK**.
7. Click **Continue**.
8. Click **Uninstall** and then click **Uninstall**.
9. After the uninstallation is finished, click **Quit**.

**Install the Scan driver**

1. Ensure that you connect your printer to the computer. Turn on your computer and printer.
2. Insert the *DRIVERS AND UTILITIES CD* which came with your printer into the CD-ROM drive.
3. Double-click **CD-ROM icon** that appears on your Macintosh desktop.
4. Double-click the **MAC_Installer** folder.
5. Double-click the **MAC_Twain** folder.
6. Double-click the Installer icon.
7. Enter the password and click **OK**.
8. Click **Continue**.
9. Click **Install**.
10. After the installation is finished, click Quit.

**UnInstall the scan driver**

1. Insert the *DRIVERS AND UTILITIES CD* which came with your printer into the CD-ROM drive.
2. Double-click CD-ROM icon that appears on your Macintosh desktop.
3. Double-click the MAC_Installer folder.
4. Double-click the MAC_Twain folder.
5. Double-click the Installer icon.
6. Enter the password and click OK.
7. Click Continue.
8. Click Uninstall and then click Uninstall.
9. After the uninstallation is finished, click Restart.

---

**Setting Up the Printer**

Set up for your printer will be different depending on which cable you use to connect the printer to your computer-the network cable or the USB cable.

**For a Network-connected Macintosh**

1. Follow the instructions on "Installing Software for Macintosh" to install the PPD and Filter files on your computer.
2. Open the Applications folder ➔ Utilities, and Print Setup Utility.

   For MAC OS 10.5~10.6, open System Preferences from the Applications folder, and click Print & Fax.
3. Click Add on the Printer List.

   For MAC OS 10.5~10.6, press the "+ " icon then a display window will pop up.
4. For MAC OS 10.3, select the IP Printing tab.

   For MAC OS 10.4, click IP Printer.

   For MAC OS 10.5~10.6, click IP.
5. Enter the printer's IP address in the **Printer Address** field.

For MAC OS 10.5~10.6, enter the printer's IP address in the **Address** field.

6. Enter the queue name in the **Queue Name** field. *If you cannot determine the queue name for your printer server, try using the default queue first.*

For MAC OS 10.5~10.6, enter the queue name in the **Queue** field.

7. For MAC OS 10.3, if Auto Select does not work properly, select **Dell** in **Printer Model** and **your printer name** in **Model Name**.

For MAC OS 10.4, if Auto Select does not work properly, select **Dell** in **Print Using** and **your printer name** in **Model**.

For MAC OS 10.5, if Auto Select does not work properly, select **Select a driver to use...** and **your printer name** in **Print Using**.

For MAC OS 10.6, if Auto Select does not work properly, select **Select Printer Software...** and **your printer name** in **Print Using**.

8. Click **Add**.

9. Your printer's IP address appears on the **Printer List**, and is set as the default printer.

---

**For a USB-connected Macintosh**

1. Follow the instructions on "Installing Software for Macintosh" to install the PPD and Filter files on your computer.

2. Open the **Applications** folder → **Utilities**, and **Print Setup Utility**.

   For MAC OS 10.5~10.6, open **System Preferences** from the **Applications** folder, and click **Print & Fax**.

3. Click **Add** on the **Printer List**.

   For MAC OS 10.5~10.6, press the "+" icon then a display window will pop up.

4. For MAC OS 10.3, select the **USB** tab.

   For MAC OS 10.4, click **Default Browser** and find the USB connection.

   For MAC OS 10.5~10.6, click **Default** and find the USB connection.

5. For MAC OS 10.3, if Auto Select does not work properly, select **Dell** in **Printer Model** and **your printer name** in **Model Name**.

   For MAC OS 10.4, if Auto Select does not work properly, select **Dell** in **Print Using** and **your printer name** in **Model**.
For MAC OS 10.5, if Auto Select does not work properly, select **Select a driver to use...** and **your printer name** in **Print Using**.

For MAC OS 10.6, if Auto Select does not work properly, select **Select Printer Software...** and **your printer name** in **Print Using**.

6. Click **Add**.

Your printer appears on the **Printer List**, and is set as the default printer.

---

## Printing

### Printing a Document

When you print with a Macintosh, you need to check the printer software setting in each application you use. Follow these steps to print from a Macintosh.

1. Open a Macintosh application and select the file you want to print.
2. Open the **File** menu and click **Page Setup** (**Document Setup** in some applications).
3. Choose your paper size, orientation, scaling, and other options and click **OK**.

![Page Setup in Mac OS 10.4](image)

4. Open the **File** menu and click **Print**.
5. Choose the number of copies you want and indicate which pages you want to print.
6. Click **Print** when you finish setting the options.

---

## Changing Printer Settings
You can use advanced printing features when using your printer.

From your Macintosh application, select **Print** from the **File** menu.

**Layout Setting**

The **Layout** tab provides options to adjust how the document appears on the printed page. You can print multiple pages on one sheet of paper.

Select **Layout** from the **Presets** drop-down list to access the following features. For details, see "Printing Multiple Pages on One Sheet of the Paper" and "Duplex Printing".

---

**Printing Multiple Pages on One Sheet of Paper**

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way to print draft pages.

1. From your Macintosh application, select **Print** from the **File** menu.
2. Select **Layout**.
3. Select the number of pages you want to print on one sheet of paper on the **Pages per Sheet** drop-down list.

4. Select the page order from the **Layout Direction** option.

   To print a border around each page on the sheet, select the option you want from the **Border** drop-down list.

5. Click **Print**, and the printer prints the selected number of pages on one side of each page.

---

**Duplex Printing**

You can print on both sides of the paper. Before printing in the duplex mode, decide on which edge you will be binding your finished document. The binding options are:

- **Long-Edge Binding** : Conventional layout used in book binding.
- **Short-Edge Binding** : Type often used with calendars.

⚠️ **CAUTION:** *If you have selected duplex printing and then try to print multiple copies of a document,* the printer may not print the document in the way you want. In case of "Collated copy", if your document has odd pages, the last page of the first copy and the first page of the next copy will be printed on the front and back of one sheet. In case of "Uncollated copy", the same page will be printed on the front and back of one sheet. Therefore, if you need multiple copies of a document and you want those copies on both sides of the paper, you must print them one at a time, as separate print jobs.

1. From your Macintosh application, select **Print** from the **File** menu.

2. Select the **Layout**.

3. Select a binding orientation from **Two Sided Printing** option.

4. Click **Print** and the printer prints on both sides of the paper.
Printer Features Setting

The **Printer Features** tab provides options for selecting the paper type and adjusting print quality.

Select **Printer Features** from the drop-down list to access the following features:

- **Reverse Duplex Printing**
  Allows you to select general print order compared to duplex print order.

- **Fit to Page**
  This printer feature allows you to scale your print job to any selected paper size regardless of the digital document size. This can be useful when you want to check fine details on a small document.

- **Paper Type**
  Ensure that **Paper Type** is set to **Printer Default**. *If you load a different type of print material, select the corresponding paper type.*

- **Resolution**
  You can select the printing resolution. The higher the setting, the sharper the clarity of printed characters and graphics. The higher setting also may increase the time it takes to print a document.

Scanning

You can scan documents using **Image Capture**. Macintosh OS offers **Image Capture**.

1. Ensure that your machine and computer are turned on and properly connected to each other.
2. Load the document(s) face up into the DADF.

   OR

   Place a single document face down on the document glass.

   For details about loading a document, see "Loading an Original Document".


   **NOTE:** If No Image Capture device connected message appears, disconnect the USB cable and reconnect it. If the problem persists, please refer to the Image Capture's help.

4. Set the scan options on this program.

5. Scan and save your scanned image.

   **NOTE:** For more information about using Image Capture, please refer to the Image Capture's help.

   **NOTE:** You can also using TWAIN-compliant software, such as Adobe® Photoshop®.

   **NOTE:** Scan process differ according to TWAIN-compliant software. Please refer to the user's guide of the software.

   **NOTE:** When scanning does not operate, update Mac OS to the latest version. Scanning operates properly in Mac OS 10.3.9 or higher and Mac OS 10.4.7 or higher.
Linux

- Getting Started
- Installing the MFP Driver
- Using the Unified Driver Configurator
- Configuring Printer Properties
- Printing a Document
- Scanning a Document

---

**Getting Started**

The supplied *DRIVERS AND UTILITIES CD* provides you with Dell's MFP driver package for using your printer with a Linux computer.

Dell's MFP driver package contains printer and scanner drivers, providing the ability to print documents and scan images. The package also delivers powerful applications for configuring your printer and further processing of the scanned documents.

After the driver is installed on your Linux system, the driver package enables you to monitor a number of MFP devices via USB port. The acquired documents can then be edited, printed on the same local MFP or network printers, sent by e-mail, uploaded to an FTP site, or transferred to an external OCR system.

The MFP driver package is supplied with a smart and flexible installation program. You do not need to search for additional components that might be necessary for the MFP software: all required packages will be carried onto your system and installed automatically; this is possible on a wide set of the most popular Linux clones.

---

**Installing the MFP Driver**

**System Requirements**

**Supported OS**

- RedHat Enterprise Linux WS 4, 5 (32/64bit)
- Fedora Core 1~7 (32/64bit)
- Mandrake 9.2 (32bit), 10.0, 10.1 (32/64bit)
- Mandriva 2005, 2006, 2007 (32/64bit)
- SuSE Linux 8.2, 9.0, 9.1 (32bit)
- SuSE Linux 9.2, 9.3, 10.0, 10.1, 10.2 (32/64bit)
- SuSE Linux Enterprise Desktop 9, 10 (32/64bit)
- Ubuntu 6.06, 6.10, 7.04 (32/64bit)
- Debian 3.1, 4.0 (32/64bit)

**Recommended Hardware Requirements**

- Pentium IV 2.4 GHz or higher (Intel Core2)
- RAM 512 MB or higher
- Free HDD space required: 1 GB or higher

**NOTE:** It is also necessary to claim swap partition of 300 MB or larger for working with large scanned images.

**NOTE:** The Linux scanner driver supports the optical resolution at maximum.

**Software**

- Linux Kernel 2.4 or higher
- Glibc 2.2 or higher
- CUPS
- SANE

**Installing the MFP Driver**

1. Ensure that you connect your multi-function to your computer. Turn both the computer and the printer on.
2. When the Administrator Login window appears, type in root in the Login field and enter the system password.

**NOTE:** You must log in as a super user (root) to install the printer software. If you are not a super user, ask your system administrator.

1. Insert the *DRIVERS AND UTILITIES CD*. The *DRIVERS AND UTILITIES CD* will automatically run.
If the printer driver CD does not automatically run, click the icon at the bottom of the desktop. When the Terminal screen appears, type in:

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost root]#/install.sh

If you still failed to run the CD-ROM, type the followings in sequence:

[root@localhost root]#umount /dev/hdc
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom

**NOTE:** The installation program runs automatically if you have an autorun software package installed and configured.

2. Click **Install**.

3. When the welcome screen appears, click **Next**.

4. Installation is started. When the installation is almost complete, the Add printer wizard appears automatically. Click **Next**.
5. If you connect your printer using the USB cable, the following window appears. Select your printer from the drop-down list and click **Next**.

OR

If you connect your printer using the network cable, the following window appears.
Check the **Network printer**, and select your printer from the drop-down list. Click **Next**.

6. If you connect your printer using the USB cable, you should choose a port you will use with your printer. After choosing the port, click **Next**.
OR

If you connect your printer using the network cable, skip to the next step.

7. Select the driver and click **Next**.

8. Enter your printer’s name, location, description and click **Next**.

9. Click **Finish** to complete installation.
10. When the following window appears, click **Finish**.

The installation program has added the **Unified Driver Configurator** desktop icon and Dell MFP group to the system menu for your convenience. *If you have any difficulties*, consult the onscreen help that is available through your system menu or can otherwise be called from the driver package windows applications, such as **Unified Driver Configurator** or Image Editor.

**Uninstalling the MFP Driver**

1. When the Administrator Login window appears, type in root in the Login field and enter the system password.

**NOTE:** You must log in as a super user (root) to install the printer software. *If you are not a super user*, ask your system administrator.
2. Insert the DRIVERS AND UTILITIES CD. The DRIVERS AND UTILITIES CD will automatically run.

If the DRIVERS AND UTILITIES CD does not automatically run, click the icon at the bottom of the desktop. When the Terminal screen appears, type in:

```
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost root]#. /uninstall.sh
```

**NOTE:** The installation program runs automatically if you have an autorun software package installed and configured.

3. Click **Uninstall**.

4. Click **Next**.

5. Click **Finish**.

---

### Using the Unified Driver Configurator

**Unified Driver Configurator** is a tool primarily intended for configuring MFP devices. Since an MFP device combines the printer and scanner, the Unified Driver Configurator provides options logically grouped for printer and scanner functions. There is also a special MFP port option responsible for the regulation of access to an MFP printer and scanner via a single I/O channel.

After installing the MFP driver, the Unified Driver Configurator icon will automatically be created on your desktop.

**Opening the Unified Driver Configurator**
1. Double-click **Unified Driver Configurator** on the desktop.

   You can also click the Startup Menu icon and select **Dell MFP** and then **Unified Driver Configurator**.

2. Press each button on the Modules pane to switch to the corresponding configuration window.

![Unified Driver Configurator](image)

   You can use the onscreen help by clicking **Help**.

3. After changing the configurations, click **Exit** to close the Unified Driver Configurator.

**Printers Configuration**

Printers configuration has the two tabs; **Printers** and **Classes**.

**Printers Tab**

You can see the current system's printer configuration by clicking on the printer icon button on the left side of the Unified Driver Configurator window.
You can use the following printer control buttons:

- **Refresh**: renews the available printers list.
- **Add Printer**: allows you to add a new printer.
- **Remove Printer**: removes the selected printer.
- **Set as Default**: sets the current printer as a default printer.
- **Stop/Start**: stops/starts the printer.
- **Test**: allows you to print a test page to check if the machine is working properly.
- **Properties**: allows you to view and change the printer properties. For details, see "Configuring Printer Properties".

**Classes Tab**

The Classes tab shows a list of available printer classes.
- **Refresh**: Renews the classes list.
- **Add Class**: Allows you to add a new printer class.
- **Remove Class**: Removes the selected printer class.

**Scanners Configuration**

In this window, you can monitor the activity of scanner devices, view a list of installed Dell MFP devices, change device properties, and scan images.
- **Properties...**: Allows you to change the scan properties and scan a document. See "Scanning a Document".

- **Drivers...**: Allows you to monitor the activity of the scan drivers.

### MFP Ports Configuration

In this window, you can view the list of available MFP ports, check the status of each port and release a port that is stalled in busy state when its owner is terminated for any reason.

![MFP Ports Configuration](image)

- **Refresh**: Renews the available ports list.
- **Release port**: Releases the selected port.

### Sharing Ports Between Printers and Scanners

Your printer may be connected to a host computer via the parallel port or USB port. Since the MFP device contains more than one device (printer and scanner), it is necessary to organize proper access of "consumer" applications to these devices via the single I/O port.

The Dell MFP driver package provides an appropriate port sharing mechanism that is used by Dell printer and scanner drivers. The drivers address their devices via so-called MFP ports. The current status of any MFP port can be viewed via the MFP Ports Configuration. The port sharing prevents you from accessing one functional block of the MFP device, while another block is in use.

When you install a new MFP printer onto your system, it is strongly recommended you do this with the
Configuring Printer Properties

Using the properties window provided by the Printers configuration, you can change the various properties for your machine as a printer.

1. Open the Unified Driver Configurator.

   *If necessary, switch to Printers configuration.*

2. Select your printer on the available printers list and click **Properties**.

3. The Printer Properties window opens.

   ![Printer Properties Window]

   The following five tabs display at the top of the window:

   - **General**: allows you to change the printer location and name. The name entered in this tab displays on the printer list in Printers configuration.
   - **Connection**: allows you to view or select another port. *If you change the printer port from USB to parallel or vice versa while in use, you must re-configure the printer port in this tab.*
   - **Driver**: allows you to view or select another printer driver. By clicking **Options**, you can set the default device options.
   - **Jobs**: shows the list of print jobs. Click **Cancel Job** to cancel the selected job and select the **Show completed jobs** check box to see previous jobs on the job list.
   - **Classes**: shows the class that your printer is in. Click **Add to Class** to add your printer to a specific class or click **Remove from Class** to remove the printer from the selected class.

4. Click **OK** to apply the changes and close the Printer Properties Window.
Printing a Document

Printing from Applications

There are a lot of Linux applications that you are allowed to print from using Common UNIX Printing System (CUPS). You can print on your machine from any such application.

1. From the application you are using, select **Print** from the **File** menu.

2. Select **Print** directly using **lpr**.

3. In the LPR GUI window, select the model name of your machine from the Printer list and click **Properties**.

4. Change the printer and print job properties.
The following four tabs display at the top of the window.

- **General**: allows you to change the paper size, the paper type, and the orientation of the documents, enables the duplex feature, adds start and end banners, and changes the number of pages per sheet.

- **Text**: allows you to specify the page margins and set the text options, such as spacing or columns.

- **Graphics**: allows you to set image options that are used when printing images/files, such as color options, image size, or image position.

- **Device**: allows you to set the print resolution, paper source, and destination.

5. Click **OK** to apply the changes and close the Properties window.

6. Click **OK** in the LPR GUI window to start printing.

7. The Printing window appears, allowing you to monitor the status of your print job.

   To abort the current job, click **Cancel**.

### Printing Files

You can print many different types of files on the Dell MFP device using the standard CUPS way - directly from the command line interface. The CUPS lpr utility allows you to do that. But the drivers package replaces the standard lpr tool by a much more user-friendly LPR GUI program.

To print any document file:

1. Type `lpr <file_name>` from the Linux shell command line and press **Enter**. The LPR GUI window appears.
When you type only lpr and press **Enter**, the Select file(s) to print window appears first. Just select any files you want to print and click **Open**.

2. In the LPR GUI window, select your printer from the list, and change the printer and print job properties.

   For details about the properties window, see "Printing a Document".

3. Click **OK** to start printing.

---

**Scanning a Document**

You can scan a document using the Unified Driver Configurator window.

1. Double-click the Unified Driver Configurator on your desktop.

2. Click the button to switch to Scanners Configuration.

3. Select the scanner on the list.

When you have only one MFP device and it is connected to the computer and turned on, your scanner appears on the list and is automatically selected.

*If you have two or more scanners attached to your computer,* you can select any scanner to work at any time. For example, while acquisition is in progress on the first scanner, you may select the second scanner, set the device options and start the image acquisition simultaneously.
NOTE: The scanner name shown in Scanners configuration can be different from the device name.

4. Click **Properties**.

5. Load the document to be scanned face up into the DADF or face down on the document glass.

6. Click **Preview** in the Scanner Properties window.

The document is scanned and the image preview appears in the Preview Pane.

7. Change the scan options in the Image Quality and Scan Area sections.

   - **Image Quality**: allows you to select the color composition and the scan resolution for the image.
   
   - **Scan Area**: allows you to select the page size. The **Advanced** button enables you to set the page size manually.

   If you want to use one of the preset scan option settings, select from the Job Type drop-down list. For details about the preset Job Type settings, see "Adding Job Type Settings".

   You can restore the default setting for the scan options by clicking **Default**.

8. When you have finished, click **Scan** to start scanning.

   The status bar appears on the bottom left of the window to show you the progress of the scan. To cancel scanning, click **Cancel**.

9. The scanned image appears in the new Image Manager window.
If you want to edit the scanned image, use the toolbar. For further details about editing an image, see "Using the Image Editor".

10. When you are finished, click **Save** on the toolbar.
11. Select the file directory where you want to save the image and enter the file name.
12. Click **Save**.

**Adding Job Type Settings**

You can save your scan option settings to retrieve for a later scanning.

To save a new Job Type setting:

1. Change the options from the Scanner Properties window.
2. Click **Save As**.
3. Enter the name for your setting.
4. Click **OK**.

Your setting is added to the Saved Settings drop-down list.

To save a Job Type setting for the next scan job:

1. Select the setting you want to use from the Job Type drop-down list.
2. Click **Save**.
The next time you open the Scanner Properties window, the saved setting is automatically selected for the scan job.

To delete a Job Type setting:
1. Select the setting you want to delete from the Job Type drop-down list.
2. Click Delete.

The setting is deleted from the list

**Using the Image Editor**

The Image Manager window provides you with menu commands and tools to edit your scanned image.

You can use the following tools to edit the image:
<table>
<thead>
<tr>
<th>Tools</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save]</td>
<td>Saves the image.</td>
</tr>
<tr>
<td>![Cancel]</td>
<td>Cancels your last action.</td>
</tr>
<tr>
<td>![Restore]</td>
<td>Restores the action you canceled.</td>
</tr>
<tr>
<td>![Zoom Out]</td>
<td>Zooms the image out.</td>
</tr>
<tr>
<td>![Zoom In]</td>
<td>Zooms the image in.</td>
</tr>
<tr>
<td>![Scroll]</td>
<td>Allows you to scroll through the image.</td>
</tr>
<tr>
<td>![Crop]</td>
<td>Crops the selected image area.</td>
</tr>
<tr>
<td>![Scale]</td>
<td>Allows you to scale the image size; you can enter the size manually, or set the rate to scale proportionally, vertically, or horizontally.</td>
</tr>
<tr>
<td>![Rotate]</td>
<td>Allows you to rotate the image; you can select the number of degrees from the drop-down list.</td>
</tr>
<tr>
<td>![Flip]</td>
<td>Allows you to flip the image vertically or horizontally.</td>
</tr>
<tr>
<td>![Brightness]</td>
<td>Allows you to adjust the brightness or contrast of the image, or to invert the image.</td>
</tr>
<tr>
<td>![Properties]</td>
<td>Shows the properties of the image.</td>
</tr>
</tbody>
</table>

For further details about the Image Manager program, refer to the onscreen help.
Maintenance

- Clearing the printer NVRAM
- Backing up Data
- Cleaning Your Printer
- Maintaining the Toner Cartridge
- Replacement parts
- Ordering Supplies

---

Clearing the printer NVRAM

⚠️ CAUTION: Before clearing the memory, make sure that all fax jobs have been completed, or you will lose those jobs.

You can selectively clear information stored in your printer’s memory.

1. Press Scroll ( < or > ) to highlight Setup and then press Select ( ✓ ).
2. Press Scroll ( ▲ or ▼ ) to highlight Restore Options and then press Select ( ✓ ).
3. Press Scroll ( ▲ or ▼ ) until you see the item you want to clear.
   - **Printer Setup**: Clears all of the data stored in the memory and resets all of your settings to the factory default.
   - **Paper Setup**: Restores all of the Paper Setting options to the factory default.
   - **Tray Behaviour**: Restores all of the Tray Behavior options to the factory default.
   - **Copy Defaults**: Restores all of the copy options to the factory default.
   - **Fax Settings**
     - **Fax Defaults**: Restores all of the Fax Setup options to the factory default.
     - **Advance Setup**: Restores all of the Advanced Fax setting options to the factory default.
   - **Scan Defaults**: Restores all of the scan options to the factory default.
   - **Sent Report**: Clears all records of your sent faxes.
   - **Rcvd Report**: Clears all records of your received faxes.
4. Press Select ( ✓ ). The selected memory is cleared and the display asks you to continue clearing the next item.
5. Repeat steps 3 and 4 to clear another item.
OR

Press Cancel (X) to return to the Standby mode.

## Backing up Data

Date in the printer's memory can be accidentally erased due to power failure or storage failure. Backup helps you protect your Address Book/Phone Book entries and the system settings by storing them as backup files on a USB memory key.

**NOTE:** In case of the phonebook, you can save the phonebook in csv file format. So that you can confirm or modify the phone list in your computer.

### Backing up Data

1. Insert the USB memory key into the USB memory port on your printer.
2. Press Scroll (< or >) to highlight Setup and then press Select (✓).
3. Press Scroll (✓ or ✓) to highlight Machine Setup and then press Select (✓).
4. Press Scroll (✓ or ✓) to highlight Export Setting and then press Select (✓).

   The data is backed up to the USB memory key.

5. Press Cancel (X) to return to the Standby mode.

### Restoring Data

1. Insert the USB memory key into the USB memory port on your printer.
2. Press Scroll (< or >) to highlight Setup and then press Select (✓).
3. Press Scroll (✓ or ✓) to highlight Machine Setup and then press Select (✓).
4. Press Scroll (✓ or ✓) to highlight Import Setting and then press Select (✓).

   The backup file is restored to the USB memory key.

5. Press Cancel (X) to return to the Standby mode.

## Cleaning Your Printer
To maintain the print quality, follow the cleaning procedures below, each time the toner cartridge is replaced or if print quality problems occur.

**NOTE:** Do not touch the transfer roller located under the toner cartridge when cleaning inside the printer. Oil from your fingers may cause print quality problems.

**CAUTION:** Cleaning solvents that contain alcohol or other strong substances may discolor or crack the printer cabinet.

### Cleaning the Exterior

Clean the printer cabinet with a soft, damp, lint-free cloth. Do not let water drip onto the printer or inside the printer.

### Cleaning the Interior

Paper, toner, and dust particles can accumulate inside the printer and cause print quality problems, such as smearing or toner specks. Clean inside the printer to prevent these problems.

1. Power the printer off and unplug the power cord. Allow a reasonable amount of time for the printer to cool down.

2. Open the front cover and pull the toner cartridge straight out. Set it on a clean flat surface.

   **CAUTION:** To prevent damage, do not expose the toner cartridge to light for more than a few minutes.

   **CAUTION:** Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area.

3. With a dry and lint-free cloth, wipe away any dust and spilled toner from the toner cartridge area and the toner cartridge cavity.
3. **CAUTION:** Do not touch the transfer roller inside the printer. Oil from your fingers may cause print quality problems.

4. Locate the long strip of glass Laser Scanning Unit (LSU) inside the top of the cartridge compartment, and gently swab the glass to see if dirt turns the white cotton black.
5. Reinsert the toner cartridge and close the front cover.

6. Plug in the power cord and power the printer on.

**Cleaning the scanner**

Keeping the scanner and DADF glass clean ensure the highest quality copies, scans, and sent faxes. Dell recommends cleaning the scanner at the start of each day and during the day, as needed.

> **NOTE:** If there are lines present on copied or faxed documents, check your scanner and DADF glass for any particles.

1. Slightly dampen a soft lint-free cloth or paper towel with water.
2. Open the document cover.
3. Wipe the surface of the document glass and DADF glass until it is clean and dry.
NOTE: Documents are moved across the DADF glass. As a result, the DADF glass may need special attention to remove built-up residue.

4. Wipe the underside of the white document cover and white sheet until it is clean and dry.

5. Close the document cover.

---

**Maintaining the Toner Cartridge**

**Storing the Toner Cartridge**

Store the toner cartridge in the original packaging until you are ready to install it.

Do not store the toner cartridge in:

- Temperatures greater than 40° C (104° F)
- An environment with extreme changes in humidity or temperature
- Direct sunlight
- Dusty places
- A car for a long period of time
- An environment where corrosive gases are present
- An environment with salty air

**Redistributing Toner**

When the toner cartridge is near the end of its life, white streaks or light print occurs. The LCD displays the warning message, **Toner Low**. Thoroughly shake the cartridge from side-to-side 5 or 6 times to distribute the toner evenly inside the cartridge and temporarily improve print quality.

This is not intended to be a long term method of correction, but meant to assist your printing needs until you obtain a new cartridge assembly.

1. Open the front cover.

2. Pull the toner cartridge out.
3. Thoroughly shake the cartridge from side-to-side 5 or 6 times to distribute the toner evenly inside the cartridge.

![Shaking Toner Cartridge Image]

**NOTE:** If toner comes into contact with your clothing, wipe the toner off with a dry cloth and wash your clothing in cold water. Hot water sets toner into fabric.

**CAUTION:** Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area.

4. Holding the toner cartridge by the handle and slowly insert the cartridge into the opening in the printer.

5. Tabs on the sides of the cartridge and corresponding grooves within the printer will guide the cartridge into the correct position until it locks into place completely.

![Inserting Toner Cartridge Image]

6. Close the front cover. Ensure that the cover is surely closed.

**Replacing the Toner Cartridge**

When the toner eventually runs out, only blank pages print when a print job or copy job are sent. The LCD displays the warning message, **Toner Almost Empty Replace Toner.** In that case the incoming faxes are
only saved in the memory and not printed. At this stage, the toner cartridge needs to be replaced.

Order an extra toner cartridge so you will have it on hand when the current cartridge no longer prints satisfactorily. See "Ordering Supplies" to order toner cartridges.

⚠️ **CAUTION:** For best results, use Dell toner cartridge. Print quality and printer reliability are not guaranteed if you do not use Dell supplies.

To replace the toner cartridge:

1. Open the front cover.
2. Pull the toner cartridge out.
3. Remove the new toner cartridge from its bag.
4. Remove the packing tape and thoroughly shake the cartridge from side-to-side to distribute the toner.

Save the box and the cover for shipping.

⚠️ **NOTE:** If toner comes into contact with your clothing, wipe the toner off with a dry cloth and wash your clothing in cold water. Hot water sets toner into fabric.
CAUTION: Do not touch the green underside of the toner cartridge. Use the handle on
the cartridge to avoid touching this area.

5. Holding the toner cartridge by the handle and slowly insert the cartridge into the opening in the
printer.

6. Tabs on the sides of the cartridge and corresponding grooves within the printer will guide the cartridge
into the correct position until it locks into place completely.

7. Close the front cover. Ensure that the cover is surely closed.

Cleaning the Drum

If there are streaks or spots on your print, the Organic Photo Conductor (OPC) drum of the toner cartridge
may require cleaning.

1. Before setting the cleaning procedure, ensure that paper is loaded in the paper tray.

2. Press Scroll ( < or > ) to highlight Setup and then press Select ( √ ).

3. Press Scroll ( ▲ or ▼ ) to highlight Maintenance and then press Select ( √ ).

   The first available menu item, Clean Drum, displays.

4. Press Select ( √ ) twice.

   The display confirms your selection.

   The printer prints out a cleaning page. Toner particles on the drum surface are affixed to the paper.

5. If the problem remains, repeat steps 3 through 4 until toner particles are not affixed to the paper.

Replacement parts

From time to time, you need to replace the rollers and fuser unit to maintain top performance and to avoid
print quality problems and paper feed problems resulting from worn parts.

The following items should be replaced after you have printed the specified number of pages.
<table>
<thead>
<tr>
<th>Item</th>
<th>Yield (Average)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DADF rubber pad</td>
<td>Approx. 20,000 pages</td>
</tr>
<tr>
<td>Transfer roller</td>
<td>Approx. 70,000 pages</td>
</tr>
<tr>
<td>Fuser unit</td>
<td>Approx. 80,000 pages</td>
</tr>
<tr>
<td>Tray rubber pad</td>
<td>Approx. 100,000 pages</td>
</tr>
<tr>
<td>Pickup roller</td>
<td>Approx. 150,000 pages</td>
</tr>
</tbody>
</table>

To purchase replacement parts, contact your Dell dealer or the retailer where you bought your printer. We strongly recommend that these items be installed by a trained service professional.

**Ordering Supplies**

You can order supplies using the Dell™ Toner Management System or the Dell Printer Configuration Web Tool.

*If your printer is connected to a network*, type your printer’s IP address in your Web browser and click the toner supplies link.

1. Double-click the Dell 2335dn MFP Toner Reorder icon on your desktop.
2. From the **Start** menu, select **Programs** → **Dell Printers** → **Dell 2335dn MFP** → **Dell 2335dn MFP Toner Reorder**.

   The Order Toner Cartridges window appears.
Go to premier.dell.com or www.premier.dell.com to order supplies online.

*If ordering by phone*, call the number that appears under the Order by Phone heading.

**OR**

3. *If your printer is connected to a network*, type the printer’s IP address in your Web browser to launch the Dell Printer Configuration Web Tool, and click the supplies link.

**NOTE:** Refer to the following table to order toner cartridges.

<table>
<thead>
<tr>
<th>Toner cartridge</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Standard Capacity Toner Cartridge (3,000 pages&lt;sup&gt;a&lt;/sup&gt;)</td>
<td>CR963</td>
</tr>
<tr>
<td>Dell High Capacity Toner Cartridge (6,000 pages)</td>
<td>HX756</td>
</tr>
</tbody>
</table>

<sup>a</sup> ISO standard page coverage in accordance with ISO/IEC 19752 testing methodology.
Clearing Jams in the DADF

When a document jams while it passes through the DADF, **Document Jam** appears on the display.

---

**NOTE:** To prevent document jams, use the document glass for thick, thin or mixed documents.

1. Remove the remaining documents from the DADF.

   *If the document is jammed in the paper feed area:*
   
   a. Open the DADF cover.

   b. Remove the document by gently pulling it out.
c. Close the DADF cover. Then reload the document into the DADF.

*If the document is jammed in the paper exit area:*

a. Open the DADF cover.

b. Open the document input tray upwards and pull the document gently out of the DADF.
c. Remove the document by gently pulling it out.

d. Close the DADF cover and the document input tray. Then load the documents back into the DADF.

*If the document is jammed in the duplex path:*

a. Open the DADF cover.
b. Open the DADF inner cover.

c. Remove the document by gently pulling it out.
d. Close the DADF inner cover and the DADF cover. Then load the documents back into the DADF.

2. If you cannot see the paper or cannot pull the jammed paper out, open the document cover.

3. Remove the document from the feed area by carefully pulling it gently to the right.

4. Close the document cover. Then load the documents back into the DADF.

---

**Clearing Jams in the Paper Tray**

When a paper jam occurs, Paper Jam appears on the display. Refer to the table below to locate and clear the paper jam.
<table>
<thead>
<tr>
<th>Operator Panel Message</th>
<th>Location of Jam</th>
<th>Go to</th>
</tr>
</thead>
</table>
| Paper Jam 0            | Paper Feed Jam (tray 1)  
Paper Feed Jam (optional tray 2) | "Paper Feed Jam (tray 1)" or  
"Paper Feed Jam (optional tray 2)". |
| Open Tray 1            | Fuser Area Jam   | "Fuser Area Jam". |
| Paper Jam 1            | Paper Exit Jam   | "Paper Exit Jam". |
| Remove Cartridge       | Paper Exit Jam   | "Paper Exit Jam". |
| Open Rear Door         | Duplex Jam 0     | "Duplex Jam 0". |
| Remove paper & Open/Close Front Door | between the duplex unit and fuser area | |
| Duplex Jam 1           | in the duplex unit | "Duplex Jam 1". |
| Open Rear Door         |                 |       |

To avoid tearing the paper, pull the jammed paper out gently and slowly. Follow the steps below to clear the jam.

**Paper Feed Jam (tray 1)**

1. Open and close the front cover. The jammed paper automatically exits the printer.
If the paper does not exit, go to the next step.

2. Pull the paper tray open.

   ![Paper Tray Open]

3. Remove the paper by gently pulling it straight out.

   ![Pulling Paper]

   If you cannot see the paper or the paper does not move when pulled, check the fuser area. For more information, see “Fuser Area Jam”.

4. Insert the paper tray into the printer until it snaps into place.

   Printing automatically resumes.

**Paper Feed Jam (optional tray 2)**

1. Pull the optional tray 2 open.

   ![Optional Tray Open]
2. Remove the jammed paper from the printer.

If you cannot see the paper in this area or the paper does not move when pulled, go to the next step.

3. Pull the tray 1 half way out.

4. Pull the paper straight up and out.
5. Insert the trays back into the printer.

Printing automatically resumes.

**MPF Jam**

1. *If the paper is not feeding properly, pull the paper out of the printer.*

2. Open and close the front cover to resume printing.

**Fuser Area Jam**

⚠️ **NOTICE:** The fuser area is hot. Take care when removing paper from the printer.
1. Open the front cover and lightly pull the toner cartridge straight out.

2. Remove the paper by gently pulling it straight out.

3. Replace the toner cartridge and close the front cover.

   Printing automatically resumes.

**Paper Exit Jam**

1. Open and close the front cover. The jammed paper automatically exits the printer.
1. If the paper does not exit, go to the next step.

2. Gently pull the paper out of the output tray.

3. If you cannot see the paper in the output tray or the paper does not move when pulled, open the rear door.

4. If you see the jammed paper, push the two blue pressure levers down and remove the paper. Skip to step 9.
If you do not see the paper, go to the next step.

5. Fully open the rear door, as shown.

6. Unfold the duplex guide fully.
7. While pushing the fuser lever to the right, open the fuser door.

**NOTE:** Ensure that to unfold the duplex guide before opening the fuser door or you may damage the fuser door.

8. Pull the jammed paper out.

*If the jammed paper does not move when you pull, push the two blue pressure levers up to loosen the paper, and then remove it.*

9. Return the levers, fuser door, and duplex guide to their original position.

10. Close the rear door.

11. Open and close the front cover.

Printing automatically resumes.

**Duplex Jam**
**Duplex Jam 0**

1. Pull the duplex unit out of the printer.

2. Remove the jammed paper from the duplex unit.

   *If the paper does not come out with the duplex unit, remove the paper from the bottom of the printer.*

3. Push the duplex unit to the printer.
4. Open and close the front cover.

Printing automatically resumes.

⚠️ **CAUTION:** *If you do not push the duplex unit correctly, paper jam may occur.*

**Duplex Jam 1**

1. Open the rear door.

2. Unfold the duplex guide fully.

3. Pull the jammed paper out.

4. Return the duplex guide and close the rear door.

5. Open and close the front cover.
Printing automatically resumes.

**Tips for Avoiding Paper Jams**

By selecting the correct paper types, most paper jams can be avoided. When a paper jam occurs, follow the steps outlined in "Clearing Jams in the Paper Tray".

- Follow the procedures in "Loading Print Media in the Paper Tray". Ensure that the adjustable guides are correctly positioned.
- Do not overload the paper tray. Ensure that the paper is below the paper capacity mark on the inside wall of the paper tray.
- Do not remove the paper from the tray while your printer is printing.
- Flex, fan and straighten the paper before loading.
- Do not use creased, damp or curled paper.
- Do not mix paper types in the paper tray.
- Use only recommended print materials. See "Paper Specifications".
- Ensure that the recommended print side of print materials is facing down in the paper tray and facing up in the MPF.
- Ensure that the duplex unit is installed correctly.

---

**Clearing LCD Error Messages**

**NOTE:** [xxx] indicates the media type.

**NOTE:** [yyy] indicates the tray.

**NOTE:** [zzz] indicates the paper size.

**NOTE:** Some error messages are provided with graphical images on the LCD of the operator panel.

<table>
<thead>
<tr>
<th>Display message</th>
<th>Meaning</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Rear door. Rear Door is open. Close Rear Door.</td>
<td>The rear door was opened while duplex printing</td>
<td>Close the rear door.</td>
</tr>
<tr>
<td>Data Read Fail Check USB key</td>
<td>Time expired while reading data.</td>
<td>Try again.</td>
</tr>
<tr>
<td>Condition</td>
<td>Description</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Data Write Fail</td>
<td>Storing to the USB memory key failed.</td>
<td>Check the available USB memory space.</td>
</tr>
<tr>
<td>Device is not supported</td>
<td>Non USB mass storage device, such as USB mouse, is connected with USB memory port.</td>
<td>Remove the non USB mass storage device from USB memory port.</td>
</tr>
<tr>
<td>Document Jam</td>
<td>The loaded document has jammed in the DADF.</td>
<td>Clear the document jam. See &quot;Clearing Jams in the DADF&quot;.</td>
</tr>
<tr>
<td>Remove Jam Document</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Door Open Close Toner Door</td>
<td>The front cover is not securely latched.</td>
<td>Close the cover until it locks into place.</td>
</tr>
<tr>
<td>Duplex jam 0</td>
<td>Paper has jammed during duplex printing.</td>
<td>Clear the jam. See &quot;Duplex Jam 0&quot;.</td>
</tr>
<tr>
<td>Remove paper &amp; Open/Closed Front Door</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplex jam 1</td>
<td>Paper has jammed during duplex printing.</td>
<td>Clear the jam. See &quot;Duplex Jam 1&quot;.</td>
</tr>
<tr>
<td>Open Rear Door</td>
<td>You entered an unavailable item.</td>
<td>Enter the correct item again.</td>
</tr>
<tr>
<td>File Format Not Supported</td>
<td>The selected file format is not supported.</td>
<td>Enter the correct item again.</td>
</tr>
<tr>
<td>Fuser Door Open</td>
<td>The fuser door is not securely latched.</td>
<td>Open the rear door and close the fuser door until it locks into place. For the location of the fuser door, see &quot;Paper Exit Jam&quot;.</td>
</tr>
<tr>
<td>Open Rear Door Close Fuser Door</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fuser Error Fuser Not Installed Check Rear Door</td>
<td>There is a problem in the fuser unit.</td>
<td>Unplug the power cord and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>Group Not Available</td>
<td>You have tried to select a group location number where only a single location number can be used, such as when adding locations for a broadcasting operation.</td>
<td>Use a speed dial number or dial the number manually using the number keypad.</td>
</tr>
<tr>
<td>Hub is not supported</td>
<td>USB hub device is connected with USB memory port.</td>
<td>Remove the USB hub device from USB memory port.</td>
</tr>
<tr>
<td>In Idle</td>
<td>The paper in the paper tray</td>
<td>Load paper in the paper tray.</td>
</tr>
<tr>
<td>State: [yyy] Empty/Open In Printing State: [yyy] Empty/Open Load [zzz] [xxx]</td>
<td>has run out.</td>
<td>See &quot;Loading Paper&quot;.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Invalid Cartridge</strong> Cartridge is not valid for this machine</td>
<td>The toner cartridge you have installed is not for your printer.</td>
<td>Install a Dell-genuine toner cartridge, designed for your printer.</td>
</tr>
<tr>
<td><strong>IP Conflict</strong> IP address conflict</td>
<td>The network IP address you have set is being used by someone else.</td>
<td>Check the IP address and reset it if necessary.</td>
</tr>
<tr>
<td><strong>Junk Fax Job Cancelled</strong></td>
<td>The received fax number is the number stored in memory as junk fax number.</td>
<td>Change the Junk Fax Setup option.</td>
</tr>
<tr>
<td><strong>Line Busy</strong> The line is already engaged Try later</td>
<td>The receiving party did not answer or the line is already engaged.</td>
<td>Try again after a few minutes.</td>
</tr>
</tbody>
</table>
| **Line Error** | Your printer cannot connect with a remote printer or has lost contact because of a problem with the phone line.  
OR  
No dial tone sounds. | Try again. *If the problem persists*, please wait for an hour or try a different phone line if possible and then try to connect again.  
OR  
Turn the ECM mode on. See "ECM Mode".  
OR  
Check that the phone line is connected properly. See "Connecting the Telephone Line".  
OR  
Check that the phone socket in the wall is working by plugging in another phone. |
<p>| <strong>Check Fax Line</strong> | | |
| <strong>Line Error</strong> The Fax Line has a problem. Try again. | The printer has a communication problem. | Ask the sender to try again. |
| <strong>Low Heat Error Low Heat Error Power Cycle</strong> | There is a problem in the fuser unit. | Unplug the power cord and plug it back in. <em>If the problem persists</em>, please call for service. |</p>
<table>
<thead>
<tr>
<th>LSU Hsync Error Power Cycle</th>
<th>A problem has occurred in the Laser Scanning Unit (LSU).</th>
<th>Unplug the power cord and plug it back in. <em>If the problem persists, please call for service.</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Size Error Mail exceeds than server support</td>
<td>The mail size is larger than the supported size by SMTP server.</td>
<td>Divide your mail or reduce the resolution.</td>
</tr>
<tr>
<td>Mail Size Error One Page is Too Large</td>
<td>Single page data exceeds the configured mail size.</td>
<td>Reduce the resolution and try again.</td>
</tr>
<tr>
<td>Memory Full Cancel</td>
<td>The memory is full.</td>
<td>Delete unnecessary documents, retransmit after more memory becomes available.</td>
</tr>
<tr>
<td>Memory Full Divide the Job</td>
<td>The memory is full.</td>
<td>Split the transmission into more than one operation.</td>
</tr>
<tr>
<td>Memory Full Fax memory is full. Print received fax job.</td>
<td>The memory is full.</td>
<td>Print received faxes.</td>
</tr>
<tr>
<td>Memory Full Too many faxes are queued to be sent.</td>
<td>The memory is full.</td>
<td>Cancel reserved fax in the Priority Fax feature.</td>
</tr>
<tr>
<td>Memory Full Too many faxes are received. Print received fax job.</td>
<td>The memory is full.</td>
<td>Print received faxes.</td>
</tr>
<tr>
<td>MPF Empty Load [zzz] [xxx] Press Continue</td>
<td>The paper in the MPF has run out.</td>
<td>Load paper in the MPF. See &quot;Using the MPF (Multi purpose feeder)&quot;.</td>
</tr>
<tr>
<td>Network Error There is a problem with the network.</td>
<td>There is a problem with the network.</td>
<td>Contact your network administrator.</td>
</tr>
<tr>
<td>Error Description</td>
<td>Description</td>
<td>Action</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>No Answer</td>
<td>The remote fax machine has not answered after several redial attempts.</td>
<td>Try again. Verify the number to ensure that a fax can be received.</td>
</tr>
<tr>
<td>No Cartridge</td>
<td>The toner cartridge is not installed.</td>
<td>Install the toner cartridge. See &quot;Installing the Toner Cartridge&quot;.</td>
</tr>
<tr>
<td>No such job</td>
<td>You are performing an Add/Cancel operation, but there are no jobs waiting.</td>
<td>Check the display to see if there are any scheduled jobs. The display should indicate if any scheduled jobs are in Standby mode, for example, Delay Fax.</td>
</tr>
<tr>
<td>Over Heat Error</td>
<td>There is a problem in the fuser unit.</td>
<td>Unplug the power cord and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>Paper Jam 0</td>
<td>Paper has jammed in the feeding area of the paper tray.</td>
<td>Clear the jam. See &quot;Paper Feed Jam (tray 1)&quot;, &quot;Paper Feed Jam (optional tray 2)&quot; or &quot;MPF Jam&quot;.</td>
</tr>
<tr>
<td>Open Tray 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove paper &amp; Open/Close Front Door</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Jam 1</td>
<td>Paper has jammed in the fuser area.</td>
<td>Clear the jam. See &quot;Fuser Area Jam&quot;.</td>
</tr>
<tr>
<td>Remove Cartridge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Jam 2</td>
<td>Paper has jammed in the paper exit area.</td>
<td>Clear the jam. See &quot;Paper Exit Jam&quot;.</td>
</tr>
<tr>
<td>Open Rear Door</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Failure</td>
<td>The power has been turned off and then on and the printer’s memory has not been saved.</td>
<td>The printer’s memory was not saved due to a power failure. The job will need to be started over.</td>
</tr>
<tr>
<td>Printer Error</td>
<td>A problem has occurred in the Laser Scanning Unit (LSU).</td>
<td>Unplug the power cord and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>Scanner locked</td>
<td>The scanner module is locked.</td>
<td>Unlock the scanner and press Cancel (X).</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Pull blue latch forward &amp; Press</td>
<td>The engine in your printer is checking some problems detected.</td>
<td>Please wait a few minutes.</td>
</tr>
<tr>
<td>Self Diagnostic</td>
<td>Send Error There is a problem in DNS</td>
<td>Configure the DNS setting.</td>
</tr>
<tr>
<td>Error There is a problem in POP3</td>
<td>The engine in your printer is checking some problems detected.</td>
<td>Please wait a few minutes.</td>
</tr>
<tr>
<td>Send Error There is a problem in SMTP</td>
<td>There is a problem in SMTP.</td>
<td>Change to the available server.</td>
</tr>
<tr>
<td>Error There is a problem in SMTP authentication</td>
<td>There is a problem in SMTP authentication.</td>
<td>Configure the authentication setting.</td>
</tr>
<tr>
<td>Send Error There is a problem on the NIC Card</td>
<td>There is a problem on the network interface card.</td>
<td>Configure your network interface card correctly.</td>
</tr>
<tr>
<td>SMTP Error SMTP Connection has a problem</td>
<td>Connection with the SMTP server failed.</td>
<td>Check that the network cable is connected properly.</td>
</tr>
<tr>
<td>OR</td>
<td></td>
<td>Contact your SMTP server administrator.</td>
</tr>
<tr>
<td>Toner Almost Empty</td>
<td>The toner cartridge is empty.</td>
<td>Replace the toner cartridge with a new one. See &quot;Replacing the Toner Cartridge&quot;.</td>
</tr>
<tr>
<td>Replace Toner</td>
<td>The toner cartridge is almost empty.</td>
<td>Take out the toner cartridge and thoroughly shake it. By doing this, you can temporarily reestablish printing operations.</td>
</tr>
<tr>
<td>OR</td>
<td></td>
<td>Replace the toner cartridge with a new one for the best print quality. See &quot;Replacing the Toner Cartridge&quot;.</td>
</tr>
</tbody>
</table>
### Solving Problems

The following chart lists some conditions that may occur and the recommended solutions. Follow the suggested solutions until the problem is corrected. *If the problem persists*, contact Dell.

## Paper Feeding Problems

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper is jammed during printing.</td>
<td>Clear the paper jam. See &quot;Clearing Jams in the Paper Tray&quot;.</td>
</tr>
</tbody>
</table>
| Paper sticks together.           | - Ensure that there is not too much paper in the paper tray. The paper tray can hold up to 250 sheets of paper, depending on the thickness of your paper.  
- Ensure that you are using the correct type of paper. See "Paper Specifications".  
- Remove paper from the paper tray and flex or fan the paper.  
- Humid conditions may cause some paper to stick together.                                                                                                  |
| Multiple sheets of paper do not feed. | - Different types of paper may be stacked in the paper tray. Load paper of only one type, size and weight.  
- *If multiple sheets have caused a paper jam*, clear the paper jam. See "Clearing Jams in the Paper Tray".                                                                                                   |
| Paper does not feed into the printer. | - Remove any obstructions from inside the printer. See "Cleaning the Interior".  
- Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.  
- There is too much paper in the paper tray. Remove excess paper from the tray.  
- The paper is too thick. Use only paper that meets the specifications required by the printer. See "Paper Specifications".                                                                     |
| The paper keeps jamming.         | - Ensure that the correct paper size is selected. See "Setting the Paper Size".  
- An incorrect type of paper is being used. Use only paper that meets the specifications required by the printer. See "Paper Specifications".  
- There may be debris inside the printer. Open the front cover and remove the debris.                                                                             |
<table>
<thead>
<tr>
<th>Condition</th>
<th>Possible cause</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer does not print.</td>
<td>The printer is not receiving power.</td>
<td>Check the power cord connections. Check the power switch and the power source.</td>
</tr>
<tr>
<td></td>
<td>The printer is not selected as the default printer.</td>
<td>Select <strong>Dell 2335dn MFP</strong> as your default printer in your Windows.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click the <strong>Start</strong> button <strong>Settings → Printers</strong>. Right-click the <strong>Dell 2335dn MFP</strong> printer icon and select <strong>Set as Default Printer</strong>.</td>
</tr>
<tr>
<td></td>
<td>Check the printer for the following:</td>
<td>✷ The front or rear door is not closed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>✷ Paper is jammed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>✷ No paper is loaded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>✷ The toner cartridge is not installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>If a printer system error occurs, contact your service representative.</em></td>
</tr>
<tr>
<td></td>
<td>The connection cable between the computer and the printer is not connected properly.</td>
<td>Disconnect the printer cable and reconnect it.</td>
</tr>
<tr>
<td></td>
<td>The connection cable between the computer and the printer is defective.</td>
<td><em>If possible, attach the cable to another computer that is working properly and print a job. You can also try using a different printer cable.</em></td>
</tr>
<tr>
<td></td>
<td>The printer may be configured incorrectly.</td>
<td>Check the printer properties to ensure that all of the print settings are correct.</td>
</tr>
<tr>
<td></td>
<td>The printer driver may be incorrectly installed.</td>
<td>Remove the printer driver and then reinstall it; see &quot;Uninstalling Software&quot; and &quot;Installing Software in Microsoft® Windows® Operating System&quot; respectively.</td>
</tr>
<tr>
<td></td>
<td>The printer is malfunctioning.</td>
<td>Check the display message on the operator panel to see if the printer is indicating a system error.</td>
</tr>
<tr>
<td>Issue</td>
<td>Potential Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The printer selects print materials from the wrong paper source.</td>
<td>The paper source selection in the printer properties may be incorrect.</td>
<td>For many software applications, the paper source selection is found under the <strong>Paper</strong> tab within the printer properties. Select the correct paper source. See &quot;<strong>Paper Tab</strong>&quot;.</td>
</tr>
<tr>
<td>A print job is extremely slow.</td>
<td>The job may be very complex.</td>
<td>Reduce the complexity of the page or try adjusting the print quality settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The maximum print speed of your printer is up to 35 PPM for Letter-sized paper.</td>
</tr>
<tr>
<td>Half the page is blank.</td>
<td>The page orientation setting may be incorrect.</td>
<td>Change the page orientation in your application. See &quot;<strong>Layout Tab</strong>&quot;.</td>
</tr>
<tr>
<td></td>
<td>The paper size and the paper size settings do not match.</td>
<td>Ensure that the paper size in the printer driver settings matches the paper in the tray.</td>
</tr>
<tr>
<td>The printer prints, but the text is wrong, garbled, or incomplete.</td>
<td>The printer cable is loose or defective.</td>
<td>Disconnect the printer cable and reconnect. Try a print job that you have already printed successfully. <em>If possible,</em> attach the cable and the printer to another computer and try a print job that you know works. Finally, try a new printer cable.</td>
</tr>
<tr>
<td></td>
<td>The wrong printer driver was selected.</td>
<td>Check the application's printer selection menu to ensure that your printer is selected.</td>
</tr>
<tr>
<td></td>
<td>The software application is malfunctioning.</td>
<td>Try printing a job from another application.</td>
</tr>
<tr>
<td></td>
<td>The operating system is malfunctioning.</td>
<td>Exit Windows and reboot the computer. Power the printer off and then back on again.</td>
</tr>
<tr>
<td>Pages print, but are blank.</td>
<td>The toner cartridge is defective or out of toner.</td>
<td>Thoroughly shake the toner. See &quot;<strong>Redistributing Toner</strong>&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>If necessary, replace the toner cartridge.</em></td>
</tr>
<tr>
<td></td>
<td>The file may have blank pages.</td>
<td>Check the file to ensure that it does not contain blank pages.</td>
</tr>
<tr>
<td></td>
<td>Some parts, such as the controller or the board, may be defective.</td>
<td>Contact a service representative.</td>
</tr>
<tr>
<td>The illustrations print incorrectly in Adobe Illustrator.</td>
<td>The setting in the software application is wrong.</td>
<td>Print the document by selecting <strong>Download as Bitmap</strong> in the <strong>Advanced Options</strong> window of the <strong>Graphic</strong> properties.</td>
</tr>
<tr>
<td>The print quality of photos is not good. Images are not clear.</td>
<td>The resolution of the photo is very low.</td>
<td>Reduce the photo size. If you increase the photo size in the software application, the resolution will be reduced.</td>
</tr>
</tbody>
</table>
The machine prints, but the text is wrong, garbled, or incomplete.

If you are under the DOS environment, the font setting for your machine may be set incorrectly.

Suggested solutions: Change the language setting. See "Printer Settings Utility".

Before printing, the machine emits vapor near the output tray.

Using damp paper can cause vapor during printing.

This is not a problem. Just keep printing.

Printing Quality Problems

The inside of the printer may be dirty or improper paper loading may reduce the print quality. See the table below to clear the problem.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
</table>
| **Light or faded print**| *If a vertical white streak or faded area appears on the page:*
|                         | - The toner supply is low. You may be able to temporarily extend the toner cartridge life. See "Redistributing Toner". If this does not improve the print quality, install a new toner cartridge.  |
|                         | - The paper may not meet paper specifications; for example, the paper is too moist or too rough. See "Paper Specifications".  |
|                         | - A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. See "Cleaning the Interior".  |
|                         | - The surface of the LSU part inside the printer may be dirty. Clean the LSU (see "Cleaning the Interior").  |
| **Toner specks**        | - The paper may not meet specifications; for example, the paper is too moist or too rough. See "Paper Specifications".  |
|                         | - The transfer roller may be dirty. Clean the inside of your printer. See "Cleaning the Interior".  |
|                         | - The paper path may need cleaning. See "Cleaning the Drum".  |
| **Dropouts**            | *If faded areas, generally rounded, occur randomly on the page:*
<p>|                         | - The toner supply is low. You may be able to temporarily extend the toner cartridge life. See &quot;Redistributing Toner&quot;. If this does not improve the print quality, install a new toner cartridge.  |
|                         | - The paper may not meet paper specifications; for example, the paper is too moist or too rough. See &quot;Paper Specifications&quot;.  |
|                         | - A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. See &quot;Cleaning the Interior&quot;.  |
|                         | - The surface of the LSU part inside the printer may be dirty. Clean the LSU (see &quot;Cleaning the Interior&quot;).  |</p>
<table>
<thead>
<tr>
<th>White Spots</th>
<th>White spots appears on the page:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The paper is too rough and a lot of dirt from a paper falls to the inner devices within the machine, so the transfer roller may be dirty. Clean the inside of your machine. Contact a service representative.</td>
</tr>
<tr>
<td></td>
<td>• The paper path may need cleaning. Contact a service representative.</td>
</tr>
</tbody>
</table>

| Vertical lines | If black vertical streaks appear on the page, the drum inside the toner cartridge has probably been scratched. Install a new toner cartridge. See "Replacing the Toner Cartridge". |
|               | • If white vertical streaks appear on the page, the surface of the LSU part inside the printer may be dirty. Clean the LSU (see "Cleaning the Interior"). |

<table>
<thead>
<tr>
<th>Gray background</th>
<th>If the amount of background shading becomes unacceptable:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Change to lighter weight pages. See &quot;Paper Specifications&quot;.</td>
</tr>
<tr>
<td></td>
<td>• Check the printer’s environment; very dry (low humidity) or high humidity (higher than 80% RH) conditions can increase the amount of background shading.</td>
</tr>
<tr>
<td></td>
<td>• Remove the old toner cartridge and install a new one. See &quot;Replacing the Toner Cartridge&quot;.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Toner smear</th>
<th>Clean the inside of the printer. See &quot;Cleaning the Interior&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Check the paper type and quality. See &quot;Paper Specifications&quot;.</td>
</tr>
<tr>
<td></td>
<td>• Remove the toner cartridge and install a new one. See &quot;Replacing the Toner Cartridge&quot;.</td>
</tr>
</tbody>
</table>
| Vertical repetitive defects | If marks repeatedly appear on the printed side of the page at even intervals:  
| | - The toner cartridge may be damaged. If a repetitive mark occurs on the page, print a cleaning sheet several times to clean the cartridge; see "Cleaning the Drum". After the printout, if you still have the same problems, install a new toner cartridge. See "Replacing the Toner Cartridge".  
| | - Parts of the printer may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after a few more pages.  
| | - The fusing assembly may be damaged. Contact a service representative.  
| Background scatter | Background scatter results from bits of toner distributed on the printed page.  
| | - The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that the paper does not absorb too much moisture.  
| | - If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams on the reverse side. Printing on seams can cause problems.  
| | - If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application or the printer properties.  
| Misformed characters | If characters are improperly formed and produce hollow images, the paper stock may be too slick. Try a different paper. See "Paper Specifications".  
| | - If characters are improperly formed and produce a wavy effect, the scanner unit may need service. For service, contact a service representative.  
| Page skew | Ensure that the paper is loaded properly.  
| | - Check the paper type and quality. See "Paper Specifications".  
| | - Ensure that the paper or other material is loaded correctly and the guides are not too tight or too loose against the paper stack.  
| Curl or wave | Ensure that the paper is loaded properly.  
| | - Check the paper type and quality. Both high |
temperatures and humidity can cause paper curl. See "Paper Specifications".
- Turn over the stack of paper in the paper tray.
- Also try rotating the paper 180° in the paper tray.
- Try printing to the rear door.

| Wrinkles or creases | Ensure that the paper is loaded properly. 
| | Check the paper type and quality. See "Paper Specifications". 
| | Turn over the stack of paper in the paper tray. 
| | Also try rotating the paper 180° in the paper tray. 
| | Try printing to the rear door. |

| Back of printouts are dirty | Check for leaks in the toner. Clean the inside of the printer. See "Cleaning the Interior". |

| Black pages | The toner cartridge may not be installed properly. Remove the cartridge and reinsert. 
| | The toner cartridge may be defective and need replacing. Install a new toner cartridge. See "Replacing the Toner Cartridge". 
| | The printer may require repair. Contact a service representative. |

| Loose toner | Clean the inside of the printer. See "Cleaning the Interior". 
| | Check the paper type and quality. See "Paper Specifications". 
| | Install a new toner cartridge. See "Replacing the Toner Cartridge". 
| | If the problem persists, the printer may require repair. Contact a service representative. |

| Character Voids | Character voids have white areas where they should |
**Horizontal stripes**

*If horizontally aligned black streaks or smears appear:*

- The toner cartridge may be installed improperly. Remove the toner cartridge and reinsert.
- The toner cartridge may be defective. Install a new toner cartridge. See "Replacing the Toner Cartridge".
- *If the problem persists*, the printer may require repair. Contact a service representative.

**Curl**

*If the printed paper is curled or the paper does not feed into the printer:*

- Turn over the stack of paper in the paper tray.
- Also try rotating the paper 180° in the paper tray.
- Try printing to other rear door.

---

**Fax Problems**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
</table>
| Receiving fax calls are not being answered by the printer | *Receive mode* set to *Tel* mode. (manual receive mode)  
*The rings-to-answer setting might not be set correctly. (Under *Ans/Fax* mode, set the *Ring To Answer* to a digit greater than the *Ring To Answer* setting for the TAD.)*  
*The DPRD feature might be turned on, but you do not have the service, or you do have the service and the feature is not set correctly.*  
*The fax line cord might not be correctly connected, or the fax line cord is faulty.*  
*The printer might not be able to detect Receiving fax tones because the answering machine is playing a voice message.*  
*A voice-messaging service might be interfering with the printer as it attempts to answer calls.*  
*Fax Line might have signal integration issues. Please carry out *Line Test* from Op-panel to confirm line status.* |
The printer is monitoring line condition while it is receiving or sending a fax job. If an error occurs during the transmission and the **ECM Mode** setting is **On**, the printer may request that the portion of the fax job to be resent. You should turn off **ECM Mode** only if you are having trouble sending or receiving a fax job, and you are willing to accept the errors in the transmission job. Turning off the setting might be useful when you are trying to send a fax long distant or receive from long distant (example: other countries etc.)

- The printer might be out of paper and the memory is full.

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| The printer cannot receive faxes from an extension telephone. | • The fax cable might not be securely connected.  
  • The printer dialing mode might be incorrectly set, or the extension phone might be incorrectly set. |
| Faxes are not received automatically.                     | • The **Fax** mode should be selected.  
  • Make sure that there is paper in the paper tray.  
  • Check to see if the display shows **Memory Full**. |
| The Receiving fax has blank spaces or is received in poor-quality. | • A noisy phone line can cause line errors.  
  • Check your printer by making a copy. |
| Receiving faxes are too light.                            | The printer might be running out of toner while printing a fax. Under Toner empty conditions, the printer will store the fax job into memory, as soon as possible, replace the print cartridge, and then reprint the fax. |
| Faxes are printed on two pages instead of one.            | The auto reduction setting may be turned **Off**, try enabling this setting. |
| Receiving Faxes are not been printed by the printer       | **Receive Forward** feature might be turned **Off**, try enabling this setting. You can set the printer to forward all incoming faxes to specified e-mail addresses. Please carry out **Line Test** from Op-panel to confirm line status. See "Testing Fax line connection". |
| The printer is not sending fax.                           | • If your printer is on a PBX system, the PBX system might be generating a dial tone that the printer cannot detect.  
  • Fax Line might have signal integration issues. Please carry out **Line Test** from Op-panel to confirm line status. See "Testing Fax line connection". |
| No dial tone sound.                                      | • Check that the phone line is connected properly. Please carry out **Line Test** from Op-panel to confirm line status. See "Testing Fax line connection".  
  • Check that the phone socket in the wall is working by plugging in another phone.  
  • Fax Line might have signal integration issues. Please carry out **Line Test** from Op-panel to confirm line status. See "Testing Fax line connection".  
  • Fax Line might have signal integration issues. Please carry out **Dial Tone Test** from Op-panel to confirm line status. See "Testing Fax line connection". |
<table>
<thead>
<tr>
<th>The printer dials a number, but the connection with another fax machine fails.</th>
<th>The other fax machine may be turned off, out of paper, or cannot answer. Speak with the other machine operator and ask her/him to sort out the problem.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faxes stop during sending.</td>
<td>The fax machine to which you are sending might be malfunctioning. Your telephone line might not be working. A communication error might be interrupting the fax job. A poor telephone connection might exist. The fax machine to which you are sending might be malfunctioning. The printer is monitoring line condition while it is receiving or sending a fax job. If an error occurs during the transmission and the <strong>ECM Mode</strong> setting is <strong>On</strong>, the printer may request that the portion of the fax job to be resent. You should turn off <strong>ECM Mode</strong> only if you are having trouble sending or receiving a fax job, and you are willing to accept the errors in the transmission job. Turning off the setting might be useful when you are trying to send a fax long distant or receive from long distant (example: other countries etc.) Your telephone line might not be working.</td>
</tr>
<tr>
<td>Outgoing fax calls continue to be dialed.</td>
<td>The printer automatically redials a fax number if the redial options are set to <strong>On</strong>.</td>
</tr>
<tr>
<td>Successfully Send faxes job is not been received at the other fax machine.</td>
<td>The receiving fax machine might be off or might have an error condition, such as being out of paper. A fax might be in memory because it is waiting to redial a busy number, other jobs that are ahead of it are waiting to be sent, or the fax is set up for a delayed send.</td>
</tr>
<tr>
<td>Send faxes have a shading at the trailing edge of each media.</td>
<td>DADF (Flat-bed) scan size might be set to incorrect size.</td>
</tr>
<tr>
<td>The document stops in the middle of faxing.</td>
<td>While faxing through DADF any documents smaller than 5.59 by 5.83 in. (142 by 148 mm) or larger than 8.5 by 14 in. (216 by 356 mm) might result into jam inside DADF. See &quot;Clearing Jams in the DADF&quot;.</td>
</tr>
<tr>
<td>Out of Memory.</td>
<td>You might be sending a fax that is too large, or the resolution might be too high.</td>
</tr>
<tr>
<td>Documents are not stored in the memory.</td>
<td>There may not be enough memory to store the document. If the display shows a Memory Full message, delete any documents you no longer need from the memory and then restore the document.</td>
</tr>
<tr>
<td>The document stops feeding in the middle of faxing.</td>
<td>The maximum length of a page that you can load is 381 mm (15 inches). Faxing of a longer page stops at 381 mm (15 inches).</td>
</tr>
<tr>
<td>Voice calls are not received by the extension telephone or answering machine that is connected to the same line shared by the printer.</td>
<td>The fax line cord connection or configuration issue. See &quot;Making Connections&quot;. The receive mode or rings-to-answer settings might be incorrectly set. See &quot;Setting up the Fax System&quot;. The telephone answering machine or extension telephone might not be functioning properly.</td>
</tr>
</tbody>
</table>
## Copying Problems

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies are too light or too dark.</td>
<td>Use the <strong>Contrast</strong> menu to darken or lighten the background of the copies.</td>
</tr>
<tr>
<td>Smears, lines, marks or spots appear on copies.</td>
<td>• If defects are on the original, select <strong>Copy → Contrast</strong> to lighten the background of your copies.</td>
</tr>
<tr>
<td></td>
<td>• If no defects are on the original, clean the document glass and underside of the document cover. See &quot;Cleaning the scanner&quot;.</td>
</tr>
<tr>
<td>Copy image is skewed.</td>
<td>• Ensure that the original is positioned correctly on document glass.</td>
</tr>
<tr>
<td></td>
<td>• Check that the copy paper is loaded correctly.</td>
</tr>
<tr>
<td>Blank copies print out.</td>
<td>Ensure that the original is face down on the document glass or face up in the DADF.</td>
</tr>
<tr>
<td>Image rubs off the copy easily.</td>
<td>• Replace the paper in the paper tray with paper from a new package.</td>
</tr>
<tr>
<td></td>
<td>• In high humidity areas, do not leave paper in the printer for the extended periods of time.</td>
</tr>
<tr>
<td>Frequent copy paper jams occurs.</td>
<td>• Fan the stack of paper, then turn it over in the paper tray. Replace the paper in the tray with a fresh supply. If necessary, check/adjust the paper guides.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the paper is the proper paper weight. 75 g/m² (20 lb) bond paper is recommended.</td>
</tr>
<tr>
<td></td>
<td>• Check for copy paper or pieces of copy paper remaining in the printer after a paper jam has been cleared.</td>
</tr>
<tr>
<td>Fewer copies from the toner cartridge than</td>
<td>• Your originals may contain pictures, solids or heavy lines. For example, your originals may be forms, newsletters, books or other documents that use more</td>
</tr>
<tr>
<td>expected prints out.</td>
<td>toner.</td>
</tr>
<tr>
<td></td>
<td>• The document cover may be left open while copies are being made.</td>
</tr>
</tbody>
</table>

## Scanning Problems
<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The scanner does not work.</td>
<td>• Ensure that you place the document to be scanned face down from the document glass, or face up in the DADF.</td>
</tr>
<tr>
<td></td>
<td>• There may not be enough available memory to hold the document you want to scan. Try the Prescan function to see if that works. Try lowering the scan resolution rate.</td>
</tr>
<tr>
<td></td>
<td>• Check that the USB cable is connected properly.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the USB cable is not defective. Switch the cable with a known good cable. <em>If necessary, replace the cable.</em></td>
</tr>
<tr>
<td></td>
<td>• Check that the scanner is configured correctly. Check the application you want to use to make certain that the scanner job is being sent to the correct port.</td>
</tr>
<tr>
<td>The unit scans very slowly.</td>
<td>• Check if the printer is printing received data. Scan the document after the current job is completed.</td>
</tr>
<tr>
<td></td>
<td>• Graphics are scanned more slowly than text.</td>
</tr>
<tr>
<td></td>
<td>• Communication speed becomes slow in scan mode because of the large amount of memory required to analyze and reproduce the scanned image.</td>
</tr>
<tr>
<td>Message appears on your computer screen:</td>
<td>• There may be a copying or printing job in progress. When the current job is complete, try the job again.</td>
</tr>
<tr>
<td>• &quot;Device can't be set to the H/W mode you want.&quot;</td>
<td>• The selected port is currently being used. Restart your computer and try again.</td>
</tr>
<tr>
<td>• &quot;Port is being used by another program.&quot;</td>
<td>• The printer cable may be improperly connected or the power may be off.</td>
</tr>
<tr>
<td>• &quot;Port is Disabled.&quot;</td>
<td>• The scanner driver is not installed or an operating environment is not set up properly.</td>
</tr>
<tr>
<td>• &quot;Scanner is busy receiving or printing data. When the current job is completed, try again.&quot;</td>
<td>• Ensure that the port is properly connected and the power is turned on. Then restart your computer.</td>
</tr>
<tr>
<td>• &quot;Invalid handle.&quot;</td>
<td>• Check that the USB cable is properly connected.</td>
</tr>
</tbody>
</table>

Global address problems
<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>d_LDAP_MAX_QUERY_EXCEEDED</strong></td>
<td>There exists limitation for number of results from the LDAP server for each LDAP query.</td>
</tr>
<tr>
<td></td>
<td>The range for the number of results is 0~100.</td>
</tr>
<tr>
<td></td>
<td>Set the query between 1 and 100.</td>
</tr>
<tr>
<td><strong>d_LDAP_SVR_AUTH_FAIL</strong></td>
<td>If a device has invalid credential (ID or PW), LDAP server will return authentication failure message.</td>
</tr>
<tr>
<td><strong>d_LDAP_QUERY_FAILED</strong></td>
<td>If a user presses the STOP key during the search and no data was returned before cancelling, the device will display this message.</td>
</tr>
<tr>
<td><strong>d_LDAP_NO_SUCH_ATTRIBUTE</strong></td>
<td>Result is depending on the query from the device.</td>
</tr>
<tr>
<td></td>
<td>If a user sees this error message, changing the query can avoid this situation.</td>
</tr>
<tr>
<td><strong>d_LDAP_ADDR_NOT_FOUND</strong></td>
<td>This case is happening only when connection was successful and search result was nothing.</td>
</tr>
<tr>
<td><strong>d_LDAP_SVR_NOT_FOUND</strong></td>
<td>It could be a wrong IP address setup or Server is not working correctly.</td>
</tr>
<tr>
<td></td>
<td>Administrator can suspect the physical condition, device (client) configuration and server status.</td>
</tr>
<tr>
<td></td>
<td>In case of device configuration, administrator should check IP address or hostname or port number.</td>
</tr>
<tr>
<td><strong>d_LDAP_TIMELIMIT_EXCEEDED</strong></td>
<td>It only happens when server is returning error code=8 which means &quot;Server Time-out&quot;.</td>
</tr>
<tr>
<td></td>
<td>When server couldn't return all search result within the timeout.</td>
</tr>
<tr>
<td></td>
<td>This is abnormal case which is depending on the server side condition though.</td>
</tr>
<tr>
<td></td>
<td>A user can test server operation with other queries.</td>
</tr>
</tbody>
</table>

**Common Windows Problems**
### Condition | Suggested solutions
--- | ---
"File in Use" message appears during installation. | Exit all software applications. Remove all software from the StartUp Group, then restart Windows. Reinstall the printer driver.

"General Protection Fault", "Exception OE", "Spool32", or "Illegal Operation" messages appear. | Close all other applications, reboot Windows and try printing again.

"Fail To Print", "A printer timeout error occurred." messages appear. | These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in standby mode or after printing has been completed, check the connection and/or whether an error has occurred.


### Common Linux Problems

| Condition | Suggested solutions |
--- | --- |
The printer doesn’t print. | - Check if the printer driver is installed in your system. Open MFP configurator and switch to the Printers tab in Printers configuration window to look at the list of available printers. Ensure that your printer is displayed on the list. If not, please, invoke Add new printer wizard to set up your device.
- Check if the printer is started. Open Printers configuration and select your printer on the printers list. Look at the description in the Selected printer pane. If its status contains "(stopped)" string, please, press the Start button. After that normal operation of the printer should be restored. The "stopped" status might be activated when some problems in printing occurred. For instance, this could be an attempt to print document when MFP port is claimed by a scanning application.
- Check if the MFP port is not busy. Since functional components of MFP (printer and scanner) share the same I/O interface (MFP port), the situation of simultaneous access of different "consumer" application to the same MFP port is possible. To avoid possible conflicts, only one of them at a time is allowed to gain control over the device. The other "consumer" will encounter "device busy" response. You should open MFP ports configuration and select the port assigned to your printer. In the Selected port pane you can see if the port is occupied by some other application. If this is the case, you should wait for completion of the current job or should press Release port button, if you are sure that the present owner is not functioning properly.
- Check if your application has special print option such as "-oraw". If "-oraw" is specified in the command line
parameter then remove it to print properly. For Gimp front-end, select "print" → "Setup printer" and edit command line parameter in the command item.

<table>
<thead>
<tr>
<th>The printer does not appear on the scanners list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Check if your printer is attached to your computer. Ensure that it is connected properly via the USB port and is turned on.</td>
</tr>
<tr>
<td>• Check if the scanner driver for your printer is installed in your system. Open MFP Configurator, switch to Scanners configuration, then press Drivers. Ensure that driver with a name corresponding to your printer's name is listed in the window.</td>
</tr>
<tr>
<td>• Check if the MFP port is not busy. Since functional components of MFP (printer and scanner) share the same I/O interface (MFP port), the situation of simultaneous access of different &quot;consumer&quot; application to the same MFP port is possible. To avoid possible conflicts, only one of them at a time is allowed to gain control over the device. The other &quot;consumer&quot; will encounter &quot;device busy&quot; response. This can usually happen while starting scan procedure, and appropriate message box appears.</td>
</tr>
<tr>
<td>• To identify the source of the problem, you should open MFP ports configuration and select the port assigned to your scanner. MFP port's symbol /dev/mfp0 corresponds to LP:0 designation displayed in the scanners' options, /dev/mfp1 relates to LP:1 and so on. USB ports start at /dev/mfp4, so scanner on USB:0 relates to /dev/mfp4 respectively and so forth sequentially. In the Selected port pane you can see if the port is occupied by some other application. If this is the case, you should wait for completion of the current job or should press Release port button, if you are sure that the present port's owner is not functioning properly.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The printer doesn't scan.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Check if a document is loaded into the printer.</td>
</tr>
<tr>
<td>• Check if your machine is connected to the computer. Ensure that if it is connected properly if I/O error is reported while scanning.</td>
</tr>
<tr>
<td>• Check if MFP port is not busy. Since functional components of MFP (printer and scanner) share the same I/O interface (MFP port), the situation of simultaneous access of different &quot;consumer&quot; application to the same MFP port is possible. To avoid possible conflicts, only one of them at a time is allowed to gain control over the device. The other &quot;consumer&quot; will encounter &quot;device busy&quot; response. This can usually happen while starting scan procedure, and appropriate message box will be displayed.</td>
</tr>
</tbody>
</table>

To identify the source of the problem, you should open MFP ports configuration and select the port assigned to your scanner. MFP port's symbol /dev/mfp0 corresponds to LP:0 designation displayed in the scanners' options, /dev/mfp1 relates to LP:1 and so on. USB ports start at /dev/mfp4, so scanner on USB:0 relates to /dev/mfp4 respectively and so forth sequentially. In the Selected port pane you can see if the port is occupied by some other application. If this is the case, you should wait for completion of the current job or should press Release port button, if you are sure that the present port's owner is not functioning properly.
I can't print when I installed both Linux Print Package (LPP) and MFP driver on the same machine simultaneously.

- Since both Linux Printer Package and MFP driver make a symbolic link to "lpr" printing command, which is commonly used on Unix clones, it is not recommended to use both package on the same machine.

Can't scan via Gimp Front-end.

- Check if Gimp Front-end has "Xsane:Device dialog." on the "Acquire" menu. If not, you should install Xsane plug-in for Gimp on the your computer. You can find Xsane plug-in package for Gimp on Linux distribution CD or Gimp home page. For the detail information, refer to the Help for Linux distribution CD or Gimp Front-end application.

  If you wish to use other kind of scan application, refer to the Help for application.

I encounter error "Unable to open MFP port device file!" when printing a document.

- Avoid changing print job parameters (via SLPR utility, for example) while a print job is in progress. Known versions of CUPS server break the print job whenever print options are changed and then try to restart the job from the beginning. Since Linux MFP driver locks MFP port while printing, the abrupt termination of the driver keeps the port locked and therefore unavailable for subsequent print jobs. If this situation occurred, try to release the MFP port.

---

**Common Macintosh Problems**

**Problems in the choose**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer does not print a document from Acrobat Reader.</td>
<td>Incompatibility between the PDF file and the Acrobat products: Printing the PDF file as an image may solve this problem. Turn on Print As Image from the Acrobat printing options.</td>
</tr>
<tr>
<td>The document has printed, but the print job has not disappeared from the spooler in Mac OS 10.3.2.</td>
<td>Update your Mac OS to OS 10.3.3. or higher.</td>
</tr>
<tr>
<td>Some letters are not displayed normally during the cover page printing.</td>
<td>This problem is caused because Mac OS cannot create the font during the cover page printing. English alphabet and numbers are displayed normally at the cover page.</td>
</tr>
<tr>
<td>When printing a document in Macintosh with Acrobat Reader 6.0 or higher, colors print incorrectly.</td>
<td>The resolution setting in the printer driver may not be matched with the one in Acrobat Reader.</td>
</tr>
</tbody>
</table>

**NOTE:** Refer to Mac OS User's Guide that came with your computer for further information on Mac OS error messages.
### Troubleshooting PostScript (PS) Errors

The following situations are PS language specific and may occur when several printer languages are being used.

**NOTE:** To receive a printed or screen displayed message when PS errors occur, open the Print Options window and click the desired selection next to the PostScript errors section.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostScript file can not be printed.</td>
<td>The PostScript option may not be installed.</td>
<td>Print a configuration page and verify that the PS version is available for printing.</td>
</tr>
<tr>
<td>Limit Check Error</td>
<td>The print job may be too complex.</td>
<td>Reduce the complexity of the page or try adjusting the print quality settings. Or, expand the memory capacity.</td>
</tr>
<tr>
<td>A PS error page prints.</td>
<td>Print job may not be PS.</td>
<td>Ensure that the print job is a PS job. Check to see whether the software application expected a setup or PS header file to be sent to the printer.</td>
</tr>
<tr>
<td>The optional tray 2 is not selected</td>
<td>The printer driver has not been configured to</td>
<td>Open the PostScript driver properties, select the <strong>Device Settings</strong> tab, and set the <strong>Tray</strong> option of the <strong>Installable Options</strong> section to <strong>Installed</strong>.</td>
</tr>
<tr>
<td>in the driver.</td>
<td>recognize the optional tray 2.</td>
<td></td>
</tr>
</tbody>
</table>
Installing Accessories

- Precautions When Installing Printer Accessories
- Installing Printer Memory
- Installing an Optional Tray 2
- Installing Wireless Network interface card

Precautions When Installing Printer Accessories

Never remove the control board while the printer is plugged in.

To avoid the possibility of an electrical shock, always disconnect the power cord when installing or removing ANY internal or external printer option.

The control board and internal printer memory are sensitive to static electricity. Before installing or removing an internal printer memory, discharge static electricity from your body by touching something metal on any device plugged into a grounded power source. *If you walk around before finishing installation*, discharge any static electricity once again.

Installing Printer Memory

Additional printer memory is provided on a Dual In-line Memory Module (DIMM).

Your printer has 256 MB of memory. Additional 256 MB can be installed. Do not remove preinstalled memory. Just add one more DIMM in the DIMM socket.

**NOTE:** Your printer supports only Dell DIMMs. Order Dell DIMMs online at [www.dell.com](http://www.dell.com).

1. Power the printer off and unplug all cables from the printer.
2. Grasp the control board cover and open it.
3. Remove a new memory DIMM from its antistatic package.

4. Holding the memory module by the edges, align the memory module on the slot at about a 30-degree tilt. Ensure that the notches of the module and the grooves on the slot fit each other.

5. Press the memory module into the slot with care until you hear a "click".
6. Replace the control board cover.

7. Reconnect the power cord and printer cable, and turn the printer on.

After installing the memory DIMM, printer drivers will automatically configure the updated memory.

---

**Installing an Optional Tray 2**

You can increase the paper handling capacity of your printer by installing an optional tray 2. This tray holds 250 sheets of paper.

1. Power the printer off and unplug all cables from the printer.

2. Remove the packing tape and the tape fastening the optional tray 2 cable from the bottom of the optional tray 2.

3. Find the location of the paper option tray connector and alignment pins.
4. Place the printer over the tray, aligning the feet on the printer with the alignment pins in the optional tray 2.

5. Connect the cable into the connector on the back of the printer.
6. Load paper in the optional tray 2. For information about loading paper in this tray, see "Loading Paper".

7. Reconnect the power cord and cables and then power the printer on.

After installing the optional tray 2, printer drivers will automatically sense tray 2.

---

**Installing Wireless Network interface card**

The machine is equipped with a network interface which allows you to use your printer on a network. You can also purchase a wireless network interface card to enable the use of the printer in wireless network environments. For information about installing the network printer server, see the network printer server user's guide.

For information about installing the wireless network interface card and configuring the network parameters, refer to Wireless Network Quick Install Guide.
# Specifications

- **General Specifications**
- **Scanner and Copier Specifications**
- **Printer Specifications**
- **Facsimile Specifications**
- **Paper Specifications**

## General Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DADF input capacity</td>
<td>Up to 50 sheets (20 lb, 75 g/m²)</td>
</tr>
<tr>
<td>DADF document size</td>
<td>Width: 5.6-8.5 in. (142-216 mm)</td>
</tr>
<tr>
<td></td>
<td>Length: 5.8-14 in. (148-356 mm)</td>
</tr>
<tr>
<td>Paper input capacity</td>
<td>Paper tray (tray 1 and optional tray 2): 250 sheets 75 g/m² (20 lb)</td>
</tr>
<tr>
<td></td>
<td>MPF: plain paper 50 sheets 75 g/m² (20 lb), special paper: 5 sheets 75 g/m² (20 lb)</td>
</tr>
<tr>
<td>Paper output capacity</td>
<td>Output tray: 150 sheets (face down)</td>
</tr>
<tr>
<td></td>
<td>rear door: 1 sheet (face up)</td>
</tr>
<tr>
<td>Paper type</td>
<td>Paper tray (tray 1 and optional tray 2): Plain paper (60-90 g/m², 16-24 lb)</td>
</tr>
<tr>
<td></td>
<td>MPF: Plain paper, Transparencies, Labels, Card, Post card (60-163 g/m², 16-43 lb), Envelopes (75-90 g/m², 20-24 lb)</td>
</tr>
<tr>
<td></td>
<td>Duplex printing: Plain paper (75-90 g/m², 20-24 lb)</td>
</tr>
<tr>
<td>Consumables</td>
<td>1-piece <strong>toner cartridge</strong> system</td>
</tr>
<tr>
<td>Power requirements</td>
<td>110-127 VAC, 50/60 Hz, 6.5A</td>
</tr>
<tr>
<td></td>
<td>220-240 VAC, 50/60 Hz, 3.5A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Printing: Less than 600 W</td>
</tr>
<tr>
<td></td>
<td>Copying: Less than 600 W</td>
</tr>
<tr>
<td></td>
<td>Standby mode: Less than 80W</td>
</tr>
<tr>
<td>Acoustic</td>
<td>Sleep mode: Less than 18 W</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Printing from standard tray (simplex job): 52 dBA</td>
<td></td>
</tr>
<tr>
<td>Printing from optional tray 2 (simplex job): 56 dBA</td>
<td></td>
</tr>
<tr>
<td>Duplex printing: 52 dBA</td>
<td></td>
</tr>
<tr>
<td>Copy (simplex job): 54 dBA</td>
<td></td>
</tr>
<tr>
<td>Standby mode: Inaudible</td>
<td></td>
</tr>
<tr>
<td>Warm-up time</td>
<td>Less than 42 seconds</td>
</tr>
<tr>
<td>Operating conditions</td>
<td>Temperature: 50o F-89o F (10o C-32o C)</td>
</tr>
<tr>
<td></td>
<td>Humidity: 20%-80% RH</td>
</tr>
<tr>
<td>LCD</td>
<td>16 characters x 4 lines with white back light</td>
</tr>
<tr>
<td>Toner cartridge life</td>
<td>Dell Standard Capacity Toner Cartridge life: 3,000 pages</td>
</tr>
<tr>
<td></td>
<td>Dell High Capacity Toner Cartridge life: 6,000 pages</td>
</tr>
<tr>
<td>Printer dimension (W x D x H)</td>
<td>18.3 x 17.3 x 18.1 in.</td>
</tr>
<tr>
<td></td>
<td>(465.2 x 440.1 x 461 mm)</td>
</tr>
<tr>
<td>Random Access Memory</td>
<td>DDR2 SDRAM 256MB(Basic) / 512MB(Max)</td>
</tr>
<tr>
<td>Maximum Monthly Duty Cycle</td>
<td>Up to 60,000 pages per month</td>
</tr>
<tr>
<td>Weight</td>
<td>Net: 17.7 Kg (including toner cartridge), 16.6 Kg (except toner cartridge)</td>
</tr>
<tr>
<td></td>
<td>Gross: 22 Kg (including consumables, accessories and package)</td>
</tr>
<tr>
<td>Package weight</td>
<td>Paper: 2.7 Kg</td>
</tr>
<tr>
<td></td>
<td>Plastic: 0.7 Kg</td>
</tr>
</tbody>
</table>

a. Power consumption can vary depend on the configuration of your machine.
b. Toner yield based on printing page with ISO standard page coverage in accordance with ISO/IEC 19752 testing methodology. Yields vary with usage and environmental conditions.

**Scanner and Copier Specifications**
<table>
<thead>
<tr>
<th><strong>Item</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatibility</td>
<td>TWAIN standard/WIA standard</td>
</tr>
<tr>
<td>Scanning method</td>
<td>DADF and Flat-bed</td>
</tr>
<tr>
<td></td>
<td>Color CCD (Charge Coupled Device) module</td>
</tr>
<tr>
<td>Scan Resolution</td>
<td>Optical: 600 x 600 dpi (from Platen, mono and color), 600 x 600 dpi interpolated (from DADF, mono and color)</td>
</tr>
<tr>
<td></td>
<td>Enhanced: 4,800 x 4,800 dpi</td>
</tr>
<tr>
<td>Copy Resolution</td>
<td>600 x 600 dpi</td>
</tr>
<tr>
<td>Effective scanning length</td>
<td>document glass: 11.5 in. (293 mm)</td>
</tr>
<tr>
<td></td>
<td>DADF: 14 in. (352 mm)</td>
</tr>
<tr>
<td>Effective scanning width</td>
<td>8.2 in. (208 mm)</td>
</tr>
<tr>
<td>Color bit depth</td>
<td>24 bit</td>
</tr>
<tr>
<td>Mono bit depth</td>
<td>1 bit for Lineart</td>
</tr>
<tr>
<td></td>
<td>8 bit for Gray scale</td>
</tr>
<tr>
<td>Scan speed (Text mode)</td>
<td>document glass: 15 (lineart), 20 (gray), 30 (color) seconds</td>
</tr>
<tr>
<td></td>
<td>DADF: 15 (lineart), 20 (gray), 30 (color) seconds</td>
</tr>
<tr>
<td>First Copy Out Time (FCOT)</td>
<td>From Standby Mode:</td>
</tr>
<tr>
<td></td>
<td>• via DADF: As Quick as 15 seconds</td>
</tr>
<tr>
<td></td>
<td>• via Platen: As Quick as 8.5 seconds</td>
</tr>
<tr>
<td></td>
<td>From Sleep Mode:</td>
</tr>
<tr>
<td></td>
<td>• via Platen: As Quick as 35 seconds</td>
</tr>
<tr>
<td>Copy speed</td>
<td>SDMC (Single Document Multiple Copy): 35 cpm (copies per minute for letter), 33 cpm for A4</td>
</tr>
<tr>
<td></td>
<td>MDMC (Multi-document Multiple Copy) at Text, Text/Photo, Photo: 21 cpm (copies per minute for letter), 20 cpm for A4</td>
</tr>
<tr>
<td></td>
<td>MDSC (Multi-document Single Copy): 7 ipm (image per minute for letter), 6 ipm for A4</td>
</tr>
<tr>
<td></td>
<td>MDMC at Photo mode: 4 cpm</td>
</tr>
<tr>
<td>Paper size</td>
<td>Letter, A4, Legal, Folio, Executive, A5, A6, B5</td>
</tr>
<tr>
<td>Zoom rate</td>
<td>document glass, DADF: 25%-400%</td>
</tr>
<tr>
<td>Multiple copies</td>
<td>1-199 pages</td>
</tr>
<tr>
<td>Copy mode (=Original Type)</td>
<td>Text, Text&amp;Photo, Photo</td>
</tr>
</tbody>
</table>

a. FCOT is measured based on internal procedure.
## Printer Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printing method</strong></td>
<td>Laser Beam Printing</td>
</tr>
<tr>
<td><strong>Printing speed (Simplex)</strong></td>
<td>Letter: up to 35 ppm (pages per minute)</td>
</tr>
<tr>
<td></td>
<td>A4: up to 33 ppm</td>
</tr>
<tr>
<td><strong>Printing speed (Duplex)</strong></td>
<td>Letter: up to 21 ipm (images per minute)</td>
</tr>
<tr>
<td></td>
<td>A4: up to 20 ipm</td>
</tr>
<tr>
<td><strong>Paper size</strong></td>
<td>Paper tray (tray 1 and optional tray 2): Letter, A4, Legal, Oficio, Folio, A5, A6, Executive, JIS B5, ISO B5</td>
</tr>
<tr>
<td></td>
<td>MPF: Letter, Legal, A4, Oficio, Folio, Executive, A5, A6 card, Post Card 4x6, Envelope 10, Envelope COM-10, Envelope DL, Envelope C5, Envelope C6, Envelope B5, JIS B5, ISO B5</td>
</tr>
<tr>
<td></td>
<td>* Min.: 3 x 5 in. (76 x 127 mm)</td>
</tr>
<tr>
<td></td>
<td>Max.: 8.5 x 14 in. (216 x 356 mm)</td>
</tr>
<tr>
<td></td>
<td>Duplex printing: Letter, A4, Legal, Oficio, Folio</td>
</tr>
<tr>
<td><strong>Print resolution</strong></td>
<td>Up to 1200 dpi effective output</td>
</tr>
<tr>
<td><strong>Emulation</strong></td>
<td>PCL6, PCL5e, PostScript Level3</td>
</tr>
<tr>
<td><strong>Font Memory</strong></td>
<td>512 KB</td>
</tr>
<tr>
<td><strong>PC Interface</strong></td>
<td>USB 2.0 Hi-Speed</td>
</tr>
<tr>
<td><strong>Network Protocol</strong></td>
<td>TCP/IPv4, IPv6 (DHCP, DNS, 9100, LPR, SNMP, HTTP, IPSec), EtherTalk, Novell NetWare NDPS services via TCP/IP &amp; IPP on 5.x, 6.x, DHCP, BOOTP, SLP, SSDP, Bonjour (Rendezvous), DDNS, WINS, TCP (Port 2000), LPR (Port 515), Raw (Port 9100), SNMPv1/2/3, HTTP, Telnet, SMTP (E-mail Notification)</td>
</tr>
<tr>
<td></td>
<td>Various Linux OS including Red Hat 8.0 <del>9.0, Fedora Core 1</del>4, Mandrake 9.2<del>10.1, and SuSE 8.2</del>9.2</td>
</tr>
<tr>
<td></td>
<td>Mac OS 10.3 ~ 10.6</td>
</tr>
<tr>
<td></td>
<td>Novell NetWare NDPS services via TCP/IP &amp; IPP on 5.x, 6.x</td>
</tr>
<tr>
<td></td>
<td>Bonjour discovery supported</td>
</tr>
<tr>
<td></td>
<td>SAP R/3 v4.6C, 4.x and 3.x and later.</td>
</tr>
<tr>
<td></td>
<td>Citrix MetaFrame; Windows Terminal Services</td>
</tr>
<tr>
<td><strong>First Page Out Time (FPOT)</strong></td>
<td>From Standby mode: Less than or equal to 8.5 seconds</td>
</tr>
<tr>
<td></td>
<td>From Sleep mode: Less than 24 seconds (Measured after less than 10 minutes in power save mode)</td>
</tr>
</tbody>
</table>
### Facsimile Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatibility</td>
<td>ITU-T Group 3</td>
</tr>
<tr>
<td>Applicable line</td>
<td>Public Switched Telephone Network (PSTN) or behind PABX</td>
</tr>
<tr>
<td>Data coding</td>
<td>MH/MR/MMR (ECM Mode) and JPEG/JBIG for color fax transmission</td>
</tr>
<tr>
<td>Modem speed</td>
<td>33.6 Kbps</td>
</tr>
<tr>
<td>Transmission speed</td>
<td>Approx. 3 seconds/page * Transmission time applies to memory transmission of text data with ECM compression using only ITU-T No.1 Chart.</td>
</tr>
<tr>
<td>Scanning speed</td>
<td>document glass: approx. 3 seconds/A4, 2.5 seconds/LTR (at standard fax resolution mode)</td>
</tr>
<tr>
<td></td>
<td>DADF: approx. 2.5 seconds/Letter (at standard fax resolution mode), 5 seconds/Letter (at fine fax resolution mode)</td>
</tr>
<tr>
<td>Multiple page scan speed</td>
<td>approx. 21 ppm/Letter (at standard fax resolution mode)</td>
</tr>
<tr>
<td></td>
<td>DADF: approx. 2.5 seconds/Letter (at standard fax resolution mode), 5 seconds/Letter (at fine fax resolution mode)</td>
</tr>
<tr>
<td>Maximum document length</td>
<td>document glass: 297 mm</td>
</tr>
<tr>
<td></td>
<td>DADF: 356 mm</td>
</tr>
<tr>
<td>Paper size</td>
<td>document glass: Letter, A4</td>
</tr>
<tr>
<td></td>
<td>DADF: Letter, A4, Legal</td>
</tr>
<tr>
<td>Resolution</td>
<td>Standard: 203 x 98 dpi</td>
</tr>
<tr>
<td></td>
<td>Fine: 203 x 196 dpi</td>
</tr>
<tr>
<td></td>
<td>Super Fine: 300 x 300 dpi</td>
</tr>
<tr>
<td>Back-up Memory</td>
<td>4 MB (Approx. 200 pages at ITU-T #1 Chart)</td>
</tr>
<tr>
<td>Halftone</td>
<td>256 levels</td>
</tr>
</tbody>
</table>

### Paper Specifications

#### Overview
Your printer accepts a variety of print materials, such as cut-sheet paper (including up to 100 percent recycled fiber content paper), envelopes, labels, transparencies and custom-size paper. Properties, such as weight, composition, grain and moisture content, are important factors affecting the printer's performance and the output quality. Paper that does not meet the guidelines outlined in this User's Guide can cause the following problems:

- Poor print quality
- Increased paper jams
- Premature wear on the printer

NOTE: Some paper may meet all of the guidelines in this guide and still not produce satisfactory results. This may be the result of improper handling, unacceptable temperature and humidity levels, or other variables over which Dell has no control.

NOTE: Before purchasing large quantities of paper, insure the paper meets the requirements specified in this User’s Guide.

CAUTION: Using paper that does not meet these specifications may cause problems, requiring repairs. These repairs are not covered by the Dell warranty or service agreements.

### Supported Sizes of Paper

<table>
<thead>
<tr>
<th>Paper</th>
<th>Dimensions</th>
<th>Weight</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>8.5 X 11 in. (216 X 279 mm)</td>
<td>60-90 g/m² bond (16-24 lb) for the paper tray</td>
<td>250 sheets of 75 g/m² bond (20 lb) paper for the paper tray (tray 1 and optional tray 2)</td>
</tr>
<tr>
<td>A4</td>
<td>8.3 X 11.7 in. (210 X 297 mm)</td>
<td>60-163 g/m² bond (16-43 lb) for the MPF</td>
<td>50 sheet of 75 g/m² bond (20 lb) paper for the MPF</td>
</tr>
<tr>
<td>Executive</td>
<td>7.25 X 10.5 in. (184 X 267 mm)</td>
<td>75-90 g/m² bond (20-24 lb) for the duplex printing</td>
<td></td>
</tr>
<tr>
<td>Legal</td>
<td>8.5 X 14 in. (216 X 356 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oficio</td>
<td>8.5 X 13.5 in. (216 X 343 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Folio</td>
<td>8.5 X 13 in. (216 X 330 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIS B5</td>
<td>7.16 X 10.11 in. (182 X 257mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISO B5</td>
<td>6.93 X 9.84 in. (176 X 250mm)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A5 | 5.82 X 8.3in. (148 X 210 mm) | Minimum size (custom) | 3 x 5 in. (76 x 127 mm) | 60-163 g/m² bond (16-32 lb) | 5 sheet of paper for the MPF |

Maximum size (Legal) | 8.5 x 14 in. (216 x 356 mm) | Transparency | Same minimum and maximum paper sizes as listed above. | 138-146 g/m² |
Labels | | | | 120-150 g/m² |
Cards | | | | 105-163 g/m² |
Envelopes | | | | 75-90 g/m² |

a. The printer supports a wide range of media sizes.
b. Capacity may vary depending on print materials's weight and thickness, and environmental conditions.

**NOTE:** You may experience jams when using print materials with a length of less than 127 mm (5 inches). For optimum performance, ensure that you are storing and handling the paper correctly. Please refer to "Printer and Paper Storage Environment".

**NOTE:** You can use A4, Letter, Folio, Oficio, Legal-sized paper for duplex printing.

### Guidelines for Using Paper

For the best result, use conventional 75 g/m² (20 lb) paper. Ensure that the paper is of good quality, and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, and curled or bent edges.

*If you are unsure of what type of paper you are loading, such as bond or recycled paper, check the label on the package.*

The following problems may cause print quality deviations, jamming or even damage to the printer:
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Problem with paper</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poor print quality or toner adhesion, problems with feeding</td>
<td>Too moist, too rough, too smooth or embossed, faulty paper lot</td>
<td>Try another kind of paper, between 100-400 Sheffield, 4%-5% moisture content.</td>
</tr>
<tr>
<td>Dropout, jamming, curl</td>
<td>Stored improperly</td>
<td>Store paper flat in its moisture-proof wrapping.</td>
</tr>
<tr>
<td>Increased gray background shading/printer wear</td>
<td>Too heavy</td>
<td>Use lighter paper, use the rear door.</td>
</tr>
<tr>
<td>Excessive curl problems with feeding</td>
<td>Too moist, wrong grain direction or short-grain construction</td>
<td>Use the rear door. Use long-grain paper.</td>
</tr>
<tr>
<td>Jamming, damage to printer</td>
<td>Cutouts or perforations</td>
<td>Do not use paper with cutouts or perforations.</td>
</tr>
<tr>
<td>Problems with feeding</td>
<td>Ragged edges</td>
<td>Use good quality paper.</td>
</tr>
</tbody>
</table>

**NOTE:** Do not use letterhead paper printed with low-temperature inks, such as those used in some types of thermography.

**NOTE:** Do not use raised or embossed letterhead.

**NOTE:** The printer uses heat and pressure to fuse toner to the paper. Insure that any colored paper or preprinted forms use inks that are compatible with this fusing temperature (180° C or 356° F for 0.1 second).

**Paper Specifications**

<table>
<thead>
<tr>
<th>Category</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acid Content</td>
<td>5.5 pH or lower</td>
</tr>
<tr>
<td>Caliper</td>
<td>0.094-0.18 mm (3.0-7.0 mils)</td>
</tr>
<tr>
<td>Curl in Ream</td>
<td>Flat within 0.02 in. (5 mm)</td>
</tr>
<tr>
<td>Cut Edge Conditions</td>
<td>Cut with sharp blades with no visible fray.</td>
</tr>
<tr>
<td>Fusing Compatibility</td>
<td>Must not scorch, melt, offset or release hazardous emissions when heated to 180° C (356° F) for 0.1 second.</td>
</tr>
<tr>
<td>Grain</td>
<td>Long Grain</td>
</tr>
<tr>
<td>Moisture Content</td>
<td>4%-6% by weight</td>
</tr>
<tr>
<td>Smoothness</td>
<td>100-400 Sheffield</td>
</tr>
</tbody>
</table>
Paper Output Capacity

<table>
<thead>
<tr>
<th>Output Location</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>output tray (Face Down)</td>
<td>150 sheets of 75 g/m² bond (20 lb) paper</td>
</tr>
<tr>
<td>rear door (Face Up)</td>
<td>1 sheet of 75 g/m² bond (20 lb) paper</td>
</tr>
</tbody>
</table>

Printer and Paper Storage Environment

Paper storage environmental conditions directly affect the feed operation.

Ideally, the printer and paper storage environment should be at or near room temperature, and not too dry or humid. Remember that paper is hygroscopic; it absorbs and loses moisture rapidly.

Heat works with humidity to damage paper. Heat causes the moisture in paper to evaporate, while cold causes it to condense on the sheets. Heating systems and air conditioners remove most of the humidity from a room. As paper is opened and used, it loses moisture, causing streaks and smudging. Humid weather or water coolers can cause the humidity to increase in a room. As paper is opened and used it absorbs any excess moisture, causing light print and dropouts. Also, as paper loses and gains moisture it can become distorted. This can cause paper jams.

Care should be taken not to purchase more paper than can be used in a short time (about 3 months). Paper stored for long periods may experience heat and moisture extremes, which can cause damage. Planning is important to prevent damage to large supplies of paper.

Unopened paper in sealed reams can remain stable for several months before use. Opened packages of paper have more potential for environment damage, especially if they are not wrapped with a moisture-proof barrier.

The paper storage environment should be properly maintained to ensure optimum performance. The required condition is 20°C to 24°C (68°F to 75°F), with a relative humidity of 4 percent to 55 percent. The following guidelines should be considered when evaluating the paper's storage environment:

- Paper should be stored at or near room temperature.
- The air should not be too dry or too humid.
- The best way to store an opened ream of paper is to rewrap it tightly in its moisture-proof wrapping. If the printer environment is subject to extremes, unwrap only the amount of paper to be used during the day’s operation to prevent unwanted moisture changes.